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1
Safety

Your printer and the recommended supplies have been designed and tested to meet
strict safety requirements. Attention to the following information ensures the continued
safe operation of your Xerox printer.

Notices and Safety
Read the following instructions carefully before operating your printer. Refer to these
instructions to ensure the continued safe operation of your printer.

Your Xerox ®printer and supplies are designed and tested to meet strict safety
requirements. These include safety agency evaluation and certification, and compliance
with electromagnetic regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified
using Xerox ® materials only.

Note
Unauthorized alterations, which can include the addition of new functions or connection
of external devices, can affect the product certification. For more information, contact
your Xerox representative.
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Electrical Safety

General Guidelines

Warning

• Do not push objects into slots or openings on the printer. Touching a voltage point
or shorting out a part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are
installing optional equipment and are instructed to do so. Power off the printer when
performing these installations. Disconnect the power cordwhen removing covers and
guards for installing optional equipment. Except for user-installable options, there
are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

• The power cord is damaged or frayed.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• The printer emits smoke, or the surface is unusually hot.
• The printer emits unusual noise or odors.
• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Power Cord

Use the power cord supplied with your printer.

• Plug the power cord directly into a properly grounded electrical outlet. Ensure that
each end of the cord is connected securely. If you do not know if an outlet is grounded,
ask an electrician to check the outlet.

Warning
To avoid risk of fire or electrical shock, do not use extension cords, power strips, or
power plugs for more than 90 days. When a permanent outlet receptacle cannot be
installed, use only one factory-assembled extension cord of the appropriate gauge
for each printer ormultifunction printer. Always adhere to national and local building,
fire, and electrical codes regarding length of cord, conductor size, grounding, and
protection.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that
does not have a ground connection terminal.
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• Verify that the printer is plugged into an outlet that is providing the correct voltage
and power. Review the electrical specification of the printer with an electrician if
necessary.

• Do not place the printer in an area where people can step on the power cord.
• Do not place objects on the power cord.
• Do not plug or unplug the power cord while the power switch is in the On position.
• If the power cord becomes frayed or worn, replace it.
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging

the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer.
If it is necessary to disconnect all electrical power from the printer, disconnect the power
cord from the electrical outlet.

Emergency Turn Off

If any of the following conditions occur, power off the printer immediately and disconnect
the power cord from the electrical outlet. Contact an authorized Xerox service
representative to correct the problem if:

• The equipment emits unusual odors or makes unusual noises.
• The power cable is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device has been tripped.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• Any part of the printer is damaged.

Telephone Line Cord

Warning
To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements.
These include safety agency examination, approval, and compliance with established
environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe
operation of your printer.

Operational Guidelines
• Do not remove any trays when the printer is printing.
• Do not open the doors when the printer is printing.
• Do not move the printer when it is printing.
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• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
• Covers, which require tools for removal, protect the hazard areas within the printer.

Do not remove the protective covers.
• Do not override any electrical or mechanical interlock devices.
• Do not attempt to remove paper that is jammed deeply inside the printer. Switch off

the printer promptly and contact your local Xerox representative.

Warning

• The metallic surfaces in the fuser area are hot. Always use caution when removing
paper jams from this area and avoid touching any metallic surfaces.

• To avoid a tip hazard, do not push or move the device with all the paper trays
extended.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced
is dependent on copy volume. Ozone is heavier than air and is not produced in amounts
large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to
www.xerox.com/environment . In other markets, please contact your local Xerox
representative or go to www.xerox.com/environment_europe.

Printer Location
• Place the printer on a level, solid, non-vibrating surface with adequate strength to

hold its weight. To find the weight for your printer configuration, refer to Physical
Specifications.

• Do not block or cover the slots or openings on the printer. These openings are provided
for ventilation and to prevent overheating of the printer.

• Place the printer in an areawhere there is adequate space for operation and servicing.
• Place the printer in a dust-free area.
• Do not store or operate the printer in an extremely hot, cold, or humid environment.
• Do not place the printer near a heat source.
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive

components.
• Do not place the printer where it is directly exposed to the cold air flow from an air

conditioning system.
• Do not place the printer in locations susceptible to vibrations.
• For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies
• Use the supplies designed for your printer. The use of unsuitable materials can cause

poor performance and a possible safety hazard.
• Follow all warnings and instructionsmarked on, or supplied with, the product, options,

and supplies.
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• Store all consumables in accordance with the instructions given on the package or
container.

• Keep all consumables away from the reach of children.
• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open

flame.
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye

contact can cause irritation and inflammation.Do not attempt to disassemble the
cartridge, which can increase the risk of skin or eye contact.

Caution
Use of non-Xerox supplies is not recommended. The XeroxWarranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not
specified for this printer. The Total Satisfaction Guarantee is available in the United
States and Canada. Coverage could vary outside these areas. Please contact your Xerox
representative for details.

Maintenance Safety
• Do not attempt any maintenance procedure that is not specifically described in the

documentation supplied with your printer.
• Clean with a dry lint-free cloth only.
• Do not burn any consumables or routine maintenance items. For information on

Xerox ® supplies recycling programs, go to www.xerox.com/gwa .

Warning
Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used
on electromechanical equipment.

Printer Symbols

DescriptionSymbol

Warning:
Indicates a serious hazard that can result in death or serious injury if not
avoided.

Hot Warning:
Hot surface on or in the printer. Use caution to avoid personal injury.

Warning:
Wait for the printer to cool for the specified time before touching the fuser.
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DescriptionSymbol

Caution:
Indicates a mandatory action to take in order to avoid damage to the
property.

Caution:
To avoid damage to the property, be careful not to spill toner when handling
the waste cartridge.

Do not touch the part or area of the printer.

Do not touch.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.

Do not burn the drum cartridges.

Do not use paper attached with staples or any other form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not use inkjet paper.
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DescriptionSymbol

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

For details about all the printer symbols that appear on your printer, refer to the Printer
Symbols guide at www.xerox.com/office/VLC605docs.

Environmental, Health, and Safety
Contact Information
Formore information on Environment, Health, and Safety in relation to this Xerox product
and supplies, contact the following customer help lines:

1-800-ASK-XEROX (1-800-275-9376)United States and
Canada:

+44 1707 353 434Europe:

For product safety information in the United States and Canada, go to
www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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2
Getting Started

Parts of the Printer

Front View

8.1. NFC AreaTray 2, Optional 550-Sheet Feeder
2. 9.Tray 1 Touch Screen

10.3. Duplex Automatic Document FeedBypass Tray
4. 11.Front Door Output Tray

12.5. Output Tray ExtensionCard Reader Bay
6. 13.USB Memory Port Right-Side Door
7. Status LED
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Duplex Automatic Document Feeder

6.1. CVT GlassDocument Feeder Cover
2. 7.Document Guides Second-Side Scanning Access Cover

Lever3. Document Feeder Tray
8. Document Glass4. Document Output Tray
9. Document Cover5. Document Output Tray Extension

Document Feeder Guidelines

The Duplex Automatic Document Feeder accommodates the following original-sized
documents:

• Width: 140–216 mm (5.5–8.5 in.)
• Length: 140–356 mm (5.5–14 in.)
• Weight: 60–125 g/m²

Follow these guidelines when loading original documents into the duplex automatic
document feeder:

• Load original documents face up so that the top of the document enters the feeder
first.

• Place only loose sheets of undamaged paper in the duplex automatic document
feeder.

• Adjust the paper guides so that they fit against the original documents.
• Insert paper in the duplex automatic document feeder only when ink on the paper

is dry.
• Do not load original documents above the MAX fill line.

Document Glass Guidelines

The document glass accommodates original size documents up to 216 x 356 mm (8.5
x 14 in.). Use the document glass rather than the duplex automatic document feeder
to copy or scan the following types of original documents:

• Paper with paper clips or staples attached
• Paper with wrinkles, curls, folds, tears, or notches
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• Coated or carbonless paper or items other than paper, such as cloth or metal
• Envelopes
• Books

Internal Parts

6.1. Transfer BeltFront Door
2. 7.Toner Cartridges Drum Cartridges

8.3. Waste CartridgeDocument Glass
4. 9.Document Cover Cleaning Rod

10.5. Right-Side DoorSingle-Pass Duplex Automatic
Document Feeder
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Rear View

7.1. USB Port, Type ATransfer Roller
2. 8.Fuser USB Port, Type B

9.3. Ethernet PortRear Door
4. 10.Wireless Network Adapter Port Cover FDI Port

11.5. Left-Side Panel, Access to optional
Productivity Kit

Phone Connector
6. Fax Line Connector

12. Power Connector

Options
MailboxFinisher

Control Panel

The control panel consists of a touch screen and buttons you press to control the functions
available on the printer. The control panel:

• Displays the current operating status of the printer.
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• Provides access to print, copy, and scan features.
• Provides access to reference materials.
• Provides access to Tools and Setup menus.
• Prompts you to load paper, replace supplies, and clear jams.
• Displays errors and warnings.
• Provides the Power/Wake button used for powering on or powering off the printer.

This button also supports the power-saver modes, and blinks to indicate the power
status of the printer.

DescriptionNameItem

This area of the screen displays information and provides access
to printer functions and applications.

Touch Screen Display1

This is the location where the system administrator logs in using
the system administrator password.

Administrator Logon2

This button serves several power-related functions.Power/Wake3

• When the printer is off, this button powers on the printer.
• When the printer is on, pressing this button displays a menu

on the control panel. From thismenu, you can choose to enter
Sleep mode, restart, or power off the printer.

• When the printer is on, but in a low-power or Sleep mode,
pressing this button wakes the printer.

• When the printer is powered on, holding this button for 5
seconds powers off the printer.

This button also blinks to indicate the power status of the printer.

• When the light blinks slowly, the printer is in Low Power or
Sleep mode.

• When the light blinks fast, the printer is powering down, or
exiting a low-power mode.

This button provides access to the Home menu for access to
printer features.

Home Button4
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DescriptionNameItem

Near Field Communication (NFC) is a technology that enables
devices to communicate when they are within 10 cm (4 in.) of
each other. Use the NFC area to obtain a network interface or
to establish a TCP/IP connection between your device and the
printer.

NFC Area5

This light blinks blue or amber to indicate printer status.Status LED6

• Blue

- Blinks once slowy to acknowledge a successful Authentic-
ation request.

- Blinks once slowly for a Copy or Print job initiated at the
control panel.

- Blinks twice slowly for Fax or Print job received from the
network.

- Blinks fast while the printer is powering up, or to signal
detection of a Wi-Fi Direct connection request.

• Amber

- Blinks to indicate an error condition or warning that re-
quires your attention. For example, an out-of-toner con-
dition, a paper jam, or out of paper for the current job.

- The printer status LED also blinks to indicate a system
error, which typically is associated with an error code.

Power Options
The printer has a single multifunction button on the control panel.

• When used in conjunction with the power switch, the Power/Wake button powers on
the printer.

• If the printer is already powered on, the Power/Wake button can be used to:

- restart the printer
- enter or exit Sleep mode
- enter or exit Low-Power mode

• The Power/Wake button also flashes when the printer is in low-power mode.

Xerox® VersaLink® C605 Multifunction Printer2-6
User Guide

Getting Started



Powering On the Printer or Exiting Low-Power or Sleep Mode

To power on the printer, or to exit Low-Powermode or Sleepmode, press the Power/Wake
button.

Note

• The Power/Wake button is the only power button on the printer.
• The printer exits Low-Powermode or Sleepmode automatically when it receives data

from a connected device.
• When in Low-Power mode, or Sleep mode, the touch screen is powered off and

unresponsive. To wake the printer manually, press the Power/Wake button.

Caution

• To prevent a printer malfunction, perform the control panel shutdown first.
• Do not plug or unplug the power cord while the printer is powered on.

Restarting, Placing in Sleep Mode, or Powering Off the Printer

To restart the printer, place the printer in Sleep Mode, or power off the printer.
1. At the printer control panel, press the Power/Wake button.

2. Select an option.

• To restart the printer, touch Restart.
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• To place the printer in Sleep Mode, touch Sleep.

Note
In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes.

• To power off the printer, touch Power Off.
• If the printer does not respond to a single press of the Power/Wake button, then

press and hold the button for 5 seconds. A Please Wait message appears as the
printer powers down.

After 10 seconds, the touch screen goes dark and the Power/Wake button flashes
until the printer powers down.

Caution
Do not unplug the power cord until the printer powers down.

Accessing the Printer

Information Pages

Your printer has a set of information pages that you can print. These pages include
configuration and font information, demonstration pages, and more.

The following Information Pages are available:

DescriptionName

The Configuration Report provides printer information
including installed options, network settings, port setup,
tray information, and more.

Configuration Report

The Billing Summary Report provides information about
the device and a detailed listing of the billingmeters and
sheet counts.

Billing Summary Report

The SuppliesUsageReport provides coverage information
and part numbers for reordering supplies.

Supplies Usage Report

The PostScript Font List provides a printout of all Post-
Script fonts that are available on the printer.

PostScript Font List

The PCL Font List provides a printout of all PCL fonts that
are available on the printer.

PCL Font List

Demonstration Print provides a demonstration of the
current print-quality settings.

Demonstration Print
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DescriptionName

The Startup Page provides basic printer configuration
and network information.

Startup Page

The printer retains information on previous print jobs,
including the date, time, job type, document name, out-
put color, paper size, number of pages, and results. The
status of amaximumof 20 jobs prints on the Job History
Report.

Job History Report

Printing Information Pages
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. To print an information page, touch the needed page.
4. To return to the Home screen, press the Home button.

Configuration Report

The Configuration Report provides product information including installed options,
network settings, port setup, tray information, and more.

Printing the Configuration Report
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. Touch Configuration Report.
4. To return to the Home screen, press the Home button.

Logging In

Logging in is the process by which you identify yourself to the printer for authentication.
If authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel
1. At the printer control panel, press the Home button.
2. Touch Log In.
3. Type the User Name using the keypad, then touch Enter.
4. If prompted, enter the password, then touch Enter.

Note
For more information on logging in as system administrator, refer to the System
Administrator Guide at www.xerox.com/office/VLC605docs.

5. Touch OK.

Note
To access each password-protected service, enter the User Name and password.
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Introduction to Apps
Xerox Apps are a gateway to the features and functions of your device. Standard Apps
are already installed on the device and appear on the Home screen. Some Apps are
installed as standard, but hidden the first time you use the device.

When you log in, the Apps configured for your personal account appear on the control
panel.

You can download more Apps for your device from the Xerox® App Gallery. For details,
refer to Xerox® Apps Gallery Overview.

The Embedded Web Server
The Embedded Web Server is the administration and configuration software that is
installed in the printer. It allows you to configure and administer the printer from aWeb
browser.

The Embedded Web Server requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh,
UNIX, or Linux environments.

• TCP/IP and HTTP enabled in the printer.
• A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the
printer, then press Enter or Return.

Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, you need the IP address of
your printer. You also need the IP address to access the settings of your printer through
the Embedded Web Server. You can view the IP address of your printer on the control
panel or on the Configuration Report.

Note
To view the TCP/IP address on the control panel, wait until the printer has been on for
2 minutes. If the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network
connectivity issue. However, note that if Wi-Fi is set as the primary Ethernet connection,
0.0.0.0 is shown for the printer’s IP address.

Viewing the IP Printer Address on the Control Panel

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.
3. Record the IP address from the display.
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4. To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from the Configuration Report

To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. Touch Configuration Report.

The IP address appears in the Connectivity section of the Configuration Report for
IPv4 or IPv6.

4. To return to the Home screen, press the Home button.

Installation and Setup
For reference:

• Installation Guide packaged with your printer
• Online Support Assistant at www.xerox.com/office/VLC605support

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on,
and connected. Configure the initial settings of the printer, then install the print driver
software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to
a network using an Ethernet cable or wireless connection. Hardware and cabling
requirements vary for the different connection methods. Routers, network hubs and
switches, modems, Ethernet cables, and USB cables are not included with your printer
andmust be purchased separately. Xerox recommends an Ethernet connection because
it is typically faster than a USB connection, and it provides access to the EmbeddedWeb
Server.

For more information, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

Selecting a Location for the Printer
1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative

humidity 10–85%.

Note
Sudden temperature fluctuations can affect print quality. Rapid heating of a cold
room can cause condensation inside the printer, directly interfering with image
transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to
hold the weight of the printer. The printer must be horizontal with all four feet in
solid contact with the surface.
To find the weight for your printer configuration, refer to Weights and Dimensions.
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3. Select a location with adequate clearance to access supplies and to provide proper
ventilation.
To find the clearance requirements for your printer, refer to Clearance Requirements.

4. After positioning the printer, you are ready to connect it to the power source and
computer or network.

Opening the Output Tray Extension

To provide better support for your prints, open the Output Tray Extension. For printing
on longer paper, lengthen the Output Tray Extension by pulling out the extender until
it stops.

Connecting the Printer
Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or
wireless connection. The method that you select depends on how your computer is
connected to the network. A USB connection is a direct connection and is the easiest to
set up. An Ethernet connection is used to connect to a network. If you are using a network
connection, it is important to understand howyour computer is connected to the network.

Note
Hardware and cabling requirements vary for the different connectionmethods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not
included with your printer and must be purchased separately.

• USB: If you connect the printer to one computer and do not have a network, use a
USB connection. A USB connection offers fast data speeds, but typically not as fast
as a network connection.

Note
To access the Embedded Web Server, a network connection is required.

• Network: If your computer is connected to an office network or home network, use
an Ethernet cable to connect the printer to the network. You cannot connect the
printer directly to the computer via Ethernet. A connection through a router or network
switch is required. An Ethernet network can be used for one or more computers and
supportsmanyprinters and systems simultaneously. An Ethernet connection is typically
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faster than USB and allows you direct access to the settings of the printer using the
Embedded Web Server.

• Wireless Network: If your environment includes a wireless router or wireless access
point, you can connect the printer to the networkwith awireless connection. Awireless
network connection provides the same access and services as a wired connection. A
wireless network connection is typically faster than USB and allows direct access to
the settings of the printer using the Embedded Web Server.

• Telephone: To send and receive faxes, the multifunction printer must be connected
to a dedicated telephone line.

Connecting to a Computer Using USB

To connect using USB, you need one of these operating systems:

• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server2008
R2, and Windows Server 2012.

• Macintosh OS X version 10.10 and later.
• UNIX and Linux: Your printer supports connection to various UNIX platforms through

the network interface.

For more information, refer to Installing the Software.

To connect the printer to the computer using a USB cable:
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on

the back of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.
3. If the Windows Found New Hardware Wizard appears, press Cancel.
4. Install the print driver.

Connecting to a Wired Network
1. Ensure that the printer is powered off.
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router

socket. Use an Ethernet switch or router, and two or more Ethernet cables. Connect
the computer to the switch or router with one cable, then connect the printer to the
switch or router with the second cable. Connect to any port on the switch or router
except the uplink port.

3. Attach the power cord, then plug in the printer and power it on.
4. Set the network IP printer address, or set up the printer for automatic printer IP

detection. For more information, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect 2 or more devices
in a LAN without a physical connection. The printer can connect to a wireless LAN that
includes a wireless router or wireless access point. Before connecting the printer to a
wireless network, the wireless router must be configured with a service set identifier
(SSID) and any necessary credentials.
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Note
Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

Installing the Wireless Network Adapter

The optional Wireless Network Adapter plugs in to the back of the printer. After the
adapter is installed, and wireless networking is enabled and configured, the adapter is
able to connect to a wireless network.

To install the Wireless Network Adapter:
1. Power off the printer.

2. To remove the Wireless Network Adapter Port Cover, press down on the latch, then
pull the cover away from the printer.

3. Remove the packaging from the Wireless Network Adapter.
4. To install the Wireless Network Adapter, follow the procedure defined on the

instruction sheet provided with the Wireless Network Adapter.
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Note
Pulling on the adapter can damage it. Once installed, remove it only as needed, and
as directed in the Wireless Network Adapter removal instructions. For details, refer
to Removing the Wireless Network Adapter.

5. Power on the printer.

6. Configure the Wi-Fi settings from the front panel or the embedded web server if
connected via ethernet. For more information, refer to Resetting Wireless Settings.

Removing the Wireless Network Adapter
1. Power off the printer.
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2. To unlatch the left-side cover, slide the handle away from the printer, then swing the
handle toward the rear of the printer.

3. To remove the cover, slide it toward the back, then away from the printer.

4. Reach into the printer and push the release lever toward the front of the printer. Hold
the release lever in this position and gently pull the Wireless Network Adapter away
from the printer.

Note
Do not use force to pull on the Wireless Network Adapter. If the latch is released
properly, the adapter pulls out easily. Pulling on a secured adapter can damage it.
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5. To reinstall the Wireless Network Adapter Port Cover, insert the bottom tab into the
small slot. Gently press the port cover against the back of the printer until it latches
into place.

6. Place the left-side cover into place, then slide it toward the front of the printer.

7. To latch the cover, swing the handle toward the front of the printer, then push the
handle in until it clicks into the locked position.
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8. Connect the printer to your computer with a USB cable or to a network using an
Ethernet cable.

9. Power on the printer.

Resetting Wireless Settings

If the printer was previously installed in a wireless network environment, it could retain
setup and configuration information. To prevent the printer from attempting to connect
to the previous network, reset the wireless settings.

To reset the wireless settings:
1. At the printer control panel, press the Home button.
2. Touch Device > Connectivity > Wi-Fi.
3. Touch the network selection that you want to reset.
4. Touch Forget This Network.
5. At the prompt, touch Forget & Reboot.
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Connecting to a Network with a Wi-Fi Protected Setup

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network.
The WPS protocols enable you to set up devices in a secure wireless network without
having wireless networking experience. With a WPS-certified router, you can use tools
in the router and the printer to connect the printer to the network. To use the tools,
ensure that the wireless router is configured properly and is compliant with the WPS.

• Push Button Connection (PBC) is the easiest way to connect the printer to a wireless
network. It automatically connects when you push a button on the router and on the
printer. After the router and printer exchange information, the printer accepts the
security and configuration information from the router and connects to the network.
The PBC is a moderately secure way to connect the printer to the network. You do
not need to enter any information to make the network connection.

• PIN (Personal IdentificationNumber) automatically connects the printer to awireless
router using a common PIN. The printer generates and prints a PIN for use in the
setup process.When you enter the PIN into the router, the router broadcasts network
information using the PIN.When both devices recognize the PIN, the router provides
the security and configuration information to the printer, which uses it to connect to
the network.

Connecting to a WPS Wireless Network Using the PBC Method

To connect to a Wi-Fi Protected Setup (WPS) wireless network using the Push-Button
Connection (PBC) method:

Note
Before you install the device, ensure that the wireless router is configured properly and
is connected to the network.

1. At the printer control panel, press the Home button.
2. Touch Device > Connectivity > Wi-Fi.
3. If Wi-Fi is Off, turn it on.

a) To toggle Wi-Fi from Off to On, touch theWi-Fi toggle button.
b) To activate your Wi-Fi setting changes, press the Home button.
c) At the prompt, touch Restart Now.
d) After the printer restarts, touch Device > Connectivity > Wi-Fi.

4. TouchManual Setup.
5. TouchWi-Fi Protected Setup (WPS).

Note
If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touchManual
Setup.

6. Touch PBC.
7. Touch OK.
8. On the wireless router, press theWPS button.
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Note
If the wireless router does not have a physical PBC button, use your computer to
select the virtual button in the router control panel. For details, refer to your router
documentation.

The router broadcasts setup information for 120 seconds.

9. To activate your Wi-Fi setting changes, restart the printer.
a) Press the Home button.
b) At the prompt, touch Restart Now.

10. After the printer restarts, wait twominutes, then to get the network information that
includes the IP address, print a Configuration Report. For details, refer to Printing the
Configuration Report.

11. At the printer control panel, press the Home button.
12. If Wi-Fi is Off, turn it on.

a) Touch Device > Connectivity > Wi-Fi.
b) To toggle Wi-Fi from Off to On, touch theWi-Fi toggle button.
c) To activate your Wi-Fi setting changes, press the Home button.
d) At the prompt, touch Restart Now.

Note
The following steps can vary with different router manufacturers. For details, refer
to your router documentation.

13. At your computer, open thewireless router control panel, then selectAddWPS Client.
14. Select PIN Method. The wireless router control panel opens to a dialog box ready

for the PIN number.
15. At the printer control panel, touch Device > Connectivity > Wi-Fi.
16. TouchManual Setup.
17. TouchWi-Fi Protected Setup (WPS).

Note
If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touchManual
Setup.

18. Touch PIN.
19. Record the PIN from the screen, then touch OK.

Note
The printer continues to advertise for 120 seconds. If the printer does not locate the
wireless router within 120 seconds, the connection attempt stops.

The printer starts advertising using the displayed PIN Code.

20. At your computer, in the wireless router control panel Client PIN Code field, enter the
PIN code, then click Next.
The printer communicates with thewireless router to resolve setup and configuration
information. When the printer has the correct information, it connects to the router
and restarts with the proper setup and configuration information.
If the router does not connect with the printer within 120 seconds, the connection
attempt stops.
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21. After the printer restarts, wait 20 seconds, then to get the network information that
includes the IP address, print a Configuration Report. For details, refer to Printing the
Configuration Report.

Connecting to a WPS Wireless Network Using the PIN Method

To connect to a Wi-Fi Protected Setup (WPS) wireless network using the PIN method:

Note
Before you install the printer, ensure that you connect and configure the wireless router
for the network.

1. At the printer control panel, press the Home button.
2. If Wi-Fi is Off, turn it on.

a) Touch Device > Connectivity > Wi-Fi.
b) To toggle Wi-Fi from Off to On, touch theWi-Fi toggle button.
c) To activate your Wi-Fi setting changes, press the Home button.
d) At the prompt, touch Restart Now.

Note
The following steps can vary with different router manufacturers. For details,
refer to your router documentation.

3. At your computer, open thewireless router control panel, then selectAddWPS Client.
4. Select PIN Method. The wireless router control panel opens to a dialog box ready

for the PIN number.
5. At the printer control panel, touch Device > Connectivity > Wi-Fi.
6. TouchManual Setup.
7. TouchWi-Fi Protected Setup (WPS).

Note
If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touchManual
Setup.

8. Touch PIN.
9. Record the PIN from the screen, then touch OK.

The printer starts advertising using the displayed PIN Code.

Note
The printer continues to advertise for 120 seconds. If the printer does not locate the
wireless router within 120 seconds, the connection attempt stops.

10. At your computer, in the wireless router control panel Client PIN Code field, enter the
PIN code, then click Next.

The printer communicates with thewireless router to resolve setup and configuration
information. When the printer has the correct information, it connects to the router
and restarts with the proper setup and configuration information.

If the router does not connect with the printer within 120 seconds, the connection
attempt stops.
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11. After the printer restarts, wait 20 seconds, then to get the network information that
includes the IP address, print a Configuration Report. For details, refer to Printing the
Configuration Report.

Connecting to a Wireless Network Manually

When connecting to a wireless network that does not include a WPS-compliant router,
set up and configure the printer manually. Before starting, obtain the router setup and
configuration information, such as name and passphrase. For assistance, contact your
system administrator.

To connect to a wireless network manually:
1. At the printer control panel, press the Home button.
2. Touch Device > Connectivity > Wi-Fi.
3. If Wi-Fi is Off, turn it on.

a) To toggle Wi-Fi from Off to On, touch theWi-Fi toggle button.
b) To activate your Wi-Fi setting changes, press the Home button.
c) At the prompt, touch Restart Now.
d) After the printer restarts, touch Device > Connectivity > Wi-Fi.

4. To connect to a network:

• Touch the name of the network, enter the password for the selected network, then
touch OK.

• If the desired network does not appear, touchManual Setup, then configure the
wireless network settings.

- For Enter the Network Name (SSID), type the name (SSID) of your network,
then press OK.

- Touch Security, then select the security method that your wireless network
uses.

- Touch Enter Password, then enter the password for your wireless network.
- Touch OK.

5. To activate your Wi-Fi setting changes, press the Home button.
6. At the prompt, touch Restart Now.
7. After the printer restarts, wait twominutes, then to get the network information that

includes the IP address, print a Configuration Report. For details, refer to Printing the
Configuration Report.

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer,
or smartphone, using Wi-Fi Direct. Wi-Fi Direct is disabled by default.

Note
Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.
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Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

Connecting to a Telephone Line

Warning
To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

1. Ensure that the printer is powered off.
2. Connect a standard RJ11 cable, No. 26 AmericanWire Gauge (AWG) or larger, to the

Line port on the back of the printer.
3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Power on the printer.
5. Enable and configure the Fax functions.

Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup
includes enabling the optional features and assigning an IP address for the Ethernet
network connection. The installationwizard starts automatically the first time the printer
is powered on. The installation wizard prompts the system administrator to configure
the following settings:

• Language
• Network Connection
• Proxy Server Setup
• Date and Time
• Measurements
• LDAP Settings
• Apps Setup
• Security Settings

For more information on configuring the printer settings, refer to the System
Administrator Guide at www.xerox.com/office/VLC605docs.

Configuring AirPrint

AirPrint® is a software feature that allows you to print from wired or wireless Apple
iOS-based mobile devices and Mac OS-based devices without the need to install a print
driver. AirPrint®-enabled printers allow you to print or fax directly from aMac, an iPhone,
iPad, or iPod touch. You can use AirPrint® to print from awired device or a wireless device
without using a print driver.
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Note

• Not all applications support AirPrint®.
• Wireless devices must join the same wireless network as the printer.
• For AirPrint® to function, both IPP and Bonjour® (mDNS) protocols must be enabled.
• The device that submits the AirPrint® job must be on the same subnet as the printer.

To allow devices to print from different subnets, configure your network to pass
multicast DNS traffic across subnets.

• The Mac OS device must be Mac OS 10.7 or later.
• AirPrint®-enabled printers work with all models of iPad, iPhone (3GS or later), and

iPod touch (3rd generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of
the printer, then press Enter or Return.

Note
If you do not know the IP address for your printer, refer to Finding the IP Address of
Your Printer.

2. In the Embedded Web Server, click Home > Connectivity.

Note
If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint®.
4. To enable AirPrint®, click the Enable toggle button.

Note
AirPrint® is enabled by default when IPP and Bonjour® (mDNS) are both enabled.

• To change the printer name, in the Name field, enter a new name.
• To enter a location for the printer, in the Location field, enter the location of the

printer.
• To enter a physical location or address for the printer, in the Geo-Location field,

enter the geographic latitude and longitude coordinates in decimal form. For
example, use coordinates such as 45.325026, -122.766831 for a location.

5. Click OK.
6. To activate your changes, at the prompt, click Restart Now.

Configuring Google Cloud Print

Google Cloud Print allows you to print documents that are stored in the cloud without
using a print driver.

Before you begin:

• Set up a Google email account.
• Configure the printer to use IPv4.
• Configure Proxy Server settings as needed.
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To configure Google Cloud Print:
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.

Note
If you do not know the IP address for your printer, refer to Finding the IP Address of
Your Printer.

2. In the Embedded Web Server, click Home > Connectivity.
3. For Mobile Printing, click Google Cloud Print.
4. To enable Google Cloud Print, click the Enable toggle button.
5. Click OK.
6. Restart the printer, then wait 2 minutes for the printer to connect.
7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.
8. Click Printer Registration.
9. Click Register.

A printer registration page prints.

10. To register the printer, in yourWeb browser, type theURL provided, or use yourmobile
phone to scan the barcode.
After the printer is registered, a confirmation status window appears.

11. To access the Google Cloud Print feature, in your Google account, clickManage Your
Printer.

Note
The default printer name appears in this format: Model name (MAC address).

Installing the Software

Before installing driver software, verify that the printer is plugged in, powered on,
connected correctly, and has a valid IP address. The IP address usually appears in the
upper, right corner of the control panel. If you cannot find the IP address, refer to Finding
the IP Address of Your Printer.

If the Software and Documentation disc is not available, download the latest drivers
from www.xerox.com/office/VLC605drivers.

Operating System Requirements
• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008

R2, and Windows Server 2012.
• Macintosh OS X version 10.10 and later.
• UNIX and Linux: Your printer supports connection to various UNIX platforms through

the network interface.

Installing the Print Drivers for a Windows Network Printer
1. Insert the Software and Documentation disc into the appropriate drive on your

computer. If the installer does not start automatically, navigate to the drive, and
double-click the Setup.exe installer file.

2. Select your printer model.
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3. Click Install Drivers.
4. Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers.
5. At the License Agreement, click I Agree.
6. From the list of discovered printers, select your printer.

Note
When installing drivers for a network printer, if your printer does not appear in the
list, click the IP Address or DNS Name button. In the IP Address or DNS Name field,
type the IP address of your printer, then click Search to locate and select your printer.
If you do not know the IP address of the printer, refer to Finding the IP Address of
Your Printer.

7. Click Next.
8. If needed, you can name your printer by typing a name in the Queue Name field.
9. If installing a print driver, make a print driver selection.
10. If installing a scan driver, make a scan driver selection.
11. Click Install.
12. If needed, set the printer as the default printer.

Note
Before selecting Share Printer, contact your system administrator.

13. To complete the installation, click Finish, then click Close.

Installing the Print Drivers for a Windows USB Printer
1. Insert the Software and Documentation disc into the appropriate drive on your

computer.
If the installer does not start automatically, navigate to the drive, and double-click
the Setup.exe installer file.

2. Click Install Software.
3. At the License Agreement, select I Agree, then click Next.
4. To install the printer support software, select Software, then click Next.
5. In the Software andDocumentationwindow, clear the check box for any unnecessary

options.
6. Click Next.
7. To complete the installation, click Finish.

Installing the Drivers and Utilities for Macintosh OS X
1. Insert the Software and Documentation disc into the appropriate drive on your

computer.
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.
4. When prompted, click Continue.
5. To accept the license agreement, click I Agree.
6. To accept the current installation location, click Install, or select another location for

the installation files, then click Install.
7. If prompted, enter your password, then click OK.
8. From the list of discovered printers, select your printer, then click Next.
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9. If your printer does not appear in the list of discovered printers:
a) Click the Network Printer Icon.
b) Type the IP address of your printer, then click Continue.
c) Select your printer in the list of discovered printers, then click Continue.

10. If your printer was not detected, verify that the printer is powered on and that the
Ethernet or USB cable is connected properly.

11. To accept the print queue message, click OK.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.

Adding the Printer

For networking, set up your printer using Bonjour® (mDNS), or connect using the IP
address of your printer for an LPD/LPR connection. For a non-network printer, create a
desktop USB connection.

Online Support Assistant at: www.xerox.com/office/VLC605support

To Add the Printer Using Bonjour

To add the printer using Bonjour®:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.

The list of printers appears on the left of the window.

3. For the list of printers, click the Plus icon (+).
4. At the top of the window, click the Default icon.
5. Select your printer from the list, then click Add.

Note
If your printer is not detected, verify that the printer is powered on and that the
Ethernet cable is connected properly.

To Add the Printer by Specifying the IP Address

To add the printer by specifying the IP address:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.

The list of printers appears on the left of the window.

3. Under the list of printers, click the Plus icon (+).
4. Click IP.
5. From the Protocol list, select the protocol.
6. In the Address field, enter the IP address of the printer.
7. In the Name field, enter a name for the printer.
8. From the Use list, choose Select a driver to use.
9. From the printer software list, select the print driver for your printer model.
10. Click Add.
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Installing Scan Drivers for Macintosh
1. Insert the Software and Documentation disc into your computer.
2. To view the .dmg file for your printer, double-click the Disc icon on your desktop .
3. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for

your operating system.
4. Open the Scan Installer package file.
5. To acknowledge the warning and introductory messages, click Continue.
6. To accept the license agreement, click Continue, then click Agree.
7. To accept the current installation location, click Install, or select another location for

the installation files, then click Install.
8. Enter your password, then click OK.
9. Select your printer then click Continue.
10. In the list of discovered printers, click Continue Installation.
11. To restart, click Log Out.

Installing LAN Fax Drivers for Macintosh
1. Insert the Software and Documentation disc into your computer.
2. To view the .dmg file for your printer, double-click the Disc icon on your desktop.
3. Open the LAN Fax Installer.dmg file, then navigate to the appropriate installer file

for your operating system.
4. Open the LAN Fax Installer package file.
5. To acknowledge the warning and introductory messages, click Continue.
6. To accept the license agreement, click Continue, then click Agree.
7. To accept the current installation location, click Install, or select another location for

the installation files, then click Install.
8. Enter your password, then click OK.
9. Select your printer in the list of discovered printers, then click Continue.
10. Click Continue Installation.
11. To finish, click Close.
12. To register your printer and software, complete the registration form.

Adding a LAN Fax Printer for Macintosh

After installing the LAN fax driver on a Macintosh computer, use Bonjour to set up your
printer. You can also add the printer using the IP Address of the printer for an LDP/LPR
connection. For non-network printers, create a desktop USB connection.

Installing Drivers and Utilities for UNIX and Linux

For details on installing print drivers and utilities for UNIX and Linux, refer to UNIX and
Linux Printing.

Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allows a client to discover and access a remote device
and its associated services across a network. WSD supports device discovery, control,
and use.
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More Information

You can obtain more information about your printer from these sources:

LocationResource

Packaged with the printer.Installation Guide

www.xerox.com/office/VLC605docsOther documentation for your printer

United States: www.xerox.com/rmlna
European Union: www.xerox.com/rmleu

Recommended Media List

www.xerox.com/office/VLC605supportTechnical support information for your printer;
including online technical support, Online Sup-
port Assistant, and print driver downloads.

Print from the control panel. For details, refer
to Information Pages.

Information Pages

www.xerox.com/office/VLC605suppliesOrder supplies for your printer

www.xerox.com/office/worldcontactsLocal sales and Technical Customer Support

www.xerox.com/office/registerPrinter registration

www.direct.xerox.com/Xerox® Direct online store
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3
Customize and Personalize

Customize and Personalize Overview
This chapter provides information on how to customize and personalize your device to
meet the specific demands of your workflows.

You can Customize your Apps, hide, or show Apps on the Home screen, and
rearrange the order to suit your job priorities. For each App, you can hide or
show individual features and configure default settings to meet the needs
of your workgroup. You can save job settings for repeated use.
Customization enables users to work more productively.

When individual user accounts are configured on the device, you can Person-
alize the device to meet specific user needs. You can configure your personal
Home page to hide or show only the Apps you use. Each of the feature lists
can be tailored to your job requirements. Default settings for each app can
be specified, and settings for regular jobs can be saved for your use.
Personalization options ensure that the features and functions displayed
meet individual user needs, improving efficiency.
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Customizing or Personalizing the Home
Screen

Hiding or Showing an App on the Home Screen
1. At the printer control panel, press the Home button.
2. Touch Customize.
3. To display an installed App that is hidden initially:

a) Touch the Plus (+) icon.
b) Touch the App that you want to appear on the control panel.
c) Touch Done.

4. To hide an installed App:
a) For the App, touch X.
b) Touch Done.

5. Verify that only the selected Apps appear on the Home screen.

Rearranging Apps on the Home screen
1. At the printer control panel, press the Home button.
2. Touch Customize.
3. Touch and hold the required App.
4. Drag the App to the new location.
5. Release the App.
6. Touch Done.
7. Verify that the Apps appear in the correct location on the Home screen.

Customizing or Personalizing the Apps
Customization enables you to modify the features available, delete a saved preset, or
remove customized settings applied to an App.

Customizing or Personalizing the Feature List

To customize the Features list for an App:
1. At the printer control panel, press the Home button.
2. Touch the App required.
3. Scroll to the bottom, then touch Customize.
4. Touch Feature List.

Note
For logged-in administrators, awindowappears that asks you to confirm if the changes
are for a Guest or for you.

5. Touch the desired option.
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• To hide a feature, for the required feature, touch the Eye icon. To signify that the
feature is hidden, the Eye icon appears with a line across it.

• To show a feature, for the required feature, touch the Eye icon. To signify that
the feature is hidden, the Eye icon appears with a line across it.

6. To reorder the menu features, touch and drag the features into the desired order.
7. To save the current configuration, touch Done.

Customizing or Personalizing the Entry Screen

The Entry Screen appears when the Fax, Email, USB or Scan To Apps are selected. The
Entry Screen provides options for entering recipient or destination details for a job. Use
this procedure to choose the options that to appear on the Entry Screen.

To customize the Entry Screen for an App:
1. At the printer control panel, press the Home button.
2. Touch the App required.
3. Scroll to the bottom, then touch Customize.
4. Touch Entry Screen.
5. Touch the needed options.

Note
For logged-in administrators, awindowappears that asks you to confirm if the changes
are for a Guest or for you.

6. To save the current configuration, touch X.

Saving Presets

You can use this feature to save a particular combination of App settings for future jobs.
You can save the settings with a name and retrieve them for later use.

To save the current App settings:
1. At the printer control panel, press the Home button.
2. Touch the App required.
3. Select the job settings.
4. Scroll to the bottom, then touch Save.
5. Touch Save as New Preset.
6. Touch Enter Preset Name, then to enter a preset name, use the keypad.
7. Touch Next.
8. Select an icon that best suits the preset that you are creating.
9. Touch Done.

Note
The preset is stored within the Preset feature.

Deleting a Saved Preset

To delete a saved preset:
1. At the printer control panel, press the Home button.
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2. Touch the App required.
3. Scroll to the bottom, then touch Customize.
4. Touch Presets.
5. Touch the Trash icon that corresponds with the preset that you want to delete.
6. At the prompt, touch Delete.
7. Touch Done.

Removing App Customization

To remove the current App customization settings:
1. At the printer control panel, press the Home button.
2. Touch the App required.
3. Scroll to the bottom, then touch Customize.
4. Touch Remove App Customization.
5. At the prompt, touch OK.

Customizing App Default Settings

To customize the App default settings:
1. At the control panel, press the Home button.
2. Touch the App required.
3. Configure the required default settings.
4. Touch Save.
5. Touch Save Defaults. The new settings override the previous default settings.
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4
Xerox® Apps

Xerox® Apps are a gateway to the features and functions of your device. There are
standard apps already installed and displayed on the Home screen. There are also apps
that are installed as standard but are hidden when your device is used for the first time.

For details about Customizing theHome screen and the apps features, refer to Customize
and Personalize.

A range of apps is available for download and installation from the Xerox® App Gallery.
These include Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to
install secure, signed apps on compatible printers.

Xerox® App Gallery

Xerox® App Gallery Overview
Use the Xerox® App Gallery to find Apps that provide new features or capab-
ilities for your device. The Xerox® App Gallery provides direct access to Apps
that can improve your productivity, simplify workflows, and enhance your
user experience.
The Xerox® App Gallery enables you to browse and update apps easily. You
can browse through the App library without logging in. The moving banner
provides an active display of apps, or you can scroll the full list of apps. To
get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or
the wired network connection.

Note
If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy
exception at the device.

For further information and instructions on using the Xerox® App Gallery, refer to the
Xerox® App Gallery User Guide available at www.xerox.com/XeroxAppGallery.
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Creating a Xerox® App Gallery Account

With an App Gallery account, you have direct access to all the available Apps for your
device. An AppGallery account allows you to view and acquire Apps, install Apps on your
device, and manage your Apps and licenses.

You can set up an App Gallery account using the control panel or the Embedded Web
Server. For information about accessing the Embedded Web Server, refer to The
Embedded Web Server. You can also create an account at
www.xerox.com/XeroxAppGallery.

Note
If you have an existing Xerox App Gallery Account, refer to Logging in to your Xerox App
Gallery Account.

To create an App Gallery account using the control panel:
1. At the printer control panel, press the Home button.
2. Touch Xerox App Gallery.
3. Touch Request an Account.
4. Touch the Enter your email address. Enter a valid email address using the touch

screen keypad, then touch Enter.
5. Touch OK. A message is displayed stating completion instructions have been sent to

the email address entered.
6. Touch Close.
7. Access your email account for the email address that you provided to Xerox® App

Gallery.
8. Open the Xerox® App Gallery Account Request email, then click the URL link for

creating an account.
9. Review and accept the Terms of Use. To continue creating an account, click theAgree

button.
10. Enter the information required into the appropriate fields:

• User ID
• Password
• Confirm Password
• First and Last Name
• Company Name
• Address (Street, City, State/Province, Postal)
• Country

11. Click OK.
12. After the account is created, a confirmation message appears.
13. At the printer control panel, log in to your App Gallery Account.

Logging in to your Xerox® App Gallery Account

When you are logged in to the App Gallery, you can browse available Apps, and install
and update Apps.
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To log in to your App Gallery Account:
1. At the printer control panel, press the Home button.
2. Touch Xerox App Gallery.
3. Enter your User Name using the touch screen keypad, then touch Enter.
4. Enter your Password using the touch screen keypad, then touch Enter.
5. Touch Log In. The Xerox® App Gallery appears.

Installing or Updating an App from the Xerox®App Gallery

Xerox®Apps add, extend, or customize the functionality of your device. You can use the
Xerox®App Gallery App to browse and install Apps at your device control panel.

Installing an App from the App Gallery
1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.
3. Enter your User Name using the touch screen keypad, then touch Enter.
4. Enter your Password using the touch screen keypad, then touch Enter.
5. Touch Log In. The Xerox® App Gallery appears.
6. Touch the App required, then touch Install. The License Agreement screen appears.

Note
If the Appwas installed previously and a new version is available, the button is labeled
as Update.

7. Touch Agree. The installation process begins.
If the App does not successfully install, to attempt the installation process again,
touch Install.

8. To exit the Xerox® App Gallery App, touch Exit.

Updating an App from the App Gallery
1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.
3. Enter your User Name using the touch screen keypad, then touch Enter.
4. Enter your Password using the touch screen keypad, then touch Enter.
5. Touch Log In. The Xerox® App Gallery appears.
6. Touch the App required, then touchUpdate. The License Agreement screen appears.
7. Touch Agree.
8. When the update is complete, the Update button is labeled as Installed.
9. To exit the Xerox® App Gallery App, touch Exit.
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Device

Device Overview
TheDevice App gives you access to information about your printer, including
the serial number and model. You can view the status of the paper trays,
billing and supplies information, and print Information Pages.

You can configure many Device options tomeet your individual needs. For details about
configuring all Device settings, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

Device Options

The following Device options are available:

DescriptionOption

Language allows you to set the language that appears on the
control panel.

Language

The About option provides an overview of your device and its
current settings and status. You can access Information Pages
and reports using this option.

About

Use this option to check for software updates and configure up-
date settings.

SoftwareUpdate

Use the Notifications option to see details of current alerts or
faults on the device. A History button displays fault codes and
the date that the fault occurred on the device.

Notifications

Use the Paper Trays option to see the paper size, type, and color
set for each paper tray and the tray-capacity status.

Paper Trays

Use the Supplies option tomonitor the status of the components
you can replace. The supply level and estimated number of im-
pressions or days left for each unit is displayed.

Supplies

Use the Billing/Usage option to view the serial number and the
total number of impressions made by your device.

Billing/Usage

Use the General option to customize settings such as the power-
saver modes, date and time, and control panel brightness. You
can configure the General settings using the device control panel,
or by using the Embedded Web Server.

General
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DescriptionOption

Use Apps to select settings for the Apps installed on your device.Apps

Use the Connectivity option to configure network settings at the
control panel, or join another wireless network.

Connectivity

Use this option to access and print the Support Pages to assist
with troubleshooting errors.

Support

Use the Resets option to reset device settings and font, forms,
and macros to the factory-default settings.

Resets

For details on configuring the printer settings, refer to the System Administrator Guide
at www.xerox.com/office/VLC605docs.

About

The About option provides an overview of your device and current settings and status.
You can access Information Pages and reports using this option.

Information Pages

Your printer has a set of information pages that you can print. These pages include
configuration and font information, demonstration pages, and more.

The following Information Pages are available:

DescriptionName

The Configuration Report provides printer information
including installed options, network settings, port setup,
tray information, and more.

Configuration Report

The Billing Summary Report provides information about
the device and a detailed listing of the billingmeters and
sheet counts.

Billing Summary Report

The SuppliesUsageReport provides coverage information
and part numbers for reordering supplies.

Supplies Usage Report

The PostScript Font List provides a printout of all Post-
Script fonts that are available on the printer.

PostScript Font List

The PCL Font List provides a printout of all PCL fonts that
are available on the printer.

PCL Font List
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DescriptionName

Demonstration Print provides a demonstration of the
current print-quality settings.

Demonstration Print

The Startup Page provides basic printer configuration
and network information.

Startup Page

The printer retains information on previous print jobs,
including the date, time, job type, document name, out-
put color, paper size, number of pages, and results. The
status of amaximumof 20 jobs prints on the Job History
Report.

Job History Report

Supply Status

You can check the status and percentage of life remaining for your printer supplies at
the control panel or from the Embedded Web Server. When printer supplies near their
replacement time, warning alerts appear on the control panel. You can customize the
alerts that appear on the control panel and configure email alert notifications.

To check the supplies status and set up alerts using the Embedded Web Server, refer to
the System Administrator Guide at www.xerox.com/office/VLC605docs.

Checking the Supplies Status at the Control Panel
1. To view status information for the printer supplies, touch Device > Supplies.
2. To view details about a specific item, including part numbers for reordering, touch

the desired item.
3. To return to the Supplies screen, touch X.
4. To return to the Device screen, touch the back arrow.

Customizing Supplies Alert Settings
1. To customize the alerts that appear for printer supplies, touch Device > Supplies >

Alerts Setup.
2. To enable supplies alerts, touch the Enable Alerts toggle button.
3. To configure the printer to display an alert when an item reaches a specific usage

percentage level, touch the item, then select the percentage.
4. To customize the alerts for each supply item, or to enable or disable an alert, touch

the toggle button.
5. To return to the Supplies screen, touch X.
6. To return to the Device screen, touch the back arrow.

Setting Up Email Alerts

To check the supplies status and set up alerts using the Embedded Web Server, refer to
the System Administrator Guide at www.xerox.com/office/VLC605docs.
1. To set up alerts to send to an email address, touchDevice > Supplies > Email Alerts.
2. To enter an email address, touch Add Email, then touch Enter Email Address.
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3. Use the touch screen keyboard to enter an email address, or select an entry from the
Address Book, then touch OK.

4. Add more email addresses if necessary.
5. To customize the alerts for each supply item, or to enable or disable an alert, touch

the toggle button.
6. To exit the menu, touch OK.
7. To return to the Device screen, touch the back arrow.

Billing and Usage Counters

The Billing/Usage menu displays the total number of impressions that the printer
generated or printed during its lifetime. You cannot reset the counters. A page is counted
as one side of a sheet of paper. For example, a sheet of paper that is printed on two
sides counts as two impressions.

To view the Billing and Usage Counters:
1. At the printer control panel, press the Home button.
2. Touch Device > Billing/Usage.
3. To view more details, touch Usage Counters, then select an option.

• Impression Counters: This option provides the number of impressions made by
the printer. The number of impressions cannot equal the number of sheets counted,
depending on the printer setup. If your printer is set up to count large sheets as
large impressions or as multiple smaller impressions, the number of impressions
can differ.

• Sheet Counters: This option provides the number of impressions made by the
printer. Impressions for 2-Sided sheets are identified as a separate line from1-Sided
sheets.

• Images Sent Counters: This option provides the number of images sent using
the Fax, Email, or Scan features.

• Fax Impressions Counters: This option provides the number of images sent using
the Fax features. Each fax feature is identified on a separate line.

• All Usage Counters: This option provides all printer usage information.

4. After viewing the usage readings, to return to the Home screen, press the Home
button.

Reset to Factory Defaults

Caution
The Reset to Factory Defaults feature erases all settings and returns the printer to the
original factory state. All jobs, presets, Apps, and device settings are reset.

The non-volatilememory (NVRAM) stores printer settings, even after the power is turned
off. When complete, the printer restarts, then displays the Install Wizard.

To reset the printer to factory defaults:
1. At the printer control panel, press the Home button.
2. Touch Device > Resets > Reset to Factory Defaults.
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3. At the prompt, touch Reset.
4. When the process is complete, the printer restarts automatically.

Remote Services

You can use the Remote Services option in the Embedded Web Server to send error and
usage information to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox,
refer to the System Administrator Guide at www.xerox.com/office/VLC605docs.

Address Book

Address Book Overview
Use the Device Address Book to create individual contacts or group contacts
for use with the Email, Fax, and Scan To Apps. You can add contacts to the
Device Address Book using the control panel or the Embedded Web Server.
This feature can also be used to scan to the Address Book contacts.

TheDevice Address Book stores amaximumof 2000 contacts. If the CreateNewContact
button is unavailable, the address book has reached capacity.

Before you can use this feature, the System Administrator must enable users to view
and manage the Device Address Book.

Editing the Address Book

You can create and save contact information for individual contacts or groups. You can
manage address book contacts at the control panel, or in the Embedded Web Server.

Adding or Editing Contacts in the Address Book at the Control Panel

To Add Contacts in the Address Book at the Control Panel
1. At the printer control panel, press the Home button.
2. Touch Address Book.
3. Touch the Plus icon (+), then select Add Contact.
4. To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company

field, then enter the information. Tomove to the next field, touchNext. When finished,
touch Enter.

5. Enter the contact details:

• To add an email address to the contact, touch Add Email. Enter an email address,
then touch Enter.

• To add a fax number to the contact, touch Add Fax. Enter a fax number, then
touch Enter.

• To add an SMB scan location, touch Add SMB. Browse to the location required,
then touch Enter.
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• To add an FTP scan location, touch Add FTP. Browse to the FTP location or enter
the FTP address, then touch Enter.

Note
If authentication is required for scan locations, enter a valid login name and
password.

6. To mark the email address or fax number as a favorite, touch the Star icon.
7. To save the contact, touch OK.
8. To return to the Home screen, press the Home button.

To Edit or Delete Contacts in the Address Book at the Control Panel
1. At the printer control panel, press the Home button.
2. Touch Address Book.
3. From the Address Book, touch a contact name, then touch Edit.
4. To change contact information, touch the information that you want to update, edit

as needed, then touch OK.
5. To save your contact changes, touch OK.
6. To delete a contact, touch Delete Contact, then touch Delete.
7. To return to the Home screen, press the Home button.

Adding or Editing Groups in the Address Book at the Control Panel

To Add Groups in the Address Book at the Control Panel
1. At the printer control panel, press the Home button, then touch Address Book.
2. Touch the Plus icon (+), then select Add Group.
3. Select the group type, enter a name for the group, then touch Enter.
4. To add group members, touch Add Member.
5. To add a contact name, from the Favorites or Contacts menu, select a contact.
6. To add more group members, touch Add Member, then select a contact.
7. To mark the group as a favorite, touch the Star icon.
8. To save the group, touch OK.
9. To return to the Home screen, press the Home button.

To Edit or Delete Groups in the Address Book at the Control Panel
1. At the printer control panel, press the Home button.
2. Touch Address Book.
3. From the Address Book, select a group, then touch Edit.
4. To add group members, touch Add Member.
5. To add a contact, from the Favorites or Contacts menu, select a contact.
6. To add more group members, touch Add Member, touch Add Member, then select

a contact.
7. To remove group members, for each contact, touch the Trash icon. At the prompt,

touch Delete.
8. To save the changes, touch OK.
9. To delete the group, touch Delete Group, then touch Delete.
10. To return to the Home screen, press the Home button.
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Adding or Editing Contacts in the Address Book in the Embedded Web
Server

To Add Contacts in the Address Book in the Embedded Web Server

To add contacts:
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.
2. In the Embedded Web Server, click Address Book.
3. Click Add Contact.
4. To enter a name, click the First Name, Last Name, or Company field, then enter the

details.
5. Enter the contact details.

• To add an email address to the contact, click the Email Plus icon (+), then enter
an email address.

• To add a fax number to the contact, click the Fax Plus icon (+), then enter a fax
number.

• To add an SMB scan location, click the (Network) SMB Plus icon (+), then enter
the SMB details. Click OK.

• To add an FTP scan location, click the FTP Plus icon (+), then enter the FTP details.
Click OK.

6. To mark the email address or fax number as a favorite, touch the Star icon.
7. To save the contact, click OK.

To Edit or Delete Contacts in the Address Book in the Embedded Web
Server

To edit or delete contacts:
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.
2. In the Embedded Web Server, click Address Book.
3. From the Address Book, select a contact.
4. To edit contact information, perform the following steps.

a) Click the contact name or contact information, then edit as needed.
b) To clear contact information, for the specific contact information, click the Trash

icon.
c) To save the changes, click OK.

5. To remove the selected contact from the Address Book, click Delete. At the prompt,
click Delete.
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Adding or Editing Groups in the Address Book in the Embedded Web
Server

To Add Groups in the Address Book in the Embedded Web Server

To add groups:
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.
2. In the Embedded Web Server, click Address Book.
3. Click Add Group.
4. For Enter Group Name, enter a name for the group.
5. From the menu, select the group type.
6. To add group members, for Members, click the Plus icon (+).
7. To add contacts to the group, in the Add Members window, for each contact, select

the check box. When you are finished, click OK.
8. To save the group, click OK.

To Edit or Delete Groups in the Address Book in the Embedded Web
Server

To edit or delete groups:
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.
2. In the Embedded Web Server, click Address Book.
3. Within the address book, select a group.
4. To add group members:

a) For Members, click the Plus icon (+).
b) In the Add Members window, click the check box for each desired member.
c) To save the changes, click OK.

5. To remove group members:
a) For the desired member, click the Trash icon.
b) At the prompt, click Delete.
c) Repeat the previous two steps for each member.
d) To save the changes, click OK.

6. To remove the selected group from the Address Book, click Delete. At the prompt,
click Delete.

Advanced Settings

The Advanced option providesmore settings for importing and exporting contact details
and managing contacts. You can use the Advanced option to set up a directory service.

For details about the Advanced options, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.
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Managing Favorites

You canmark contacts as Favorites. A star next to a contact in the list indicates a Favorite.
You can mark a favorite as a Global Favorite for all services or as a Favorite for email,
fax, or scan-to destinations.

Managing Favorites at the Control Panel
1. At the printer control panel, press the Home button, then touch Address Book.
2. Select a contact, then touch Edit.
3. To make the contact a Global Favorite, for the contact name, touch the Star icon.
4. To mark a contact as a Favorite for email, fax, or a scan-to destination:

a) For each desired feature, touch the Star icon.
b) To save changes, touch OK.

5. To clear a contact marked as a Favorite:
a) To remove the contact as a Global Favorite, for the contact name, touch the Star

icon.
b) To remove the contact from the Favorite list for a selected feature, for the selected

feature, touch the Star icon.
c) To save changes, touch OK.

6. To return to the Home screen, press the Home button.

Managing Favorites in the Embedded Web Server
1. In the Embedded Web Server, click Address Book.
2. Select a contact.
3. To make the contact a Global Favorite, click the Global Favorite Star icon.
4. To mark a contact as a Favorite for email, fax, or a scan-to destination, for each

feature, click the Star icon.
5. To remove a contact marked as a Favorite, for Global Favorite or the selected feature,

touch the Star icon. The contact is removed from the Global Favorite list, or the
Favorite list for the selected feature.

6. To save changes, click OK.

Jobs

Jobs Overview
Use Jobs to view current jobs, print saved, personal, and secure jobs, and
view details of completed jobs. You can pause, delete, print, or view job
progress or job details for a selected job.
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Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or
completed jobs. You can pause, delete, print, or view job progress or job details for a
selected job. From the Jobs window in the Embedded Web Server, you can view a list of
active and completed print jobs. For more details, refer to Managing Jobs Using the
Embedded Web Server.

A print job can be held by the printer when it is unable to complete a print job. For
example, when the printer needs attention, paper, or supplies. When the condition is
resolved, the printer automatically resumes printing. When you send a Secure Print job,
the job is held until you release it by typing a passcode at the control panel. For more
details, refer to Managing Special Job Types.

Pausing the Print Job with the Option to Delete It
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the desired print job.
3. Do one of the following:

• To pause the print job, touch Pause. To resume the print job, touch Resume.
• To delete the print job, touch Delete. At the prompt, touch Delete.

Note
If you do not make a selection within 60 seconds, the job automatically resumes.

4. To return to the Home screen, press the Home button.

Viewing, Printing, or Deleting Saved and Secure Jobs
Note

• The system administrator can restrict users from deleting jobs. If a system
administrator has restricted job deletion, you can view the jobs, but not delete them.

• Only the user that sent the job or the system administrator can delete a Secure Print
job.

1. At the printer control panel, press the Home button.
2. To view a list of active and completed jobs, touch Jobs.
3. To view a list of specific job types, touch an option.

• To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the
quantity, then touch OK. To delete the job, touch the Trash icon, then touch
Delete.

• To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the
folder, then touch Print All, or Delete All.

• For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the
passcode number, then touch OK. To print a Secure Job, touch the job. To print
or delete all the jobs in the folder, touch Print All, or Delete All.

4. To view details about a job, touch the job.
5. To return to the Home screen, press the Home button.
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Printing a Job Held for Resources
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. From the jobs list, touch the held job name. The resources required for the job appear

on the control panel.
4. Do one of the following:

• To print the job, replenish the resources required. The job resumes automatically
when the required resources are available. If the job does not print automatically,
touch Resume.

• To delete the print job, touch Delete. At the prompt, touch Delete.

5. To return to the Home screen, press the Home button.

Managing Special Job Types

Special job types allow you to send a print job from your computer, then print it from
the printer control panel. Select special job types in the print driver, Printing Options tab,
under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for
future use. Any user can print or delete a Saved Job.

Printing a Saved Job
1. In your software application, access the print settings. Formost software applications,

press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

• For Windows, click Printer Properties. Depending on your application, the title of
the button can vary.

• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Saved Job.
4. Type a job name or select a name from the list, then click OK.
5. Select any other required printing options.

• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Saved Job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Saved Jobs, touch Saved Jobs.
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK.
5. To delete the document after printing, for that job, touch the Trash icon, then at the

prompt, touch Delete.
6. To return to the Home screen, press the Home button.
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Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it
is held at the printer until you enter your passcode at the printer control panel.

Printing by Using Secure Print
1. In your software application, access the print settings. Formost software applications,

press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

• For Windows, click Printer Properties. Depending on your application, the title of
the button varies.

• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.

• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Secure Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. Enter the passcode number, then touch OK.
6. Select an option:

• To print a Secure Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete a Secure Print job, touch the Trash icon, then at the prompt, touch

Delete.
• To delete all the jobs in the folder, touch Delete All.

Note
After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.

Personal Print

Personal Print allows you to store a document in the printer, then print it from the control
panel.

Note
The Personal Print feature is only available on aWindows computer printing to a network
printer.
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Personal Print is a type of saved job with these features:

• A Personal Print job appears in a folder named after the user ID associated with the
print job.

• A Personal Print job does not use a passcode.
• Any user can print or delete a Personal Print job.
• You can print all jobs in the list at once, delete an individual job, or delete all jobs in

the list.
• After a Personal Print job is printed, it is deleted automatically.

Using Personal Print
1. In your software application, access the print settings. Formost software applications,

click File > Print or for Windows, press CTRL+P.
2. Select your printer, then click Printer Properties. Depending on your application, the

title of the button varies.
3. For Job Type, select Personal Print.
4. Select any other required printing options, then click OK.
5. To send the job to the printer, click Print.

Releasing a Personal Print job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Personal Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. If prompted for a passcode, touch Skip.

Note
When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

6. Select an option.

• To print a Personal Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the
remaining copies. After reviewing the sample set, you can either print the remaining
copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

• A Sample Set job appears in a folder named after the user ID associated with the
print job.

• A Sample Set job does not use a passcode.
• Any user can print or delete a Sample Set job.
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• A Sample Set prints one copy of a job to allow you to proofread the job before printing
any remaining copies.

After a Sample Set job is printed, it is deleted automatically.

Printing by Using Sample Set
1. In your software application, access the print settings. Formost software applications,

press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

• For Windows, click Printer Properties. Depending on your application, the title of
the button varies.

• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.
4. Select any other required printing options.

• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.
3. Touch the Sample Set job.

Note
The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.

• To print the remaining copies of the job, touch Release.
• To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

Managing Jobs Using the Embedded Web Server

You can view a list of active jobs and delete print jobs from the Active Jobs list in the
EmbeddedWeb Server. You can use the EmbeddedWeb Server to submit jobs for printing
at the device. You can print .pdf, .ps, .pcl, .prn, .xps, .jpg, .tif and .txt files directly from
the Embedded Web Server without opening another application or the print driver. The
files can be stored on a local computer hard drive, mass storage device, or network drive.
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.
2. In the Embedded Web Server, click Jobs.
3. Click the job name.
4. Do one of the following:

• To pause the print job, click Pause. To resume the print job, click Resume.
• To delete the print job, click Delete. At the prompt, click Delete.
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5. To return to the Home screen, click Home.

Submitting Jobs for Printing Using the Embedded Web Server
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.
2. In the Embedded Web Server, click Home.
3. In the Quick Links area, click Submit File.
4. Click the Submit field.
5. In the selection window, select a file to print, then click Open.
6. To print the document, click Submit.

Copy

Copy Overview
To make a copy, the device scans your original documents and temporarily
stores the images. The image print based on the options selected.

If Authentication or Accounting has been enabled on your device, enter your login details
to access Copy features.

You can adjust various settings for individual Copy jobs and save settings as Presets for
future jobs. The list of features can be customized, and some features could be hidden
from view when the App is installed. To view all available features and to find out more
about customizing the Copy App, refer to Customize and Personalize.

For information about all the App features and available settings, refer to Apps Features.

Making a Copy

To make a copy:
1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.
3. Load your original documents.

• Use the document glass for single pages or paper that cannot be fed using the
single-pass duplex automatic document feeder. Lift the document feeder, then
place the original document face down in the upper-left corner of the document
glass.
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• For single, multiple, or 2-sided pages, use the single-pass duplex automatic
document feeder. Remove any staples and paper clips from the pages. Insert the
original documents face up in the document feeder, with the top of the page
entering the feeder first. Adjust the paper guides so that they fit against the
original documents.

4. Touch Copy, then enter the number of copies needed.

Note
To amend the number of copies entered, touch the X button, then enter the required
quantity.

5. If scanning from 2-sided original documents, touch 2-Sided, then select an option.
6. Adjust copy settings as needed.

For details about available features, refer to Apps Features.

7. Touch Start. If you placed documents in the feeder, scanning continues until the
feeder is empty.

8. If you are scanning from the document glass, when prompted, do one of the following:

• To complete the job and return to the Copy app, touch Done.
• To scan another page, load a new original document on the document glass, then

touch Add Page.
• To delete the scan and return to the Copy app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

9. To return to the home screen, press the Home button.
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Stapling a Copied Document

With the optional finisher installed on the printer, copied documents can be stapled.
1. From the Copy app, touch Staple.
2. Touch 1 Staple.
3. Touch Save.
4. Touch Start.

The stapled copy is delivered to the finisher.

Copy Workflows
Note
Some features are hidden from view when the Copy App is installed. For more
information, refer to Customize and Personalize.

Adjusting Color Balance

If you have a color original image, you can adjust the balance of the printing colors
between cyan, magenta, yellow, and black before printing your copy.

To adjust the Color Balance
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Color Balance.
4. To adjust the highlight, midtone, and shadow density levels by color, touch the color

that you want to adjust, then move the sliders to increase or decrease the density
levels.

5. Touch OK.

To adjust the Saturation
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Saturation.
4. To adjust the saturation, move the slider.
5. Touch OK.

To add Color Effects
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Color Effects.
4. Select the required option. A confirmation message appears.
5. To accept the new color settings, touch Apply.

Adjusting Contrast Settings

You can adjust the variation between light and dark areas of your copy using the Contrast
feature. You can reduce the sensitivity of the printer to variations in light background
colors using Auto Background Suppression.
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To adjust the Auto Background Suppression and Contrast:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Image Enhancement.
4. To enable Auto Background Suppression, touch the Auto Background Suppression

toggle button.
5. To enable Auto Contrast, touch the Auto Contrast toggle button.
6. To adjust the Contrast manually, ensure that the Auto Contrast toggle button is off,

then move the slider to increase or decrease the contrast.
7. Touch OK.

Changing the Page Layout

You can use Page Layout to place a defined number of pages on one or both sides of
the paper.

To change the page layout:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Page Layout.
4. Select the required number of pages per side.
5. To change the Original Orientation, touch Page Layout, then touchMore. Select

Portrait or Landscape.

Note
The Original Orientation option is only available when the selected number of pages
per slide is 2, 4, or 8.

6. To change the Image Order, touch Page Layout, then touchMore. Select one of the
following options.

• Right then Down: This option prints the images across the page, row by row.
• Down then Right: This option prints the images down the page, columnby column.

Note
The Image Order option is only available when the selected number of pages per
slide is 4 or 8.

7. Touch OK.

Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound
documents. You can use this feature to copy images for different results.

• Copy either the left or right page onto a single sheet of paper.
• Copy both the left and right pages onto two sheets of paper.
• Copy both the left and right pages as a single image onto one sheet of paper.
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Note
To make copies from books, magazines, or other bound documents, use the document
glass only. Do not place bound original documents in the document feeder.

To set up book copying:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Book Copying.
4. TouchMode, then select one of the following options:

• Off: This option is the default setting.
• Both Pages: This option scans both pages of an open book onto two sheets of

paper.
• Left/Right Page Only: This option scans the left or right page of an open book

onto a single sheet of paper.

5. If Binding Edge Erase is required, touch Binding Edge Erase, then move the slider to
the right to erase up to 50 mm (1.97 in.).

6. Touch OK.

Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image
is smaller than the page size. For image shift towork correctly, position original documents
as follows:

• Document Feeder: Position original documents face up, short edge entering the
feeder first.

• Document Glass: Position original documents face down, in the upper-left corner of
the document glass, short edge to the left.

To change the placement of the image:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Image Shift.
4. Select one of the following options.

• Off: This option is the default setting.
• Auto Center: This option centers the image on the page.
• Snap to Edge: This option shifts the image to the edge of the document. Select

one of the image-position options.

- Mirror Side 1: This option allows you to set the Image Shift for Side 1, and
matches the Side 2 Image Shift accordingly. To move the image to the
required edge of the page, touch the appropriate arrow.

- Independent Sides: This option allows you to position the images on Side
1 and Side 2 independently of each other. To move each image to the
required edge of the page, touch the appropriate arrow.

• Manual: This option allows you to specify the amount of Image Shift required.
Select one of the image-position options.
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- Mirror Side 1: This option allows you to set the Image Shift for Side 1, and
matches the Side 2 Image Shift accordingly. Touch the appropriate fields.
To adjust the image shift, move the slider.

- Independent Sides: This option allows you to position the images on Side
1 and Side 2 independently of each other. Touch the appropriate fields. To
adjust the image shift, move the slider.

5. To specify the orientation of the original document, touchOriginal Orientation, then
select an option.

6. Touch OK.

Creating a Booklet

The booklet feature reduces the original page images to fit two images on each side of
the printed page. You can print copies in booklet format.

Note

• This booklet option is available on printers with an optional Productivity Kit installed
only.

• In Booklet mode, the printer scans all of the original documents before it prints the
copies.

To create a booklet:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Booklet Creation.

Note
If Reduce/Enlarge has been adjusted, a message appears confirming that
Reduce/Enlarge has changed toAuto%. If Paper Supply has been set toAuto Select,
a message appears confirming that Paper Supply has changed to Tray 1.

4. Touch the Booklet Creation toggle button.
5. Touch Original Document, then select the option that matches your original

documents:

• 1-Sided Original: This option scans only one side of the original image and
produces 1-sided output files.

• 2-Sided Original: This option scans both sides of the original image.
• 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating

the second side.

6. If a cover sheet is required, touch the Cover toggle button, then adjust Paper Supply
and Print On Coveras needed.

7. Touch OK.

Adding a Front Cover

You can print the first page of your copy job on different paper, such as colored or
heavyweight paper. The printer selects the special paper from a different tray. The cover
can be blank or printed.
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Note
This function is available only on printers with an optional Productivity Kit installed only.

To add a front cover to your copy job:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Front Cover.
4. Touch the Front Cover toggle button.

Note
If Paper Supply is set toAuto Select, a notification appears confirming that the Paper
Supply has been changed to Tray 1.

5. Touch Printing Options, then select an option.

• Blank: This option inserts a blank front cover.
• Print on Side 1 Only: This option prints on the front side of the cover only.
• Print on Side 2 Only: This option prints on the back side of the cover only.
• Print on Both Sides: This option prints on both sides of the cover.

6. Touch Paper Supply, then select the required paper source.
7. Touch OK.

Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You
can specify the amount to erase on the right, left, top, and bottom edges.

To erase the edges of copies:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Edge Erase.
4. Select one of the following options.

• All Edges: This option erases all four edges by the same amount. To adjust the
amount to erase, move the slider.

• Print to Edge: This option prints with no edge erase.
• Individual Edges: This option allows you to specify different amounts to erase

from the edges. Select an erase option.

- Mirror Edges: This option allows you to set the Edge Erase for Side 1, and
matches the Side 2 Edge Erase accordingly. To adjust the edge erase, move
the slider.

- Independent Edges: This option allows you to set the Edge Erase on Side 1
and Side 2 independently of each other. Touch the appropriate field. To
adjust the Edge Erase, move the slider.

5. To specify the orientation of the original document, touchOriginal Orientation, then
select an option.

6. Touch OK.
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Printing a Sample Copy

Sample Copy allows you to print a test copy of a job to inspect before printing multiple
copies. This feature is useful for complex or high-volume jobs. After you print and inspect
the test copy, you can choose to print or cancel the remaining copies.

To print a sample copy of your job:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Adjust the copy settings as needed.
4. Enter the number of copies needed.
5. Touch the Sample Copy toggle button.
6. Touch the Start button. The sample copy prints.
7. Inspect the sample copy, then select one of the following options.

• If the copy is unsatisfactory, touchDelete. The job is canceled and nomore copies
are printed.

• If the copy is satisfactory, touch Release. The remaining copies are printed.

8. To return to the home screen, press the Home button.

Adding Annotations

You can use the Annotations feature to add a page number, comment, date, or Bates
Stamp to your copies.

Note

• This function is only available on printers with an optional Productivity Kit installed.
• If Booklet Creation is selected, you cannot add Annotations.

To add annotations:
1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Annotations.
4. To insert page numbers:

a) Select the required page location, then touch Page Number.
b) Enter the starting page number.
c) To adjust which pages contain the selected annotation, touch Apply To, then

select All Pages or All Pages Except First.
d) Touch OK.

5. To insert a comment:
a) Select the required page location, then touch Comment.
b) Select the required entry, then touch OK.

Note
To create a comment, touch the edit icon forNot in Use. Enter the required text,
then touch OK.
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c) To adjust which pages contain the selected annotation, touch Apply To, then
select the required option.

d) Touch OK.

Note
To create a prefix, touch the edit icon for Not in Use. Enter the required text, then
touch OK.

6. To insert the current date:
a) Select the required page location, then touch Date Stamp.
b) Touch Format, then select the required date format.
c) To adjust which pages contain the selected annotation, touch Apply To, then

select the required option.
d) Touch OK.

7. To insert a Bates Stamp:
a) Select the required page location, then touch Bates Stamp.
b) Touch Prefix, then select the required entry. Touch OK.

Note
To create a prefix, touch the edit icon for Not in Use. Enter the required text,
then touch OK.

c) Touch Starting Number. Enter the required starting number, then touch OK.
d) Touch Number of Digits, then select the required option.
e) To adjust which pages contain the selected annotation, touch Apply To, then

select the required option.
f) Touch OK.

8. To change the text formatting, touch Format & Style. Adjust the settings as required,
then touch OK.

9. Touch OK.
10. If necessary, to remove all entered annotations, touch Delete All.

Note
Not all annotations are available in all page locations.

ID Card Copy

ID Card Copy Overview
You can use the ID Card Copy App to copy both sides of an ID card or small
document onto one side of paper. To copy the card, place each side in the
upper-left corner of the document glass. The printer stores both sides of the
document, then prints them side by side on the paper.

The ID Card Copy App is hidden from view on initial device setup. The list of features
can be customized, and some features can be hidden from view. For more information
about adding and customizing Apps, refer to Customize and Personalize.
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For information about all the App features and available settings, refer to Apps Features.

Copying an ID Card

To copy an ID card:
1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.
3. Lift the automatic document feeder, then place the original document in the upper-left

corner of the document glass.
4. Touch ID Card Copy.
5. Adjust the settings as required.
6. Touch Scan.
7. When scanning is finished, lift the automatic document feeder. Flip the original

document, then place it in the upper-left corner of the document glass.
8. To scan the second side of the original document and print the copies, touch Scan.
9. To return to the home screen, press the Home button.

Email

Email Overview
You can use the Email app to scan images and attach them to emails. You
can specify the file name and format of the attachment, and include a
subject heading and message for the email.

You can adjust various settings for individual Email jobs and save settings as Presets for
future jobs. The list of features can be customized, and some features could be hidden
from view when the App is installed. To view all available features and to find out more
about customizing the Email App, refer to Customize and Personalize.

For information about all the App features and available settings, refer to Apps Features.

Sending a Scanned Image in an Email

To send a scanned image in an email:
1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.
3. Load your original documents.

• For single pages or paper that cannot be fed using the single-pass duplex automatic
document feeder, use the document glass. Lift the automatic document feeder,
then place the original documents face down in the upper-left corner of the
document glass.
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• For multiple, single, or 2-sided pages, use the single-pass duplex automatic
document feeder. Remove any staples or paper clips from the pages. Insert the
original documents face up in the automatic document feeder, with the top of
the page entering the feeder first. Adjust the paper guides so that they fit against
the document originals.

4. Touch Email.
5. Enter recipients:

• To enter the email address manually into the To field, type the address using the
touch screen keypad. Touch Enter.

• To select a contact or group from the Address Book, touch the Address Book icon.
Touch Favorites or Contacts, then select a recipient.

6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select
an option.

7. Adjust the email settings as needed:

• To save the scanned document with a specific file name, touch the attachment
file name, enter a new name using the touch screen keypad, then touch Enter.

• To save the scanned document with a specific file format, touch the attachment
file format, then select the required format.

To create a searchable file or to add password protection, from the File format,
selectMore.

• To change the subject line, touch Subject, enter a new subject line using the touch
screen keypad, then touch Enter.

• To change the email body message, touchMessage, enter a new message, then
touch OK.
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For details about available features, refer to Apps Features.

8. To start the scan, touch Send.
9. If you are scanning from the document glass, when prompted, to finish, touchDone,

or to scan another page, touch Add Page. To cancel a job, touch Cancel Job.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

10. To return to the Home screen, press the Home button.

Scan To

Scan To Overview
The Scan To feature provides several methods for scanning and storing an
original document. The scanning procedure using your printer differs from
that of desktop scanners. The printer is connected typically to a network
rather than a single computer, so you select a destination for the scanned
image at the printer.

The printer supports the following scanning functions:

• Scan original documents to an email address.
• Scan original documents to a USB Flash drive. This is available using the USB app.

Refer to .
• Scan original documents to your home folder.
• Scan original documents to a shared network location using SMB and FTP transfer

protocols.

You can adjust various settings for individual Scan To jobs and save settings as Presets
for future jobs. The list of features can be customized, and some features could be hidden
from view when the App is installed. To view all available features and to find out more
about customizing the Scan To App, refer to Customize and Personalize.

For information about all the App features and available settings, refer to Apps Features.

Scanning to an Email Address

Before you scan to an email address, ensure that you configure the printer with the
email server information. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

To scan an image and send it to an email address:
1. Load the original document on the document glass or into the duplex automatic

document feeder.
2. At the control panel, touch the Home button.
3. Touch Scan To.
4. Enter recipients.
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• To enter the email address manually, touch Email, then enter an email address.
Touch Enter.

• To select a contact or group from the Address Book, touch Contacts.

5. To save the scanned document as a specific file name, touch the attachment file
name, then enter a new name using the touch screen keypad. Touch Enter.

6. To save the scanned document as a specific file format, touch the attachment file
format, then select the required format.

Note
To make scanned documents searchable, your system administrator can enable the
Searchable feature.

7. Adjust scanning options as needed.
8. To change the subject line, from Email Features, touch Subject, then enter a new

subject line using the touch screen keypad. Touch Enter.
9. To change the email bodymessage, from Email Features, touchMessage, then enter

a new message. Touch OK.
10. To begin the scan, touch Scan.
11. If you are scanning from the document glass, when prompted, to finish, touchDone,

or to scan another page, touch Add Page.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

12. To return to the Home screen, press the Home button.

Scanning to a User Home Folder

Scan to Home allows you to scan documents that are saved to a home directory on an
external server. The home directory is distinct for each authenticated user. The directory
path is established through LDAP.

Before You Begin

To scan to the home folder defined in an LDAP directory, first ensure that the home
folder locations are defined for each user.

If you want to scan to a shared folder on the network, create a shared folder on your
network with read and write access privileges.

Note
For assistance, contact your system administrator.

Scanning to a Home Folder
Note
If LDAP Network Authentication is configured, the Home button appears as an option
that you can select on the Scan To screen.

1. Load the original document on the document glass or into the duplex automatic
document feeder.
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2. At the printer control panel, press the Home button.
3. To log in to the printer, touch Log In.
4. Enter your user name, then touch Next.
5. Enter your password, then touch OK.
6. To scan to a home folder, select an option:

• Touch Scan To. On the Scan To screen, touch Home.
• TouchMy Folder.

7. To save the scanned document as a specific file name, touch the attachment file
name, enter a new name using the touch screen keypad, then touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file
format, then select the desired format.

9. Adjust scanning options as needed.
10. To begin the scan, press Scan.

If you are scanning from the document glass, when prompted, to finish, touchDone,
or to scan another page, touch Add Page.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

11. To return to the Home screen, press the Home button.

Scan to Desktop

Before you begin:

• Before scanning, ensure that your computer and the printer are plugged in, powered
on, and connected to an active network.

• On your computer, ensure that you have the correct print driver software installed.
For details, refer to Installing the Software.

• On your computer, ensure that the printer is installed using WSD. For details, refer to
Installing the Software.

• On your printer, ensure thatWSD is enabled. For details, refer the SystemAdministrator
Guide at www.xerox.com/office/VLC605docs.

To Scan to Desktop:
1. Load the original document on the document glass or into the duplex automatic

document feeder.
2. At the printer control panel, press the Home button.
3. Touch Scan to Desktop.
4. To select a destination, touch the computer address.
5. To begin the scan, press Scan.

The Windows Fax and Scan application opens on your PC desktop. The image file of
your scan is saved to the Scanned Documents folder.

6. If you are scanning from the document glass, when prompted, to finish, touchDone,
or to scan another page, touch Add Page.
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Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

7. To return to the Home screen, press the Home button.

Scanning to a Shared Folder on a Network Computer

Before you can use the printer as a scanner on a network do these steps:

• Create a shared folder on your computer hard drive.
• Access the EmbeddedWeb Server, then create an address that points the scanner to

the computer.

Sharing a Folder on a Windows Computer
1. Open Windows Explorer.
2. Right-click the folder you want to share, then select Properties.
3. Click the Sharing tab, then click Advanced Sharing.
4. Select Share this folder.
5. Click Permissions.
6. Select the Everyone group, then verify that all permissions are enabled.
7. Click OK.

Note
Remember the Share name for later use.

8. Click OK again.
9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later
1. From the Apple menu, select System Preferences.
2. From the Internet & Wireless menu, select Sharing.
3. From the Service menu, select File Sharing.
4. Under Shared Folders, click the Plus icon (+).
5. Browse to the folder that you want to share on the network, then click Add.
6. To modify access rights for your folder, select the folder. The groups activate.
7. From the Users list, click Everyone, then use the arrows to select Read & Write.
8. Click Options.
9. To share the folder, select Share files and folders using SMB.
10. To share the folder with specific users, next to the user name, select On.
11. Click Done.
12. Close the System Preferences window.

Note
When you open a shared folder, a Shared Folder banner appears in the Finder for the
folder and subfolders.
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Adding an SMB Folder as an Address Book Entry from the Embedded
Web Server
1. At your computer, open a Web browser. In the address field, type the IP address of

the printer, then press Enter or Return.

Note
If you do not know the IP address for your printer, refer to Finding the IP Address of
Your Printer.

2. Click Address Book, then click Add Contact.
3. For Network (SMB), click the Plus icon (+), then enter the following information:

• Nickname: Enter the name that you want to appear in the Address Book.
• Type: Select the network connection type.
• IP Address: Port / Host Name: Port or IPv6 Address/Prefix : Port: The option

selected under Type determines which option displays in this field. Enter the IP
address of your computer, then enter the default port number.

• Share: Enter a name for the directory or folder. For example, to save scanned files
to a shared folder named scans, type scans.

• Document Path: Enter the path of the folder on the SMB server. For example, to
save the scanned files to a folder named colorscans inside the scans folder, type
colorscans.

• Login Name: Enter your computer user name.
• Password: Enter your computer login password.
• Retype Password: Enter your login password again.

4. To save your network information, click OK.
5. To save your contact, click OK.

Adding a Folder as an Address Book Entry Using the Control Panel
1. At the printer control panel, touch the Home button.
2. Touch Address Book.
3. Touch the Plus icon (+), then select Add Contact.
4. Enter the name to appear in the address book.
5. Touch Add (SMB), then navigate to the desired folder.

Note
Login credentials are required for computers on secured networks.

6. To save changes, touch OK.

Scanning to a Shared Folder on a Networked Computer
1. Load the original document on the document glass or into the duplex automatic

document feeder.
2. At the printer control panel, press the Home button.
3. Touch Scan To.
4. Touch Contacts.
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5. From the Contacts list, select the shared folder.
6. To save the scanned document as a specific file name, touch the attachment file

name, enter a new name using the touch screen keypad, then touch Enter.
7. To save the scanned document as a specific file format, touch the attachment file

format, then select the needed format.
8. Adjust scanning options as needed.
9. To begin the scan, press Scan.
10. If you are scanning from the document glass, when prompted, to finish, touchDone,

or to scan another page, touch Add Page.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

11. To return to the Home screen, press the Home button.

Scanning Images into an Application on a Connected Computer

You can import images directly from the scanner into a folder on your computer. With
a Macintosh® computer and some Windows® applications, you can import the images
directly into an application.

Scanning an Image into an Application
Note
SomeWindows applications, includingMicrosoft Office 2007 and newer, do not support
this feature.

1. Load the original document on the document glass or in the duplex automatic
document feeder.

2. At your computer, open the application into which you want to scan the image.
3. In the application, select the menu item to acquire the image.
4. From the Paper Source menu in Windows, or from the Scan From menu on a

Macintosh® computer, select one of the following:

• For the Document Glass, select Flatbed.
• For the Duplex Automatic Document Feeder, select Document Feeder.

5. Specify other scan driver settings as needed.
6. To begin the scan, click Scan.

The printer scans the document and places the image in your application.

Scanning from Windows Control Panel
1. Load the original document on the document glass or in the duplex automatic

document feeder.
2. On your computer, select Start > Devices and Printers.
3. From the Devices and Printers window, right-click the printer icon, then select Start

Scan.
4. From the menu, select the paper source for your original document .
5. Adjust scanning options as needed.
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6. To preview the document or select a portion of the document to scan, select Preview.
The printer scans a preview copy of the image.

7. To select part of the document, use the corner points to resize the frame.
8. Click Scan.
9. To import the scan, in the Import Pictures and Video window, click Import.

The scanned image is stored in the defaultMy Pictures folder.

Fax

Fax Overview
When you send a fax from the printer control panel, the document is scanned
and transmitted to a fax machine, using a dedicated telephone line. You
can use the Fax feature to fax documents to a fax number, or individual
contact, or to a group of contacts.

You can use the Fax feature to do the following tasks:

• Delay the send of your fax job for up to 24 hours.
• Send a fax from your computer.
• Forward fax documents to an email address.
• Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols
(VOIPs) such as FIOS and DSL are not supported. Before you use the fax, configure the
Fax Settings to ensure that the settings are compatible with your local connection and
regulations. The Fax Settings include optional features that you can use to configure
the printer for faxing.

Note
Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

You can adjust various settings for individual Fax jobs and save settings as Presets for
future jobs. The list of features can be customized, and some features could be hidden
from view when the App is installed. To view all available features and to find out more
about customizing the Fax App, refer to Customize and Personalize.

For information about all the App features and available settings, refer to Apps Features.

Sending a Fax

To send a fax:
1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.
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3. Load your original documents.

• Use the document glass for single pages or paper that cannot be fed using the
single-pass duplex automatic document feeder. Lift the document feeder, then
place the original document face down in the upper-left corner of the document
glass.

• For single, multiple, or 2-sided pages, use the single-pass duplex automatic
document feeder. Remove any staples and paper clips from the pages. Insert the
original documents face up in the document feeder, with the top of the page
entering the feeder first. Adjust the paper guides so that they fit against the
documents.

4. Touch Fax.
5. To enter a recipient fax number, use the touch screen keypad, then touch Enter. To

add a number from the fax address book, touch the Address Book icon.

Note
To insert a pause as needed, touch the Special Characters icon, then touch Dial
Pause. To enter longer pauses, touch Dial Pausemultiple times.

6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select
an option.

7. Adjust fax settings as needed.

For details about available features, refer to Apps Features.

8. Touch Send.
9. If you are scanning from the document glass, when prompted, do one of the following:

• To complete the job and return to the Fax app, touch Done.
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• To scan another page, load a new original document on the document glass, then
touch Add Page.

• To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

10. To return to the Home screen, press the Home button.

Fax Workflows
Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the
send of your fax job for up to 24 hours.

Note
Before you use this feature, ensure that the printer is set to the current time. For details,
refer to the System Administrator Guide at www.xerox.com/office/VLC605docs.

To specify the time to send your fax:
1. At the printer control panel, press the Home button.
2. Touch Fax.
3. To add a recipient fax number, use the touch screen keypad, or, to add a contact

from the Address Book, touch the Address Book icon.
4. Load original documents into the printer, then adjust the settings as needed. For

details, refer to Sending a Fax.
5. Touch Delay Send.
6. Touch Specific Time, enter the required time, then touch OK.
7. Touch Send. The fax is scanned and saved, then sent at the time that you specified.
8. If you are scanning from the document glass, when prompted, do one of the following:

• To complete the job and return to the Fax app, touch Done.
• To scan another page, load a new original document on the document glass, then

touch Add Page.
• To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

9. To return to the Home screen, press the Home button.

Sending a Cover Sheet with a Fax

You can send a cover sheet with your fax. The cover sheet lists recipient information
from the fax address book, and sender information from the Company Name Fax Line
setting.
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To send a cover sheet with a fax:
1. At the printer control panel, press the Home button, then touch Fax.
2. Add fax recipient names and adjust fax settings, as needed. For details, refer to

Sending a Fax.
3. Touch Cover Sheet.
4. Touch Add Cover Sheet.
5. To add predefined comments in the From or To fields, touch Blank Comment, then

select from the list of predefined comments.

Note
If no predefined comments have been added, the list is unavailable. To populate the
list with predefined comments, refer to Adding Predefined Comments.

6. Touch OK.

Adding Predefined Comments

To add a predefined comment:
1. At the printer control panel, press the Home button.
2. Touch Device > Apps > Fax.
3. Touch Cover Sheet Comments.
4. Select a Not in Use comment.
5. Enter the required text, then touch OK.
6. To return to the Home screen, press the Home button.

Forwarding a Fax to an Email Address

You can configure the device to forward faxes to an email address. You can specify the
types of faxes to forward, for example, received faxes, sent faxes, or sent and received
faxes.

Note
Before you can forward a fax to an email address, ensure that the Fax Forwarding feature
is enabled and a SMTP server is configured. For details, refer to the SystemAdministrator
Guide at www.xerox.com/office/VLC605docs.

To forward a fax to an email address:
1. At the printer control panel, press the Home button.
2. Touch Device > Apps > Fax.
3. Touch Fax Forwarding > Fax Forwarding.
4. Select Receive Only, Send Only, or Send & Receive.
5. Touch Add Email. To enter an email address, use the touch screen keypad, or select

a contact from the Address Book.
6. To add a subject line, touch Subject, enter your subject line text, then touch OK.
7. To add a filename for attachments, touch Attachment, then enter a filename.
8. To change the file format for attachments, touch the current format extension, then

select a new format.

Note
The default file format is .pdf.
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9. To save the settings, touch OK.
10. For the new settings to take effect, press theHome button, then at the prompt, touch

Restart Now.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are
held in the Jobs list until you enter a passcode. After you enter the passcode, the faxes
are released and printed.

Note
Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is
enabled. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

To print a secure fax:
1. At the printer control panel, press the Home button, then touch Jobs.
2. Touch Personal & Secure Jobs.
3. Touch your assigned private folder.
4. Enter your passcode, then touch OK.
5. Select a job to print, or touch Print All.
6. To return to the Home screen, press the Home button.

Sending a Fax Manually

You can use the Manual Send feature to enable the fax modem speaker temporarily.
This feature is helpful to dial international numbers, or to use phone systems that require
you to wait for a specific audio tone.

To send a fax manually:
1. At the printer control panel, press the Home button, then touch Fax.
2. TouchManual Send.

Note
To display the menu without entering a fax number, at the top of the screen, touch
Fax.

3. Adjust the fax settings as needed.
4. Touch Dial, then enter a fax number using the touch screen keypad.
5. To send the fax, touch Scan.
6. If you are scanning from the document glass, when prompted, do one of the following

steps:

• To complete the job and return to the Fax app, touch Done.
• To scan another page, load a new original document on the document glass, then

touch Add Page.
• To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.
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7. To return to the Home screen, press the Home button.

Polling a Remote Fax Machine

Fax Polling allows the printer to retrieve a fax stored on another fax machine that
supports fax polling.

Note
This feature is hidden from view when the Fax App is installed. For more information,
refer to Customize and Personalize.

To poll a remote fax machine:
1. At the printer control panel, press the Home button, then touch Fax.
2. Touch Polling.

Note
To display the menu without entering a fax number, at the top of the screen, touch
Fax.

3. Enter the fax number of the fax machine that you want to poll.

• To enter a fax number manually, touch Enter Fax Number.
• To add a number from the fax address book, touch the Address Book icon.

4. To initiate the polling process, touch Retrieve.
5. To return to the Home screen, press the Home button.

Sending a Fax From Your Computer

You can send a fax to the printer from an application on your computer.

Sending a Fax From Windows Applications

You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set
options. You can send a confirmation sheet, set the send speed, resolution, send time,
and dialing options.

To send a fax from Windows applications:
1. With the desired document or image open in your application, open the Print dialog

box. For most software applications, click File > Print or press CTRL+P.
2. Select the required printer. To open the print driver dialog box, click Printer Properties.
3. On the Printing Options tab, from the Job Type list, select Fax.
4. In the Fax window, click the Recipients tab.
5. To add recipients manually:

a) Click the Add Recipient icon.
b) Type the recipient name and fax number, then add other information as required.
c) Click OK.
d) To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:
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a) Click the Add From Phonebook icon.
b) Select the required phonebook from the list.
c) Select names from the list, or search for a contact using the search bar.
d) To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e) Click OK.
f) To add more recipients, repeat this procedure.

7. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options
list, select Print a Cover Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.
9. To save your settings and return to the main print dialog page, click OK.
10. Click Print. In the Fax Confirmation window, click OK.

Sending a Fax From Macintosh Applications

You can use the fax driver to send a fax from many Macintosh applications. To install
the fax driver, refer to Installing the Software.

To send a fax from Macintosh applications:
1. With the desired document or image open in your application, open the Print dialog

box. For most software applications, click File > Print or press CMD+P.
2. Select the required printer.
3. To access the fax driver settings, click Preview, select Xerox Features, then from Job

Type list, select Fax.
4. To add a recipient, in the Fax window, click the Recipients tab, then click the Add

Recipient icon.
5. Type the recipient name and fax number, add other information as needed, then

click OK.
6. To add more recipients, repeat this procedure.
7. To include a cover sheet, click the Cover Sheet tab.
8. From theCover Sheet list, select Print a Cover Sheet, then enter the details as needed.
9. On the Options tab, select the required options. To save your settings and return to

the main print dialog window, click OK.
10. To send the fax, click Print.

Printing a Fax Activity Report
1. At the printer control panel, press the Home button.
2. Touch Device > Apps > Fax.
3. Touch Activity Report.
4. To return to the Home screen, press the Home button.
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USB

USB Overview
Use the USB feature to save jobs to a USB Flash drive, or to print jobs already
stored on a USB Flash drive. Jobs in a print-ready format, for example PDF,
TIFF or JPEG can be printed.

To create a print-ready file, select the Print to File option when you print your documents
from programs such as Microsoft® Word. Many advanced publishing programs can
provide additional methods to create print-ready files.

Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to
USB function produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

Note

• If the device is in Power Saver mode, before proceeding with the USB scan, to wake
the device, press the Power/Wake button.

• Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:
1. Load the original document on the document glass or in the duplex automatic

document feeder.
2. At the printer control panel, press the Home button.
3. Insert your USB Flash drive into the USB memory port on the front of the printer.
4. At the USB Drive has been detected screen, touch Scan to USB.

Note
If this feature does not appear, enable the feature or contact the system
administrator.

5. To save the scanned file to a specific folder on the USB Flash drive, navigate to the
directory where you want to save your file, then touch OK.

6. To save the scanned document as a specific file name, touch the attachment file
name, then enter a new name using the touch screen keypad. Touch Enter.

7. To save the scanned document as a specific file format, touch the attachment file
format, then select the required format.

8. Adjust scanning features as needed.
9. To begin the scan, press Scan.

The printer scans your images to the folder that you specified.

10. If you are scanning from the document glass, when prompted, to finish, touchDone,
or to scan another page, touch Add Page.
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Note
If you are scanning a document from the automatic document feeder, a prompt
does not appear.

Caution
Do not remove the USB Flash drive while the device is scanning and processing the
job. If you remove the Flash drive before the transfer is complete, the file can become
unusable and other files on the drive can be damaged.

11. To return to the Home screen, press the Home button.

Printing from a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the
printer.

Note

• If the device is in Power Saver mode, before proceeding with the Print job, to wake
the device, press the Power Saver button.

• Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive
1. Insert the USB Flash drive into the USB memory port on the printer.
2. At the USB Drive has been detected screen, touch Print from USB.

Note
If this feature does not appear, enable the feature or contact the system
administrator. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

3. Add files to the Document Source Table.

• To print a group of print-ready files, for the USB drive or folder, touch the Select
All icon. Verify that your files are selected.

• To print a specific file, browse to that file, then touch the file name or icon.

4. Touch OK.
5. Confirm that the required files are listed.

• To select more files, touch Add Document, then touch OK.
• To remove a file name from the list, touch the file name, then touch Remove.

6. Select the paper supply, quantity, output color, and 2-sided printing options.
7. Touch Print.
8. When you are finished, remove the USB Flash drive.

To print from a USB Flash drive that is already inserted in the printer
1. If the USB Flash drive is already in the USB memory port, press the Home button.
2. Touch USB.
3. Touch Print from USB.
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Note
If this feature does not appear, enable the feature or contact the system
administrator. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

4. Add files to the Document Source Table.

• To print a group of print-ready files, for the USB drive or folder, touch the Select
All icon. Verify that your files are selected.

• To print a specific file, browse to that file, then touch the file name or icon.

5. Touch OK.
6. Confirm that the required files are listed.

• To select more files, touch Add Document, then touch OK.
• To remove a file name from the list, touch the file name, then touch Remove.

7. Select the paper supply, quantity, output color, and 2-sided printing options.
8. Touch Print.
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5
Printing

Printing Overview
Before printing, your computer and the printer must be plugged in, powered on, and
connected. Ensure that you have the correct print driver software installed on your
computer. For more information, refer to Installing the Software.
1. Select the appropriate paper.
2. Load paper in the appropriate tray. On the printer control panel, specify the size,

color, and type.
3. Access the print settings in your software application. Formost software applications,

press CTRL+P for Windows, or CMD+P for Macintosh.
4. Select your printer.
5. To access the print driver settings:

• For Windows, select Properties or Preferences.
• For Macintosh, select Xerox ® Features.

The title of the button can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.

Selecting Printing Options
Printing options, also called print driver software options, are specified as Printing
preferences in Windows and Xerox® Features in Macintosh. Printing options include
settings for 2-sided printing, page layout, and print quality. Printing options that are set
from Printing preferences within the Devices and Printers window become the default
setting. Printing options that are set fromwithin the software application are temporary.
The application and the computer do not save the settings after the application is closed.
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Print Driver Help

Xerox ® print driver software Help information is available from the Printing Preferences
window. Click the Help button (?) in the bottom, left corner of the Printing Preferences
window to see the Help.

Information about Printing Preferences appears in the Help window. From there, you
can select by topic or use the search field to enter the topic or function for which you
need information.

Windows Printing Options
Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing
Preferences before sending the job to the printer.
1. With the document open in your software application, access the print settings. For

most software applications, click File > Print or press CTRL+P.
2. Select your printer and click the Properties or Preferences button to open the Printing

Preferences window. The title of the button can vary depending on your application.
3. Click a tab in the Printing Preferences window, then make selections.
4. To save and close the Printing Preferences window, click OK.
5. To send the job to the printer, click Print.

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings
specified in the Printing Preferences window. You can specify yourmost common printing
options and save them so that you do not have to change the settings every time you
print.

For example, if youwant to print on both sides of the paper formost jobs, specify 2-sided
printing in Printing Preferences.
1. Navigate to the list of printers on your computer:

• For Windows Server 2008 and later, click Start > Settings > Printers.
• For Windows 7, click Start > Devices and Printers.
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• For Windows 8.1 and Windows 10, right-click the Start icon > Control Panel >
Devices and Printers.

Note
If you are using a custom Start menu application, it can change the navigation path
to your list of printers.

2. In the list of printers, right-click the icon for your printer, then click Printing
preferences.

3. In the Printing Preferences window, click a tab, then select the options. To save the
settings, click OK.

Note
For more information about Windows print driver options, click the Help button (?) in
the Printing Preferences window.

Selecting Printing Defaults in Windows for a Shared Network Printer
1. Navigate to the list of printers on your computer:

• For Windows Server 2008 and later, click Start > Settings > Printers.
• For Windows 7, click Start > Devices and Printers.
• For Windows 8.1 and Windows 10, right-click the Start icon > Control Panel >

Devices and Printers.

Note
If you are using a custom Start menu application, it can change the navigation path
to your list of printers.

2. In the list of printers, right-click the icon for your printer, then select Printer properties.
3. In the printer Properties dialog box, click the Advanced tab.
4. On the Advanced tab, click Printing Defaults.
5. Make your selections on the print driver tabs as needed, then click Apply.
6. To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print
jobs. In Xerox® App Gallery, you can save an app as default, so you can have app by app
default settings for printing.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. To open the Printing Preferences window, select your printer, then click Properties

or Preferences.
3. In the print Properties window, click the tabs, then select the required settings.
4. In the print Properties window, click Saved Settings, then click Save As.
5. To save the set of options in the Saved Settings list, type a name for the set of printing

options, then click OK.
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Macintosh Printing Options
Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.
2. Select your printer.
3. In the Print Options menu, select Xerox Features.

Note
To see all printing options, click Show Details.

4. Select any other required printing options from the lists.
5. To send the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print
jobs.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select your printer from the Printers list.
3. Select the required printing options from the lists in the Print dialog box.

Note
To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list,

click OK.
6. To print using these options, select the name from the Presets list.

UNIX and Linux Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in
UNIX and Linux environments.

The Xerox® print drivers provide a GUI-based driver dialog for printer feature selections.
You can select print drivers based on your operating system.

Xerox® Printer Manager

Xerox® PrinterManager is an application that allows you tomanage and print tomultiple
printers in UNIX and Linux environments.

Xerox® Printer Manager allows you to:

• Configure and check the status of network connected printers.
• Set up a printer on your network and monitor the operation of the printer once

installed.
• Perform maintenance checks and view supplies status at any time.
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• Provide a common look and feel across the many different suppliers of UNIX and
Linux operating systems.

Installing Xerox® Printer Manager

Before you begin:

Ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install Xerox® Printer Manager:
1. Download the appropriate package for your operating system. To locate print drivers

for your printer, go to www.xerox.com/office/VLC605drivers.
2. On the print driver website, navigate to your printer model.
3. For your printer model, click Drivers & Downloads.
4. From the Operating System menu, select your operating system.
5. To identify the print driver for your printer model, review the list of available print

drivers.

Note
For additional information on each driver, click Description.

6. To select the print driver for your printer model and operating system, click the print
driver name.

7. To begin the download, read the End User License Agreement, then click accept.
The file automatically downloads to the default location for your computer file
downloads.

8. To install the Xerox® Print Driver package:
a) Open the package with your OS package manager.
b) To install using a command-line utility, change to the directory where you

downloaded the file. To run the installer, type the appropriate command-line
utility for your operating system. For example:

• Red Hat: rpm -U <filename>.rpm
• Debian-based Linux: dpkg -i <filename>.deb
• AIX: rpm -U <filename>.rpm
• HPUX: <filename>.depot.gz
• Solaris: pkgadd -d <filename>.pkg

Note
Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional
information about utilities included in the OS package manager, refer to the
manual included with the package. For example,man xeroxprtmgr.

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager, do one of the following tasks.

• For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter
or Return.
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• For Linux, type sudo xeroxprtmgr, then press Enter or Return.

Printing with xeroxprint

Xerox has its own print command. You can use the following command:

xeroxprint -d<Some_Queue > -o[Options] <Somefile

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS
(Common UNIX Printing System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured customprint drivers for Linux.
To locate drivers for your printer, go to www.xerox.com/office/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The
instructions for installing and building CUPS are contained in the CUPS Software
AdministratorsManual, written and copyrighted by Easy Software Products. For complete
information on CUPS printing capabilities, refer to the CUPS Software Users Manual
available from www.cups.org/documentation.php.

Installing the PPD File on the Workstation
1. If available, download the Xerox® PPD for CUPS (Common UNIX Printing System)

from the Drivers and Downloads page on the Xerox Support website.
2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are

unsure of the location of the folder, use the Find command to locate the PPD files.
3. Follow the instructions that are included with the PPD file.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.
2. Open aWebbrowser and type http://localhost:631/admin, then click Enter orReturn.
3. For User ID, type root. For password, type the root password.
4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS

printer list.

Printing with CUPS (Common UNIX Printing System)

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type lp -dprinter filename, then click Enter.
2. To print to a specific printer in Berkeley, type lpr -Pprinter filename, then click Enter.

Mobile Printing Options

This printer can print from iOS and Android mobile devices. For more information, refer
to Configuring Google Cloud Print.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer,
or smartphone, using Wi-Fi Direct.
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For more information, refer to Connecting to Wi-Fi Direct.

For more information on using Wi-Fi Direct, refer to the documentation provided with
your mobile device.

Note
Depending on which mobile device you are using, the printing procedure varies.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To
enable AirPrint® for your printer, refer to Configuring AirPrint. To use AirPrint®, ensure
that your mobile device is connected to the same wireless network as the printer.

To print with AirPrint®:
1. Open the email, photograph, website page, or document that you want to print.
2. Tap the Action icon.
3. Tap Print.
4. Select your printer, then set the printer options.
5. Tap Print.

Printing from a Mopria-Enabled Mobile Device

MOPRIA™ is a software feature that enables users to print from mobile devices without
requiring a print driver. You can use MOPRIA™ to print from your mobile device to
MOPRIA™-enabled printers.

Note

• MOPRIA™ and all of its required protocols are enabled by default.
• Ensure that you have the latest version of theMOPRIA™ Print Service installed on your

mobile device. You can obtain a free download from the Google Play Store.
• Wireless devices must join the same wireless network as the printer.
• The name and location of your printer appears in a list of MOPRIA™-enabled printers

on connected devices.

To print using MOPRIA™, follow the directions provided with your mobile device.

Printing from a USB Flash Drive
You can print a file stored on a USB Flash drive. The USB port is on the front of the
printer.

Note

• If the device is in Power Saver mode, before proceeding with the Print job, to wake
the device, press the Power Saver button.

• Only USB Flash drives formatted to the typical FAT32 file system are supported.

1. Insert the USB Flash drive into the USB memory port on the printer.
2. At the USB Drive has been detected screen, touch Print from USB.
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Note
If this feature does not appear, enable the feature or contact the system
administrator. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

3. Add files using the Browse USB screen.

• To print a group of print-ready files, for the USB drive or folder, touch the Select
All icon. Verify that your files are selected.

• To print a specific file, browse to that file, then touch the file name or icon.

4. Touch OK.
5. Confirm that the required files are listed.

• To select more files, touch Add Documents, then touch OK.
• To remove a file name from the list, touch the file name, then touch Remove.

6. Select the paper supply, quantity, output color, and 2-sided printing options.
7. Touch Print.
8. When you are finished, remove the USB Flash drive.

Printing from a USB Flash Drive Already Inserted in the Printer
1. If the USB Flash drive is already in the USB memory port, press the Home button.
2. Touch Print from USB.

Note
If this feature does not appear, enable the feature or contact the system
administrator. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

3. Add files using the Browse USB screen.

• To print a group of print-ready files, for the USB drive or folder, touch the Select
All icon. Verify that your files are selected.

• To print a specific file, browse to that file, then touch the file name or icon.

4. Touch OK.
5. Confirm that the desired documents appear. If the documents do not appear, touch

Add Documents, select additional documents, then touch OK.
6. Select the paper supply, quantity, output color, and 2-sided printing options.
7. Touch Print.

Printing Features

Managing Jobs

From the Jobs window in the Embedded Web Server, you can view a list of active and
completed print jobs.
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From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or
completed jobs. You can pause, delete, print, or view job progress or job details for a
selected job. When you send a secure print job, the job is held until you release it by
typing a passcode at the control panel. For details, refer to Printing Special Job Types.

Pausing the Print Job with the Option to Delete It
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the print job.
3. Do one of the following:

• To pause the print job, touch Pause. To resume the print job, touch Resume.
• To delete the print job, touch Delete. At the prompt, touch Delete.

Note
If you do not make a selection within 60 seconds, the job automatically resumes.

4. To return to the Home screen, press the Home button.

Viewing, Printing, or Deleting Jobs
1. At the printer control panel, press the Home button.
2. To view a list of active and completed jobs, touch Jobs.
3. To view a list of specific job types, touch an option.

• To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the
quantity, then touch OK. To delete the job, touch the Trash icon, then touch
Delete.

• To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the
folder, then touch Print All, or Delete All.

• For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the
passcode number, then touch OK. To print a Secure Job, touch the job. To print
or delete all the jobs in the folder, touch Print All, or Delete All.

4. To view details about a job, touch the job.
5. To return to the Home screen, press the Home button.

Note

• The system administrator can restrict users from deleting jobs. If a system
administrator has restricted job deletion, you can view the jobs, but not delete them.

• Only the user that sent the job or the system administrator can delete a Secure Print
job.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from
the printer control panel. Select special job types in the print driver, Printing Options tab,
under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for
future use. Any user can print or delete a Saved Job.
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To Print a Saved Job
1. In your software application, access the print settings. Formost software applications,

press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

• For Windows, click Printer Properties. Depending on your application, the title of
the button can vary.

• For Macintosh, in the Print window, click Print Optionsmenu, then select Xerox
Features.

3. For Job Type, select Saved Job.
4. Type a job name or select a name from the list, then click OK.
5. Select any other required printing options.

• For Windows, click OK, then click Print.
• For Macintosh, click Print.

To Release a Saved Job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Saved Jobs, touch Saved Jobs.
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK.
5. To delete the document after printing, for that job, touch the Trash icon, then at the

prompt, touch Delete.
6. To return to the Home screen, press the Home button.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it
is held at the printer until you enter your passcode at the printer control panel.

To print using Secure Print
1. In your software application, access the print settings. Formost software applications,

press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

• For Windows, click Printer Properties. Depending on your application, the title of
the button varies.

• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.

• For Windows, click OK, then click Print.
• For Macintosh, click Print.
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To release a Secure Print jo
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Secure Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. Enter the passcode number, then touch OK.
6. Select an option:

• To print a Secure Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete a Secure Print job, touch the Trash icon, then at the prompt, touch

Delete.
• To delete all the jobs in the folder, touch Delete All.

Note
After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.

Personal Print

Personal Print allows you to store a document in the printer, then print it from the control
panel.

Note
This feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

• A Personal Print job appears in a folder named after the user ID associated with the
print job.

• A Personal Print job does not use a passcode.
• Any user can print or delete a Personal Print job.
• You can print all jobs in the list at once, delete an individual job, or delete all jobs in

the list.
• After a Personal Print job is printed, it is deleted automatically.

To Print using Personal Print
1. In your software application, access the print settings. Formost software applications,

click File or for Windows, press CTRL+P.
2. Select your printer, then click Printer Properties. Depending on your application, the

title of the button varies.
3. For Job Type, select Personal Print.
4. Select any other required printing options, then click OK.
5. To send the job to the printer, click Print.

To Release a Personal Print Job
1. At the printer control panel, press the Home button.
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2. Touch Jobs.
3. To view Personal Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. If prompted for a passcode, touch Skip.

Note
When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

6. Select an option.

• To print a Personal Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the
remaining copies. After reviewing the sample set, you can either print the remaining
copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

• A Sample Set job appears in a folder named after the user ID associated with the
print job.

• A Sample Set job does not use a passcode.
• Any user can print or delete a Sample Set job.
• A Sample Set prints one copy of a job to allow you to proofread the job before printing

any remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To Print using Sample Set
1. In your software application, access the print settings. Formost software applications,

press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

• For Windows, click Printer Properties. Depending on your application, the title of
the button varies.

• For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.
4. Select any other required printing options.

• For Windows, click OK, then click Print.
• For Macintosh, click Print.

To Release a Sample Set
1. At the printer control panel, press the Home button.

Xerox® VersaLink® C605 Multifunction Printer5-12
User Guide

Printing



2. To view available jobs, touch Jobs.
3. Touch the Sample Set job.

Note
The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.

• To print the remaining copies of the job, touch Release.
• To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select
which paper to use based on the document size, paper type, and paper color you specify.
You can also select a specific tray loaded with the desired paper.

• For Windows, paper options are in the Paper field on the Printing Options tab.
• For Macintosh, in the Print window, in Xerox Features, paper options are in the Paper

field for Paper/Output.

Scaling

Scaling reduces or enlarges the original document to match the selected output paper
size.

• For Windows, the scale options are on the Printing Options tab, in the Paper field.
• For Macintosh, the scale options are in the Print window for Preview. To view more

printing options, click Show Details.

The following scaling options are available:

• Automatically Scale scales the document to fit the selected Output Paper Size. The
scaling amount appears in the percentage box below the sample image.

• No Scaling does not change the size of the page image printed on the output paper,
and 100%appears in the percentage box. If the original size is larger than the output
size, the page image is cropped. If the original size is smaller than the output size,
extra space appears around the page image.

• Manually Scale scales the document by the amount entered in the percentage box
below the preview image.

Printing on Both Sides of the Paper
Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print
driver. The print driver uses the settings for portrait or landscape orientation from the
application for printing the document.
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Note
Ensure that the paper size and weight are supported. For details, refer to Supported
Paper Types and Weights for Automatic 2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed
pages turn. These settings override the application page orientation settings.

• 1-Sided Print: This option prints on one side of the media. Use this option when
printing on envelopes, labels, or other media that cannot be printed on both sides.

• 2-Sided Print: This option prints the job on both sides of the paper to allow binding
on the long edge of the paper. The following illustrations show the result for
documents with portrait and landscape orientations, respectively:

• 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The
images print to allowbinding on the short edge of the paper. The following illustrations
show the result for documents with portrait and landscape orientations, respectively:

Note
2–Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options
for Windows.

Print Quality

Print-quality modes:

• Standard print-quality mode: 600 x 600 dpi
• Enhanced print-quality mode: 600 x 600 dpi, 8-bit depth

Image Options

Image options controls how the printer uses color to produce your document. The
Windows PostScript print driver and theMacintosh print drivers provide thewidest range
of color controls and corrections on the Image Options tab.

• ForWindows, Color Corrections, and Color Adjustment are on the Image Options tab.
• For Macintosh, in the Print window, in Xerox Features, Color Options is on the

Paper/Output list.
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Note
Add files using the Browse USB screen.

The following options are available:

• Xerox Black andWhite: This feature converts all color in the document to black and
white or shades of gray.

• Xerox Automatic Color: This option applies the best color correction to text, graphics,
and images. Xerox recommends this setting.

• Vivid RGB: This setting produces brighter andmore saturated colors using red, green,
and blue color.

• Commercial: This option applies color for printing on a commercial printing press.
• LCD: This option approximately matches the colors in the print job to the colors used

by your computer monitor display screen.
• Euroscale Press: This optionmatches the European FOGRAglossy paper specification.
• None: This option provides no color correction.
• sRGB: This option approximates the colors in the print job to the red, green, and blue

(RGB) configuration of your computer monitor display screen.

Image Shift

Image Shift allows you to modify the location of the image on the page. You can shift
the printed image along the X and Y axes of each sheet of paper.

Color Adjustments

Use Color Adjustments to adjust particular characteristics of the printed color.
Characteristics include lightness, contrast, saturation, and color cast.

Note
Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text
and images in your printed job.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas
of the print job.

Saturation

Saturation allows you to adjust the color strength and the amount of gray in the color.

Color Cast

Use Color Cast settings to adjust the amount of a selected color in the print job while
preserving lightness.
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The following options are available:

• The Cyan to Red option allows you to adjust the color balance between cyan and
red. For example, when you increase the cyan levels, the red levels decrease.

• TheMagenta toGreenoption allows you to adjust the color balance betweenmagenta
and green. For example, when you increase the magenta levels, the green levels
decrease.

• The Yellow to Blue option allows you to adjust the color balance between yellow and
blue. For example, when you increase the yellow levels, the blue levels decrease.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror
left to right when printed.

Printing Multiple Pages to a Single Sheet

When printing amultiple-page document, you can printmore than one page on a single
sheet of paper.

To print 1, 2, 4, 6, 9, or 16 pages per side, select Pages Per Sheet on the Page Layout
tab.

• For Windows, Page Layout is on the Document Options tab.
• For Macintosh, in the Print window, Layout is on the Preview list.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. You can
create booklets from any paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images
per sheet of paper, two page images on each side. The pages are printed in the correct
order so that you can fold and staple the pages to create the booklet.

• For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the
Document Options tab.

• For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the
Paper/Output list.

When you print booklets using the Windows PostScript or Macintosh driver, you can
specify the gutter and creep.

• Gutter: Specifies the horizontal distance in points between the page images. A point
is 0.35 mm (1/72 in.).
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• Creep: Specifies howmuch the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images
to shift outward slightly when folded. You can select a value from zero to 1 point.

CreepGutter

Selecting Finisher Options

With the optional finisher option installed on the printer, you can request stapled
documents right from your desktop computer. The stapler can staple up to 30 sheets of
105 g/m2.
1. From the Printing Options tab, locate the Finishing option, then select 1 Staple.
2. Click OK.

The stapled prints are delivered to the finisher unit.

Selecting Mailbox Options

With the optionalmailbox option installed on the printer, you can send prints to a specific
mailbox bin right from your desktop computer.
1. From the Printing Options tab, locate the Output Destination option, then select

one of the mailbox bins.
2. Click OK.

The prints are delivered to the selected mailbox bin.

Using Special Pages

The Special Pages options control how covers, inserts, and exception pages are added
to your printed document.

• For Windows, the Special Pages tab is on the Document Options tab.
• For Macintosh, in the Print window, in Xerox Features, Special Pages is on the

Paper/Output list.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for
the cover pages that are different from the source used for the body of a document. For
example, you can use your company letterhead for the first page of a document. You
can also use heavyweight paper for the first and last pages of a report. You can use any
applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

• No Covers does not print cover pages. No cover pages are added to the document.
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• Front Only prints the first page on paper from the specified tray.
• Back Only prints the back page on paper from the specified tray.
• Front and Back: Same prints the front and back cover pages from the same tray.
• Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the
front and back covers by size, color, or type. You can also use blank or pre-printed paper,
and you can print side one, side two, or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or
after designated pages within a document. Adding an insert after designated pages
within a document separates sections, or acts as a marker or placeholder. Ensure that
you specify the paper to use for the insert pages.

• Insert Options provides the options to place an insert After Page X, where X is the
specified page, or Before Page 1.

• Insert Quantity specifies the number of pages to insert at each location.
• Pages: Specifies the page or range of pages that use the exception page

characteristics. Separate individual pages or page rangeswith commas. Specify pages
within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type
1,6,9-11.

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
• Job Setting: Displays the attributes of the paper for the remainder of the job.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can
specify differences such as page size, page type, and page color. You can also change
the side of the paper on which to print as your job requires. A print job can contain
multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one
side of a special paper, and the remainder of the pages printed 2-sided on regular paper.
You can use exception pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages
and select the alternate paper source:

• Pages: Specifies the page or range of pages that use the exception page
characteristics. Separate individual pages or page rangeswith commas. Specify pages
within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type
1,6,9-11.

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow

to select an option:

- 1-Sided Print prints the exception pages on one side only.
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- 2-Sided Print prints the exception pages on both sides of the paper and flips the
pages on the long edge. The job then can be bound on the long edge of the
pages.

- 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of
the paper and flips the pages on the short edge. The job then can be bound on
the short edge of the pages.

- Use Job Setting prints the job using the attributes shown in the Job Settings
box.

• Job Setting: Displays the attributes of the paper for the remainder of the job.

Note
Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

Printing Watermarks for Windows

A watermark is special-purpose text that can be printed across one or more pages. For
example, you can add a word like Copy, Draft, or Confidential as a watermark instead
of stamping it on a document before distribution.

Note
The Watermark feature is only available on a Windows computer printing to a network
printer.

To print a watermark:
1. In the print driver, click the Document Options tab.
2. Click theWatermark tab.
3. From the Watermark menu, select the watermark. You can choose from preset

watermarks, or create a customized watermark. You can also manage watermarks
from this menu.

4. Under Text, select an option:

• Text: Enter the text in the field, then specify the font.
• Time Stamp: Specify the date and time options, then specify the font.
• Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.

• Select the scaling option that specifies the size of the picture in relation to the
original image. Use the arrows to scale the image in increments of 1%.

• To define the angle of the image on the page, specify the position option or to
rotate the image left or right by increments of 1, use the arrows.

• To define the location of the image on the page, specify the position option, or
to move the image in each direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark.

• Print in Background: This option prints thewatermark behind the text and graphics
in the document.
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• Blend: This option combines the watermark with the text and graphics in the
document. A blendedwatermark is translucent, so you can see both thewatermark
and the document content.

• Print in Foreground: This option prints the watermark over the text and graphics
in the document.

7. Click Pages, then select the pages to print the watermark:

• Print on All Pages prints the watermark on all pages of your document.
• Print on Page 1Only prints thewatermark only on the first page of the document.

8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click OK.

Orientation

Orientation allows you to select the direction that the page prints.

• For Windows, the Orientation tab is on the Document Options tab.

Note
The orientation setting in your application print dialog box may override the
orientation options in the print driver.

• For Macintosh, Orientation options are in the Print window.

The following options are available:

• Portrait: Orients the paper so that the text and images print across the short
dimension of the paper.

• Landscape: Orients the paper so that the text and images print across the long
dimension of the paper.

• Rotated Landscape: Orients the paper so that the content is rotated 180 degrees
and with the long bottom side up.

Note
For Macintosh, to print portrait text and images in landscape orientation, clear the
Auto Rotate check box.
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Printing Banner Pages

To enable or disable Banner Pages, contact your system administrator, or refer to the
System Administrator Guide at www.xerox.com/office/VLC605docs.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on
your computer screen with the name of the job and the name of the printer where it
was printed.

Note
This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.

• Enabled: This option turns on notifications.
• Disabled: This option turns off the Notification feature.

3. Click OK.

Using Custom Paper Sizes
You can print on custom paper sizes that are within the minimum and maximum size
range supported by the printer. For details, refer to Supported Custom Paper Sizes.

Printing on Custom Paper Sizes
Note
Before printing on a custom paper size, use the Custom Paper Sizes feature in printer
Properties to define the custom size. For more information, refer to Defining Custom
Paper Sizes.

Printing on Custom Paper Size from Windows
Note
Before printing on custom-size paper, define the custom size in the printer Properties.

1. Load the custom-size paper in the tray.
2. In the application, click File > Print, then select your printer.
3. In the Print dialog box, click Printer Properties.
4. On the Printing Options tab, from the Paper list, select the required custom paper

size and type.
5. Select any other required options, then click OK.
6. In the Print dialog box, click Print.

Printing on Custom Paper Size from Macintosh
1. Load the custom-size paper.
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2. In the application, click File > Print.
3. From the Paper Size list, select the custom paper size.
4. Click Print.

Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the
print driver software and on the printer control panel.When setting the paper size, ensure
that you specify the same size as the paper in the tray. Setting the wrong size paper can
cause a printer error. Print driver settings override control panel settings when you print
using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver

You can print custom-size paper from any paper tray. Custom-size paper settings are
saved in the print driver and are available for you to select in all your applications.

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.

To Create and Save Custom Sizes for Windows
1. In the print driver, click the Printing Options tab.
2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output

Paper Size > New.
3. In the New Custom Paper Size window, enter the height and width of the new paper

size.
4. To specify the units of measurement, at the bottom of the window, click the

Measurements button, then select Inches orMillimeters.
5. To save, in the Name field, type a title for the new size, then click OK.

To Create and Save Custom Sizes for Macintosh
1. In the application, click File > Print.
2. Click Paper Size, then selectManage Custom Sizes.
3. To add a new size, in the Manage Paper Sizes window, click the Plus icon (+).
4. Double-click Untitled, then type a name for the new custom paper size.
5. Enter the height and width of the new custom paper size.
6. Click the arrow for the Non-Printable Area field, then select the printer from the list.

Or, for User Defined margins, set the top, bottom, right, and left margins.
7. To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from any paper tray. Custom-size paper settings are
saved in the print driver and are available for you to select in all your applications.
1. At the printer control panel, press the Home button.
2. Touch Device > Paper Trays.
3. Touch the desired tray for your custom-size paper.
4. Touch the current paper size setting, then from the list, touch Custom.
5. In the Custom Paper Size screen, enter the height and width of the new paper size.
6. To save the setting, touch OK.
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7. To return to the Home screen, press the Home button.
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6
Paper and Media

Paper and Media Overview
Your printer is designed to use various paper and othermedia types. Follow the guidelines
in this section for the best print quality and to avoid jams:

• Use only Xerox approved paper. For details, refer to Supported Paper.
• Use only dry, undamaged paper.
• Some paper and other media types can cause poor output quality, increased paper

jams, or damage your printer. Refer to Paper That Can Damage Your Printer.

• Ensure that the paper type selected in your print driver matches the paper type on
which you are printing.

• If you have the same size paper loaded inmore than one tray, ensure that the proper
tray is selected in the print driver.

• Store your paper and other media properly for optimum print quality. For details,
refer to Paper Storage Guidelines.

Supported Paper
Your printer is designed to use various paper and other media types. To ensure the best
print quality and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:

• www.xerox.com/rmlna Recommended Media List (United States)
• www.xerox.com/rmleu Recommended Media List (Europe)
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Ordering Paper

To order paper or other media, contact your local reseller or visit
www.xerox.com/office/VLC605supplies.

General Paper Loading Guidelines
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the

tray.
• Adjust the paper guides to fit the paper size.
• Fan paper before loading it in the paper tray.
• If excessive jams occur, use paper or other approved media from a new package.
• Do not print on label media once a label has been removed from a sheet.
• Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Caution
Some paper and othermedia types can cause poor output quality, increased paper jams,
or damage your printer. Do not use the following media:

• Rough or porous paper
• Inkjet paper
• Non-laser glossy or coated paper
• Paper that has been photocopied
• Paper that has been folded or wrinkled
• Paper with cutouts or perforations
• Stapled paper
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips
• Padded envelopes
• Plastic media
• Transparencies

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage
from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs,
is particularly damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.
• Maintain constant temperatures and relative humidity.
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces aremore

likely to collect moisture.
• Store paper flat, either on pallets, cartons, shelves, or in cabinets.
• Avoid food or drinks in the area where paper is stored or handled.
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• Do not open sealed packages of paper until you are ready to load the paper into the
printer. Leave stored paper in the original packaging. The paper wrapper protects the
paper from moisture loss or gain.

• Some specialmedia is packaged inside resealable plastic bags. Store themedia inside
the bag until you are ready to use it. Keep unused media in the bag and reseal it for
protection.

Supported Paper Types and Weights

WeightsPaper TypesTrays

60–80 g/m²RecycledTray 1 and Trays 2–5
Bypass Tray

60–90 g/m²Custom

75–105 g/m²Bond
Hole-Punched
Letterhead
Plain
Pre-Printed

106–176 g/m²Lightweight Cardstock
Lightweight Glossy Cardstock

177–220 g/m²Cardstock
Glossy Cardstock

Labels

60–80 g/m²RecycledHigh Capacity Feeder (HCF)

60–90 g/m²Custom

75–105 g/m²Bond
Hole-Punched
Letterhead
Plain
Pre-Printed

106–176 g/m²Lightweight Cardstock
Lightweight Glossy Cardstock

EnvelopesTray 1 and Bypass Tray

Supported Paper Types andWeights for Automatic 2-Sided Printing

WeightPaper Type

60–80 g/m²Recycled

60–90 g/m²Custom
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WeightPaper Type

75–105 g/m²Bond
Hole-Punched
Letterhead
Plain
Pre-Printed

106–176 g/m²Lightweight Cardstock
Lightweight Glossy Cardstock

Supported Standard Paper Sizes

The paper sizes below are automatically detected in the paper trays and are available
as a size selection.

North American Standard SizesEuropean Standard SizesTray

Postcard (102 x 152 mm, 4 x 6 in.)
127 x 178 mm, 5 x 7 in.
Statement (140 x 216 mm, 5.5 x 8.5
in.)
Executive (184 x 267mm, 7.25 x 10.5
in.)
203 x 254 mm, 8 x 10 in.
Letter (216 x 279 mm, 8.5 x 11 in.)
Folio (216 x 330 mm, 8.5 x 13 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Monarch Envelope (98 x 190mm, 3.9
x 7.5 in.)
No. 10 Envelope (241 x 105 mm, 4.1
x 9.5 in.)

A6 (105 x 148 mm, 4.1 x 5.8 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.)
A4 (210 x 297 mm, 8.3 x 11.7 in.)
215 x 315 mm
DL Envelope (110 x 220mm, 4.33 x 8.66
in.)
C5 Envelope (162 x 229 mm, 6.4 x 9 in.)
B5 ISO (176 x 250 mm, 6.9 x 9.8 in.)

Bypass Tray

Executive (184 x 267mm, 7.25 x 10.5
in.)
Letter (216 x 279 mm, 8.5 x 11 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Folio (216 x 330 mm, 8.5 x 13 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)
A4 (210 x 297 mm, 8.3 x 11.7 in.)
B5 ISO (176 x 250 mm, 6.9 x 9.8 in.)

Tray 1 and
Trays 2–5

Letter (216 x 279 mm, 8.5 x 11 in.)A4 (210 x 297 mm, 8.3 x 11.7 in.)High Capacity
Feeder (HCF)

Supported Standard Paper Sizes for Automatic 2-Sided Printing

North American Standard SizesEuropean Standard Sizes

Legal (216 x 356 mm, 8.5 x 14 in.)
Letter (216 x 279 mm, 8.5 x 11 in.)
Folio (216 x 330 mm, 8.5 x 13 in.)
Executive (184 x 267 mm, 7.25 x 10.5 in.)
203 x 254 mm, 8 x 10 in.

A4 (210 x 297 mm, 8.3 x 11.7 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.)
215 x 315 mm, 8.5 x 12.4 in.
B5 ISO (176 x 250 mm, 6.9 x 9.8 in.)

Xerox® VersaLink® C605 Multifunction Printer6-4
User Guide

Paper and Media



Note
For the Duplex Automatic Document Feeder, refer to Document Feeder Guidelines.

Supported Custom Paper Sizes

Paper SizesTray Number

Minimum: 76 x 190 mm (3 x 7.5 in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

Tray 1

Minimum: 76 x 190 mm (3 x 7.5 in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

Trays 2–5

Minimum: 76 x 127 mm (3 x 5 in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

Bypass Tray

A4 or Letter onlyHigh Capacity Feeder (HCF)

Minimum: 140 x 203 mm (5.5 x 8.0 in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

2-Sided Printing, not available on the N
model

Changing Paper Settings

When you load paper into a tray, you can change the tray settings. The following options
are available:

• Fully Adjustable: If you select this paper setting, you can change the paper size,
type, and color when you load paper into the tray.

• Dedicated: If you select this paper setting, you cannot change the paper size, type,
and color when you load paper into the tray.

• Bypass: When paper is present in this tray, it is used for print jobs where you did not
specify a particular tray.

For details on how to change the paper setting when loading paper in trays 1-5, refer
to Loading Paper in Tray 1 and Trays 2–5. For details on how to change the paper setting
when loading paper in the bypass tray, refer to Loading Paper in the Bypass Tray.
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Loading Paper

Loading Paper in the Bypass Tray
To load paper in the Bypass Tray:
1. Open the Bypass Tray. If the Bypass Tray is loaded with paper already, remove any

paper that is a different size or type.

2. Pull out the extension tray for larger sizes.

3. Move the width guides to the edges of the tray.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a
level surface. This procedure separates any sheets that are stuck together and reduces
the possibility of jams.

Xerox® VersaLink® C605 Multifunction Printer6-6
User Guide

Paper and Media



Note
To avoid jams and misfeeds, do not remove paper from its packaging until you are
ready to use the paper.

5. Load the paper in the tray.

Note
Do not load paper above the maximum fill line on the width guides. Overfilling the
tray can cause the printer to jam.

• Load hole-punched paper with the holes to the left.

• For 1-sided printing, load letterhead or pre-printed paper face up with the top
edge going into the printer.
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• For 2-sided printing, load letterhead and pre-printed paper face down with the
top edge going into the printer.

6. Adjust the width guides until they touch the edges of the paper.

7. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper
type, size, and color settings.
a) If the paper type, size, and color are correct, touch OK.
b) If the paper type, size, or color are incorrect, change the settings.

• To select a sheet size, touch the current size setting, then from the list, select
the size.

• To select a paper type, touch the current paper type, then from the list, select
the type.

• To select a paper color, touch the current paper color, then from the list,
select the color.

c) To save the settings, touch OK.
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Configuring Tray 1 and Trays 2–5 for the Paper Length

You can adjust the length of the trays to accommodate A4, Letter (8.5 x 11 in.), and
Legal (8.5 x 14 in.) paper sizes. When you use the Legal-length paper setting, the paper
tray protrudes from the front of the printer.

To change the trays to match the paper length:
1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of

the tray slightly, then pull it out.

2. Remove all paper from the tray.
3. To compress the tray for shorter paper, hold the back of the tray with one hand. With

the other hand, press the release latch at the front of the tray, then push the ends
inward until they latch.

4. To extend the tray for longer paper, hold the back of the tray with one hand. With
the other hand, press the release latch at the front of the tray, then pull the ends
outward until they latch.
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5. To protect the paper when the tray is extended, place the tray cover over the extended
section of the paper tray.

6. Load paper into the tray before inserting it back into the printer.

Loading Paper in Tray 1 and Trays 2–5

You can adjust the length of the paper tray to accommodate A4 (210 x 297mm), Letter
(8.5 x 11 in.), and Legal (8.5 x 14 in.) paper sizes. You can also load label sheets in Tray
1.
1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of

the tray slightly and then pull out the tray completely.
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2. For paper sizes other than Legal, adjust the paper length and width guides as
illustrated.

3. For Legal-size paper, to extend the front of the tray, press the green release latch,
then pull the tray out.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a
level surface. This procedure separates any sheets that are stuck together and reduces
the possibility of jams.

5. Load paper into the tray with the print side face up.

• Load hole-punched paper with the holes to the left.
• Load label sheets in the tray face up.
• For 1-sided printing, load letterhead paper face up with the top of the paper

toward the back of the tray.
• For 2-sided printing, load letterhead and pre-printed paper face down with the

top edge feeding into the printer.
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Note
Do not load paper above the maximum fill line. Overfilling the tray can cause the
printer to jam.

6. Adjust the length and width guides to fit the paper.

7. Insert the tray into the printer.

Note
To avoid paper jams, do not remove the paper cover when printing is in progress.
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8. If the tray is extended for Legal-size paper, the tray protrudes when it is inserted fully
into the printer. You can place a cover over the area protruding out of the tray.

9. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper
type, size and color.
a) If the paper type, size and color are correct, touch OK.
b) If the paper type, size or color are incorrect, change the settings.

• To select a paper type, touch the current paper type, then from the list, select
the type.

• To select a paper size, touch the current size setting, then from the list, select
the size.

• To select a different paper color, touch the current paper color, then from
the list, select the color.

c) To save the settings, touch OK.

10. To change a paper tray to Dedicated Mode:
a) At the printer control panel, press the Home button.
b) Touch Device > Paper Trays.
c) Touch the desired tray.
d) To dedicate the tray for a paper size, type, or color, touch TrayMode, then touch

Dedicated.

• To select a paper size, touch the current size setting, then from the list, select
a size.

• To select a paper type, touch the current paper type, then from the list, select
a paper type.

• To select a paper color, touch the current paper color, then from the list,
select a paper color.

e) To save the settings, touch OK.
f) To return to the Home screen, press the Home button.
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Loading Paper in the High Capacity Feeder (HCF)

The High Capacity Feeder (HCF) tray accommodates 8.5 x 11 in. / A4 paper only and is
loaded in the short-edge feed (SEF) direction.
1. Pull out the tray slowly until it stops.

2. Flex the sheets back and forth and fan the sheets before loading them into the tray.

3. Load the paper into the tray.
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Note
Do not load paper above the maximum fill line. Overfilling the tray can cause the
printer to jam.

4. Push in the tray until it stops.

5. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper
type, size and color.
a) If the paper type, size and color are correct, touch OK.
b) If the paper type, size or color are incorrect, change the settings.

• To select a paper type, touch the current paper type, then from the list, select
the type.

• To select a paper size, touch the current paper size, then from the list, select
the size.

• To select a different paper color, touch the current paper color, then from
the list, select the color.

c) To save the settings, touch OK.

Setting the Tray Mode

Tray Mode determines if you are prompted to confirm or modify paper settings when
you load paper in the tray. Tray Mode defines how the printer behaves when a paper
conflict or mismatch occurs.

To configure the Bypass Tray Mode:
1. At the printer control panel, press the Home button.
2. Touch Device > Paper Trays.
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3. Touch the Bypass Tray icon. It is displayed in the top position, before the numbered
trays.

4. Touch Tray Mode.
5. Touch the desired mode:

• Bypass prompts you to confirm ormodify paper tray settingswhen paper is loaded
in the Bypass Tray. The Bypass Tray Mode sets the Bypass Tray as the default
tray for all print jobs without a specified tray.

• Fully Adjustable prompts you to confirm or modify paper tray settings when
paper is loaded in the Bypass Tray.

6. To save the setting, touch OK.
7. To return to the Home screen, press the Home button.

Configuring the Tray Mode for Trays 1–5
1. At the printer control panel, press the Home button.
2. Touch Device > Paper Trays.
3. Touch the desired tray.
4. Touch Tray Mode.
5. Touch the desired mode:

• Fully Adjustable prompts you to confirm or modify paper tray settings when
paper is loaded in a tray.

• Dedicated uses the current paper size and type settings and does not prompt you
to confirm or modify the settings. Select this setting to use a tray for printing on
a specific paper type and size, such as letter-size or hole-punched paper.

6. To save the setting, touch OK.
7. To return to the Home screen, press the Home button.

Printing on Special Paper
To order paper or other media, contact your local reseller or visit
www.xerox.com/office/VLC605supplies.

For reference:

• www.xerox.com/rmlna Recommended Media List (United States)
• www.xerox.com/rmleu Recommended Media List (Europe)

Envelopes

You can print envelopes from Tray 1 or the Bypass Tray.

Guidelines for Printing Envelopes
• Use only paper envelopes.
• Do not use envelopes with windows or metal clasps.
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• Print quality depends on the quality and construction of the envelopes. If you do not
get the desired results, try another envelope brand.

• Maintain constant temperatures and relative humidity.
• Store unused envelopes in their packaging to avoid excess moisture and dryness

which can affect print quality and cause wrinkling. Excessive moisture can cause the
envelopes to seal before or during printing.

• Remove air bubbles from the envelopes before loading them into the tray by setting
a heavy book on top of the envelopes.

• In the print driver software, select Envelope as the paper type.
• Do not use padded envelopes. Use envelopes that lie flat on a surface.
• Do not use envelopes with heat-activated glue.
• Do not use envelopes with press-and-seal flaps.

Loading Envelopes in the Bypass Tray
1. Open the Bypass Tray.

2. Pull out the extension tray for larger sizes.
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3. Move the width guides to the edges of the tray.

Note

• To prevent jams, ensure that the leading edge of the envelopes are flat or have
only a slight upward curl, less than 5 mm (.19 in.), before loading into the tray.
If the edge is curled or swollen, fold it over to decurl. The length of the curl must
bewithin 8–10mm (.31–.39 in.). Downward curl at the leading edge of envelopes
is not acceptable and can cause a jam or misfeed.

• Load envelopes up to 16.5 mm (.65 in.) in height. This is approximately 10–20
envelopes, depending on brand, size, and texture.

• If you do not load envelopes in the Bypass Tray right after you have removed
the envelopes from the packaging, the envelopes can bulge. To avoid jams,
flatten the envelopes before loading them into the tray.

4. To load the envelopes, select an option:

• For Number 10 envelopes, load the envelopes with the short edge going into the
printer, flaps down, and flaps to the right.
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• For Monarch or DL envelopes, perform one of the following steps. If the envelopes
wrinkle, try another option.

- Load envelopes with the short edge going into the printer, flaps down, and
flaps to the right.

- Load envelopes with the print-side up, flaps open and down, and the bottom
of the envelope going into the printer.

- Load envelopeswith the print-side up, flaps closed and down, and flaps going
into the printer.
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• For C5 envelopes, perform one of the following steps. If the envelopes wrinkle, try
the other option.

- Load envelopes with the print-side up, flaps open and down, and the bottom
of the envelope going into the printer.

- Load envelopes with the print-side up, flaps closed and down, and short edge
going into the printer.

Note
For envelopes to print correctly, load envelopes with the flaps open. In the
print driver, select Portrait, Landscape, or Rotated Landscape, as needed.
To flip the images, select Rotate Image 180 Degrees.

Xerox® VersaLink® C605 Multifunction Printer6-20
User Guide

Paper and Media



5. Adjust the width guides until they touch the edges of the envelopes.
6. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper

size, type and color.
a) If the paper size, type and color are correct, touch OK.
b) If the paper size, type or color are incorrect, change the settings.

• To select a different size, touch the current size setting, then from the list,
select the size.

• To select a paper type, touch the current paper type, then from the list, select
Envelope.

• To select an envelope color, touch the current paper color, then from the list,
select an envelope color.

c) To save the settings, touch OK.

Loading Envelopes in Tray 1
1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of

the tray slightly, then pull it out.

2. Remove any paper in the tray.
3. Adjust the paper length and width guides as illustrated.

4. Load envelopes in the trays with the flaps closed, flap-side down, and the short edge
leading into the printer.
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Note
Do not load more than 50 envelopes into the tray, up to 45 mm (1.8 in.) in height.

5. Adjust the width guides until they touch the edges of the envelopes.
6. Slide the tray all the way into the printer.

7. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper
type, size and color.
a) If the paper size, type and color are correct, touch OK.
b) If the paper size, type or color are incorrect, change the settings.

• To select a size, touch the current size setting, then from the list, select
Custom. Touch the Length field and select a number value. Touch theWidth
field and select a number value. Select OK.

• To select a paper type, touch the current paper type, then from the list, select
Envelope.

• To select a different color, touch the current paper color, then from the list,
select the color.

c) To save the settings, touch OK.

8. From the Print dialog at your workstation, select the paper setting values and click
OK. To feed and print the envelopes, click Print.

Labels

You can print labels from the Bypass Tray or Tray 1.

Guidelines for Printing Labels
• Use labels designed for laser printing.
• Do not use vinyl labels.
• Do not feed a sheet of labels through the printer more than once.
• Do not use dry gum labels.
• Print only on one side of the sheet of labels. Use full-sheet labels only.
• Store unused labels flat in their original packaging. Leave the label sheets inside the

original packaging until ready to use. Return any unused label sheets to the original
packaging and reseal it.
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• Do not store labels in extremely dry or humid conditions or extremely hot or cold
conditions. Storing labels in extreme conditions can cause print-quality problems or
cause labels to jam in the printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause
labels to curl and jam in the printer.

• In the print driver software, select Label as the paper type.
• Before loading labels, remove all other paper from the tray.

Warning

Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.

Loading Labels in the Bypass Tray
1. Open the Bypass Tray. If the tray is already open, remove any paper that is a different

size or type.

2. Pull out the extension tray for larger sizes.
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3. Move the width guides to the edges of the tray.

4. Load sheet-labels in the Bypass Tray, face up, with the top edge of the page feeding
into the printer first.

5. Adjust the width guides until they touch the edges of the paper.

6. The printer prompts you to verify the size, type and color of the label sheets.
a) If the size, type and color are correct, touch OK.
b) If the size, type or color are incorrect, change the settings.

• To select a different size, touch the current size setting, then from the list,
select a size.

• To select the type, touch the current paper type, then from the list, select
Labels.

• To select the color, touch the current paper color, then from the list, select
a color.

c) To save the settings, touch OK.
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Loading Labels in Tray 1
1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of

the tray slightly, then pull it out.

2. Adjust the paper length and width guides.
3. Load the label sheets in the tray, face up.

Note
Do not load paper above the maximum fill line. Overfilling can cause paper jams.

4. Slide the tray back into the printer.

5. Push the tray in all the way.
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6. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the label
sheet size, type and color.
a) If the paper size, type and color are correct, touch OK.
b) If the paper size, type or color are incorrect, change the settings.

• To select a sheet size, touch the current size setting, then from the list, select
the size.

• To select the paper type, touch the current paper type, then from the list,
select Labels.

• To select a different color, touch the current color, then from the list, select
the color.

c) To save the settings, touch OK.

Glossy Cardstock

You can print Cardstock and Glossy Cardstock up to 220 g/m² from the Bypass tray and
Trays 1-5. For types and weights of supported Cardstock, refer to Supported Paper Types
and Weights.

Guidelines for Printing on Glossy Cardstock
• Do not open sealed packages of glossy cardstock until you are ready to load paper

into the printer.
• Leave glossy cardstock in the original wrapper, and leave the packages in the shipping

carton until ready to use.
• Remove all other paper from the tray before loading glossy cardstock.
• Load only the amount of glossy cardstock you are planning to use. When you are

finished printing, remove the cardstock from the paper tray. Replace unused cardstock
in the original wrapper and seal.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause
glossy cardstock to curl and jam in the printer.

• In the print driver software, select the glossy cardstock type, or select the tray loaded
with the required paper.
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7
Maintenance

General Precautions

Caution
When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials
only as directed in this documentation.

Warning
Keep all cleaning materials out of the reach of children.

Warning
Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

Warning
Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your
printer.

Warning
Internal parts of the printer can be hot. Use caution when doors and covers are open.

• Do not place anything on top of the printer.
• Do not leave the covers and doors open for any length of time, especially in well-lit

places. Light exposure can damage the drum cartridges.
• Do not open covers and doors during printing.
• Do not tilt the printer while it is in use.
• Do not touch the electrical contacts or gears. Doing so could damage the printer and

cause the print quality to deteriorate.
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• Ensure that any parts removed during cleaning are replaced before you plug in the
printer.

Cleaning the Printer

Cleaning the Exterior

Clean the exterior of the printer once a month.

• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft
cloth.

• After cleaning, wipe with a dry, soft cloth.
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently

wipe the stain off.

Caution

Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild
detergent.

Cleaning the Scanner

Clean the scanner about once a month, when anything is spilled on it, or when debris or
dust collect on any of the surfaces. Keep the feed rollers clean to ensure the best possible
copies and scans.
1. Remove any paper from the Document Feeder Tray, and the Document Output Tray.

2. Open the Document Cover.
3. Slightly dampen a soft, lint-free cloth with water.
4. Clean the document glass.
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Note
For best results, use Xerox® Glass Cleaner to remove marks and streaks.

5. Clean the CVT glass.

Note
For best results, use Xerox® Glass Cleaner to remove marks and streaks.

6. Wipe the white underside of the document cover until it is clean and dry.

7. To access the second-side scanning lens assembly, lower the Second-Side Scanning
Access Cover.
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8. Using a soft cloth moistened with water, wipe the mirrored glass, the white-plastic
strip, and the rollers. If dirt is difficult to remove, moisten a soft cloth with a small
amount of neutral detergent, then wipe the printer parts dry with a soft cloth.

Note
To prevent damage to the film around the glass, do not press heavily on themirrored
glass.

9. Close the Second-Side Scanning Access Cover.

10. Close the Document Cover.
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Cleaning the Feed Rollers on the Duplex Automatic Document Feeder
1. Open the Top Cover.

2. Wipe the feed rollers with a dry, soft, lint-free cloth or paper towel until the rollers
are clean.

Note
If the feed rollers get stained with toner or debris, they can cause stains on the
documents. To remove the stains, use a soft lint-free cloth dampened with a neutral
detergent or water.

3. Close the Top Cover.

Cleaning the Interior

Warning

• Never touch a labeled area on or near the heat roller in the fuser. You can get burned.
If a sheet of paper is wrapped around the heat roller, do not try to remove it
immediately. Power off the printer immediately and wait 40 minutes for the fuser
to cool. Try to remove the jam after the printer has cooled.

• If you spill any toner in the printer, wipe it up using amoist cloth. Never use a vacuum
cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or
explosion.

To prevent stains inside the printer that can deteriorate print quality, clean the interior
of the printer regularly. Clean the printer interior whenever you replace the drumcartridge.
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After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer
before closing the printer covers and doors.

• Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper
Jams.

• Remove any dust or stains with a dry, clean cloth.

Cleaning the LED Lenses

If prints have voids or light streaks through one or more colors, use the following
instructions to clean the LED lenses.

Warning
If you accidentally get toner on your clothes, lightly dust them off as best as you can.
If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If
toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in
your eyes, wash it out immediately with cool water and consult a doctor.

1. Power off the printer.

2. Open the right-side door.
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3. To unlock the waste cartridge, pinch the latch.

4. To remove the waste cartridge, lower the top of the cartridge and lift it away from
the printer. To prevent toner spills, keep the openings facing up.

Note

• Be careful not to spill toner when handling the waste cartridge.
• After removing the waste cartridge, do not touch the area shown in the

illustration.
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5. Place the removed waste cartridge on a level surface, with the openings facing up.

Note
To avoid toner spills or malfunction, do not lay the waste cartridge on its side, or with
the openings facing down.

6. Remove the cleaning rod from inside the printer.
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7. Insert the cleaning rod into one of the four cleaning holes until it stops, then pull out
the rod. Repeat this two more times.

8. Repeat the procedure for the holes in the other three slots.
9. Return the cleaning rod to its original location.

10. To reinsert the waste cartridge, lower the bottom of the cartridge into position. To
lock the cartridge into place, push the top forward until the latch clicks into place.
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11. Close the right-side door.

Cleaning the Color-Density Sensors

If the print or color density is too light, missing, or the background is foggy, clean the
color-density sensors.
1. Power off the printer.

2. Lift the rear door release and pull open the door.
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3. Use a dry cotton swab to clean the color-density sensors.

4. Close the rear door.

AdjustmentsandMaintenanceProcedures

Color Registration

The printer automatically adjusts the color registration when automatic adjustment is
enabled. You can also adjust color registration manually any time the printer is idle. You
must adjust the color registration any time the printer ismoved. If you are having printing
problems, adjust the color registration.

Performing a Color Registration Adjustment

A color-registration adjustment occurs every time a new toner cartridge is installed. You
can run this adjustment at other times as needed.

To perform a color-registration adjustment:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Color Registration.
3. To perform an Automatic Color Registration adjustment, touch Start.
4. At the successfully completed prompt, touch Close.
5. To exit the menu, touch X.
6. To return to the Home screen, press the Home button.
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Color Calibration

Use Color Calibration to adjust colors that appear incorrect, or for composite grays that
look neutral.

To perform a Color Calibration:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Color Calibration.
3. To select a screen to use for your calibration, touch Screen Type, then select an

option.

• To optimize color tones for copy jobs, touch Copy Job.
• To optimize color tones for Standard print-quality print jobs, touch Print Job 1.
• To optimize color tones for Enhanced print-quality print jobs, touch Print Job 2.

4. To select a target job type for your calibration, touch Target, then select the type of
output you want calibrated.

• To optimize color only for copy jobs, touch Copy Jobs Only.
• To optimize color only for print jobs, touch Print Jobs Only.
• To optimize color for both copy and print jobs, touch Copy & Print Jobs.
• If no adjustment is desired, touch None.

5. To select the source paper tray, touch Paper Supply, then touch the desired tray.
6. To begin the color calibration, touch Start. Follow the onscreen instructions.
7. When finished, touch Close.
8. To exit the menu, touch X.
9. To return to the Home screen, press the Home button.

Scan Color Consistency

Use the Scan Color Consistency procedure to adjust scanned colors that appear incorrect,
or for composite grays that look neutral. This procedure prints a Calibration Chart that
you load into the automatic document feeder. The printer scans that page and uses the
scanned values to complete the adjustments.

To perform the Scan Color Consistency procedure:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Color Scan Consistency.
3. To select the desired procedure, touch Calibration Type, then select a procedure.

• To perform the Scan Color Consistency procedure, touch Print Calibration Chart.
Follow the onscreen instructions.

• To restore the color scan settings to the previous settings, touch Restore Previous
Settings. Follow the onscreen instructions.

• To reset the color scan settings to factory-default values, touch Reset to Factory
Defaults. Follow the onscreen instructions.

4. When finished, touch Close.
5. To exit the menu, touch X.
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6. When finished, to return to the Home screen, press the Home button.

Adjusting Paper Registration

UseAdjust Paper Registration to adjust the placement of the printed image on the page.
The adjustment allows you to place the top, bottom, left, and right margins exactly
where you want. You can specify the image position on both the front and back sides
of the paper, for each installed paper tray.

Verifying Paper Registration
1. At the printer control panel, press the Home button.
2. Log in as administrator. For details, refer to the System Administrator Guide at

www.xerox.com/office/VLC605docs.
3. Touch Device > Support > Image Position.
4. Select the source paper tray for the registration print.

a. Touch Paper Supply.
b. Touch the desired tray.

5. If your printer has automatic 2-sided printing, select the sides that you want to
optimize.

• To select a sample registration page for adjusting side 1, touch Adjusted Side,
then touch Side 1.

• To select a sample registration page for adjusting both sides, touch Adjusted
Side, then touch Side 2.

6. Specify the consecutive number of sample pages to print.

a. Touch Print Settings.
b. To increase or decrease the number of sample pages, for Quantity, touch the

Plus icon (+) or the Minus icon (-), then touch OK.

7. To print the sample pages, touch Print Sample.
8. When printing is completed, touch Close.
9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed

image from the top, bottom, left, and right edges.

Note
For identification, a single dot is printed on Side 1, and two dots are printed on Side
2.
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10. For Side 2, measure the distance of the printed image from the top, bottom, left,
and right edges.

11. If the image is centered, no adjustment is required. If the image is not centered,
adjust the paper registration. For details, refer to Performing a Color Registration
Adjustment.

Performing a Paper Registration Adjustment
1. At the control panel, press the Home button.
2. Log in as administrator. For details, refer to the System Administrator Guide at

www.xerox.com/office/VLC605docs.
3. Touch Device > Support > Image Position.
4. To adjust registration, select the source paper tray.

a. Touch Paper Supply.
b. Touch the desired tray.

5. Using the chart printed in Verifying Paper Registration, select the side for registration.

a. For adjusting Side 1, touch Adjusted Side, then touch Side 1.
b. For adjusting Side 2, touch Adjusted Side, then touch Side 2.

6. To adjust the registration, touch Lead/Side Registration.

a. To adjust the side-to-side registration, for Side Registration, touch the Plus
icon (+) or the Minus icon (-).

b. To adjust the top-to-bottom registration, for Lead Registration, touch the Plus
icon (+) or the Minus icon (-).

For reference, position the chart so that Side-1 or Side-2 dots are at the bottom
of the page.

• For Lead Registration, a positive value shifts the image down the page.
• For Side Registration, a positive value shifts the image to the left.
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7. To save your settings, touch OK.
8. As needed, to enter additional values, repeat the previous steps.
9. Print another sample page, then repeat the process until you complete the

registration corrections.
10. To return to the Home screen, press the Home button.

Transfer Voltage Adjustment

Use Transfer Voltage Adjustment to specify the bias transfer roller voltage for printing
on the selected paper type. If the printed image is too light, increase the voltage for the
paper you are using. If the printed image is mottled or blotchy-looking, decrease the
voltage for the paper you are using.

To adjust the transfer voltage:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Transfer Voltage Adjustment.
3. To select the paper type for the adjustment, touch Paper Type, then touch the paper

type.
4. To adjust the transfer voltage, for Voltage Level, touch the Plus icon (+) or the Minus

icon (-).
5. Touch Adjust.
6. To exit the menu, touch X.
7. To return to the Home screen, press the Home button.

Adjusting the Fuser

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the
toner on a print is smearing or can be rubbed off the paper, increase the temperature
for the paper you are using. If the toner is blistered ormottled, decrease the temperature
for the paper you are using.

To adjust the fuser:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Fuser Temperature Adjustment.
3. To select the paper type, touch Paper Type, then touch the name of the paper type

in the list.
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4. To increase or decrease the fusing temperature, touch the arrow buttons, then touch
Adjust.

5. To adjust the fuser for another paper type, select it from the list, then repeat steps
3 and 4.

6. To exit the menu, touch X.
7. To return to the Home screen, press the Home button.

Adjusting the Altitude

Use Adjust Altitude to adjust the altitude tomatch that of the locationwhere the printer
is installed. If the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Altitude Adjustment.
3. Touch the altitude of the location of the printer, then touch OK.
4. To return to the Home screen, press the Home button.

Performing a Developer and Transfer Roller Cleaning Procedure

When a printer sits idle for an extended time, visible background toner can potentially
appear on prints. Use the Developer and Transfer Roller Cleaning procedure to reduce
background toner on prints.

To perform a Developer and Transfer Roller Cleaning procedure:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Developer & Transfer Roller Cleaning.
3. To perform a Developer and Transfer Roller Cleaning, touch Start.
4. At the successfully completed prompt, touch Close.
5. To exit the menu, touch X.
6. To return to the Home screen, press the Home button.

Performing a Transfer Belt Cleaning Mode Procedure

Debris on the transfer belt can cause vertical black or color-streaks and lines to appear
on prints. To remove black or color-streaks and lines on prints, use the Belt Cleaning
Mode procedure.

To perform a Belt Cleaning Mode procedure:
1. At the printer control panel, press the Home button.
2. Touch Device > Support > Belt Cleaning Mode.
3. To perform a Belt Cleaning Mode procedure, touch Start.
4. At the successfully completed prompt, touch Close.
5. To exit the menu, touch X.
6. To return to the Home screen, press the Home button.
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Supplies

Consumables

Consumables are printer supplies that are depleted during the operation of the printer.
Consumable supplies for this printer are the Genuine Xerox® Toner Cartridges in cyan,
magenta, yellow, and black.

Note

• Each consumable includes installation instructions.
• Install only new cartridges in your printer. If a used toner cartridge is installed, then

the toner-remaining amount displayed could be inaccurate.
• To ensure print quality, the toner cartridge was designed to cease functioning at a

predetermined point.

Caution
Use of toner other than genuine Xerox® Toner can affect print quality and printer
reliability. Xerox® Toner is the only toner designed andmanufactured under strict quality
controls by Xerox for specific use with this printer.

Routine Maintenance Items

Routinemaintenance items are printer parts that have a limited life and require periodic
replacement. Replacements can be parts or kits. Routinemaintenance items are typically
customer replaceable parts.

Note
Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

• Drum Cartridge Kit
• Waste Cartridge
• Maintenance Kit, which includes a Transfer Belt, Transfer Roller, and Feed Roller
• Fuser

Ordering Supplies
When to Order Supplies

A warning appears on the control panel when supplies near their replacement time.
Verify that you have replacements on hand. It is important to order these items when
the messages first appear to avoid interruptions to your printing. An error message
appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/VLC605supplies.

7-17Xerox® VersaLink® C605 Multifunction Printer
User Guide

Maintenance

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC605&PgName=order&Language=English


Caution
Use of non-Xerox supplies is not recommended. The XeroxWarranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not
specified for this printer. The Total Satisfaction Guarantee is available in the United
States and Canada. Coverage could vary outside these areas. Please contact your Xerox
representative for details.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at
the control panel or from the Embedded Web Server. When printer supplies near their
replacement time, warning alerts appear on the control panel. You can customize the
alerts that appear on the control panel and configure email alert notifications.

Checking the Supplies Status at the Control Panel
1. To view status information for the printer supplies, touch Device > Supplies.
2. To view details about a specific item, including part numbers for reordering, touch

the desired item.
3. To return to the Supplies screen, touch X.
4. To return to the Device screen, touch the back arrow.

Customizing Supplies Alert Settings
1. To customize the alerts that appear for printer supplies, touch Device > Supplies >

Alerts Setup.
2. To enable supplies alerts, touch the Enable Alerts toggle button.
3. To configure the printer to display an alert when an item reaches a specific usage

percentage level, touch the item, then select the percentage.
4. To customize the alerts for each supply item, or to enable or disable an alert, touch

the toggle button.
5. To return to the Supplies screen, touch X.
6. To return to the Device screen, touch the back arrow.

Setting Up Email Alerts

To check the supplies status and set up alerts using the Embedded Web Server, refer to
the System Administrator Guide at www.xerox.com/office/VLC605docs.
1. To set up alerts to send to an email address, touchDevice > Supplies > Email Alerts.
2. To enter an email address, touch Add Email, then touch Enter Email Address.
3. Use the touch screen keyboard to enter an email address, or select an entry from the

Address Book, then touch OK.
4. Add more email addresses if necessary.
5. To customize the alerts for each supply item, or to enable or disable an alert, touch

the toggle button.
6. To exit the menu, touch OK.
7. To return to the Device screen, touch the back arrow.
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Supplies Usage Report

The Supplies Usage Report provides coverage information and part numbers for
reordering supplies. The date a supply item was installed also appears on the report.

To print the Supplies Usage Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. Touch Supplies Usage Report.
4. To return to the Home screen, press the Home button.

Toner Cartridges
General Precautions

Warning

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills,
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows
toner, have the child spit out the toner, and rinse the mouth with water. Consult a
physician immediately.

Warning
Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills.
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox representative.

Warning
Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can
catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

A message appears on the control panel when a toner cartridge must be replaced.

Note
Each toner cartridge includes installation instructions.

Cause and SolutionPrinter Status Message

The toner cartridge is low. Order a new toner
cartridge.

Reorder Toner

The toner cartridge is empty. Replace the toner
cartridge with a new one.

Out of Toner

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to
www.xerox.com/gwa.
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Managing the Printer

Viewing the Meter Reading

The Billing/Usage menu displays the total number of impressions that the printer
generated or printed during its lifetime. You cannot reset the counters. A page is counted
as one side of a sheet of paper. For example, a sheet of paper that is printed on two
sides counts as two impressions.

Note
If you provide regular billing information for your device, you can use the Remote Services
Upload feature to simplify the process. You can enable Remote Services to send billing
meter readings to Xerox automatically so that you do not have to collect the readings
manually. Refer to the SystemAdministrator Guideatwww.xerox.com/office/VLC605docs
for further information.

To view the billing information for your printer:
1. At the printer control panel, press the Home button.
2. Touch Device > Billing/Usage.
3. To view more details, touch Usage Counters, then select an option.
4. After viewing the usage readings, to return to the Home screen, press the Home

button.

Printing the Billing Summary Report

The Billing Summary Report provides information about the device and a detailed listing
of the billing meters and sheet counts.

To print the Billing Summary Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. Touch Billing Summary Report.
4. To return to the Home screen, press the Home button.

Moving the Printer

Warning

• To lift the printer, always use at least two people to grasp the hand holds on each
side of the printer.

• To prevent you from dropping the printer or injury, lift the printer firmly by gripping
the recessed areas on both sides of the printer. Never lift the printer by gripping any
other areas.

• If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer.
If the optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to
the ground and cause injury.
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Follow these instructions when moving the printer:
1. Power off the printer, then disconnect the power cord and other cables from the back

of the printer.

Note
To prevent electric shock, never touch the power plugwithwet hands.When removing
the power cord, ensure that you pull the plug and not the cord. Pulling the cord can
damage it, which can lead to fire or electric shock.

2. Remove any paper from the Bypass Tray.

3. Close the Bypass Tray.

4. Remove any paper or other media from the Output Tray.
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5. If the Output Tray Extension is extended, close it.

6. Remove any paper from Tray 1, then close the tray.

7. Keep the paper wrapped and away from humidity and dirt.
8. If the optional 550-Sheet Feeder is installed, unlock, then uninstall it before youmove

the printer.
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9. Lift and carry the printer as shown in the illustration.

Note

• When moving the printer, do not tilt it more than 10 degrees in any direction.
Tilting the printer more than 10 degrees can cause toner spillage.

• Repack the printer and its options using the original packing material and boxes
or a Xerox Repackaging Kit.

• Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction
Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction
Guarantee do not cover damage to the printer caused by improper moving.

After moving the printer:

1. Reinstall any parts that you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and power on the printer.
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8
Troubleshooting

General Troubleshooting
This section contains procedures to help you locate and resolve problems. Resolve some
problems by simply restarting the printer.

Printer Does Not Power On

SolutionsProbable Causes

At the printer control panel, press the
Power/Wake button. For details, refer to Power
Options.

The power switch is not turned on.

Power off the printer, then plug the power cord
securely into the outlet.

The power cord is not plugged into the outlet
correctly.

Power off the printer, then unplug the power
cord and wait 30 seconds. Plug the power cord
into the outlet securely, then press the
Power/Wake button.

The printer requires a full reset.

Plug another electrical appliance into the outlet,
then check if it operates properly.
Try a different outlet.

Something is wrong with the outlet connected
to the printer.

Use a power source with the specifications lis-
ted in the Electrical Specifications.

The printer is connected to an outlet with a
voltage or frequency that does not match the
printer specifications.

Caution
Plug the three-wire cord with grounding prong directly into a grounded AC outlet.
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Printer Resets or Powers Off Frequently

SolutionsProbable Causes

Power off the printer, confirm that the power
cord is plugged in correctly to the printer and
the outlet, then power on the printer.

The power cord is not plugged into the outlet
correctly.

Power off the printer, then power on again. For
details, refer to Printing the Error History Report.
If the error persists, contact your Xerox repres-
entative.

A system error occurred.

Power off the printer, then connect the power
cord to a suitable outlet.

The printer is connected to an uninterruptible
power supply.

Plug the printer directly into the outlet or into
a power strip that is not shared with other
devices.

The printer is connected to a power strip shared
with other high-power devices.

Increase the Auto Power Off timer setting or
disable theAuto Power Off feature. For details,
refer to the System Administrator Guide at
www.xerox.com/office/VLC605docs.

The Auto Power Off feature is enabled to save
power.

Printer Does Not Print

SolutionsProbable Causes

On the control panel, press the Power/Wake
button.

The printer is in Power Saver mode.

If the Status LED is blinking amber, follow the
instructions on the control panel to clear the
error. If the error persists, contact your Xerox
representative.

The printer has an error.

Load paper into the tray.The printer is out of paper.

Load the correct paper in the appropriate tray.
On the printer control panel, specify the correct
paper size, type and color.

The incorrect paper is loaded for the print job.

From the print driver, select a paper tray con-
taining the correct paper.

The paper settings for the print job do not
match any paper loaded in the paper trays at
the printer.

Replace the empty toner cartridge.A toner cartridge is empty.
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SolutionsProbable Causes

Power off the printer, confirm that the power
cord is plugged in correctly to the printer and
the outlet, then power on the printer. If the er-
ror persists, contact your Xerox representative.

No control panel indicators are lighted.

The printer is busy.
• If the Status LED is flashing blue, a previous

print job could be the problem.
1. At your computer, use the printer

properties to delete all print jobs in the
print queue.

2. At the control panel, touch Jobs, then
delete all pending print jobs.

• Load the paper in the tray.
• If the Status LED does not flash once after

you send a print job, check the connection
between the printer and the computer.
Power off the printer, then power on the
printer.

If the Status LED does not flash once after you
send a print job, check the connection between
the printer and the computer.

The printer cable is disconnected.

If the printer is connected to a network:There is a network-connectivity issue.
1. Verify that the Ethernet cable is connected

to the printer.
2. On the printer Ethernet connector, verify

that the green LED is On. If the green LED
is not lighted, reseat both ends of the
Ethernet cable.

3. Examine the TCP/IP address in the Com-
munication section of the Configuration
Report. For details, refer to Printing the
Configuration Report.

4. If the TCP/IP address is 0.0.0.0, the printer
needs more time to acquire an IP address
from the DHCP server. Wait 2 minutes,
then print the Configuration Report again.

5. If the TCP/IP address is unchanged, or
begins with 169, contact your network
administrator.

Verify that the Wireless Network Adapter is in-
stalled and properly configured. For details,
refer to Connecting to a Wireless Network.

There is awireless network setup or connectivity
issue.
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Printing Takes Too Long

SolutionsProbable Causes

It takes more time to print on certain types of
special paper. Ensure that the paper type is set
properly in the driver and at the printer control
panel. For details, refer to Print Speed.

The printer is set to a slower printingmode. For
example, the printer could be set to print on
Heavyweight paper.

It takes time for printing to start when the
printer is exiting Power Saver mode.

The printer is in Power Saver mode.

Determine if a print spooler or a computer
sharing the printer is buffering all print jobs and
then spooling them to the printer. Spooling can
slow print speeds. To test the speed of the
printer, print some Information Pages such as
the Office Demo Page. If the page prints at the
rated speed of the printer, you could have a
network or printer installation issue. For addi-
tional help, contact the system administrator.

The way the printer was installed on the net-
work could be an issue.

Wait. No action needed.The job is complex.

Change the print-quality mode in the print
driver to Standard.

The print-quality mode in the driver is set to
Enhanced.

Document Prints FromWrong Tray

SolutionsProbable Causes

Application and print driver have conflicting
tray selections.

1. Check the tray selected in the print driver.
2. Go to the page setup or printer settings of

the application from which you are print-
ing.

3. Set the paper source to match the tray
selected in the print driver or set the paper
source to Automatically Select.

Note
To have the print driver select the tray, set the
tray used as the paper source toAuto Selection
Enabled.
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Automatic 2-Sided Printing Problems

SolutionsProbable Causes

Ensure that you are using a supported paper
size and weight for 2-sided printing. Envelopes,
cardstock, and labels cannot be used for
2–sided printing. For details, refer to Supported
Paper Types andWeights for Automatic 2-Sided
Printing.

Unsupported or incorrect paper.

Ensure that your printer supports automatic 2-
sided printing. For details, refer to Printer Con-
figurations and Options.

Your printer model is not configured with
automatic 2-sided printing.

In the print driver Printing Options tab, select
2–Sided Print.

Incorrect setting.

Printer is Making Unusual Noises

SolutionsProbable Causes

Power off the printer and remove the obstruc-
tion or debris. If you cannot remove the obstruc-
tion, contact your Xerox representative.

There is an obstruction or debris inside the
printer.

Paper Tray Will Not Close

SolutionsProbable Causes

The paper tray does not fully close.
• If the tray is extended for legal-size paper,

the tray protrudes when it is inserted into
the printer. For details, refer to Configuring
Tray 1 and Trays 2–5 for the Paper Length.

• Some debris or an object is blocking the
tray.

• The tray is blocked by the table or shelf on
which it is located.

• If the paper lift at the back of the tray is not
locked down, replace the tray.

Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85%or when a cold
printer is located in a warm room. Condensation can form in a printer after it has been
sitting in a cold room that is heated quickly.
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SolutionsProbable Causes

Allow the printer to operate for several hours
at room temperature.

The printer has been sitting in a cold room.

The relative humidity of the room is too high.
• Reduce the humidity in the room.
• Move the printer to a location where the

temperature and relative humidity are
within the operating specifications. For de-
tails, refer to Environmental Specifications.

Paper Jams

Locating Paper Jams

Warning
Never touch a labeled area on or near the heat roller in the fuser. You can get burned.
If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately.
Switch off the printer immediately and wait 40 minutes for the fuser to cool. Try to
remove the jam after the printer has cooled. If the error persists, contact your Xerox
representative.

Caution
Do not attempt to clear any paper jams using tools or instruments, which can damage
the printer permanently.
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The following illustration shows where paper jams can occur along the paper path:

4.1. FuserTray 2
2. 5.Single-Pass Duplex Automatic

Document Feeder
Bypass Tray

6. Tray 1
3. Optional Finisher or Mailbox

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported
paper. Other paper types can cause jams. If supported paper is jamming frequently in
one area, clean that area of the paper path.

The following can cause paper jams:

• Selecting the incorrect paper type in the print driver.
• Using damaged paper.
• Using unsupported paper.
• Loading paper incorrectly.
• Overfilling the tray.
• Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

• Use only supported paper. For details, refer to Supported Paper.
• Follow proper paper handling and loading techniques.
• Always use clean, undamaged paper.
• Avoid paper that is curled, torn, moist, creased, or folded.
• To separate the sheets before loading into the tray, fan the paper.
• Observe the paper tray fill line; never overfill the tray.
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• Adjust the paper guides in all trays after inserting the paper. A guide that is not
properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer
damage.

• After loading the tray, at the control panel, select the correct paper type and size.
• Before printing, select the correct type and size in the print driver.
• Store paper in a dry location.

Avoid the following:

• Polyester-coated paper that is designed especially for inkjet printers.
• Paper that is folded, wrinkled, or excessively curled.
• Loading more than one type, size, or weight of paper in a tray at the same time.
• Overfilling the tray.
• Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/rmlna.

Clearing Paper Jams
Clearing Paper Jams from the Duplex Automatic Document Feeder
1. Open the Top Cover and remove any paper.
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2. If paper is jammed in the Single-Pass Duplex Automatic Document Feeder, open the
Document Cover.

3. To access the jammed paper, open the Second-Side Scanning Access Cover, then
remove any jammed paper.

4. Close the Second-Side Scanning Access Cover.

5. Close the Document Cover, then reload the document in the Duplex Automatic
Document Feeder.
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To prevent paper jams:

• Do not load original documents above the MAX fill line.
• Adjust the paper guides so that they fit against the original documents.
• Use only supported paper. Formore information, refer toDocument Feeder Guidelines.

Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel, you must clear all paper from the
paper path.
1. Remove any paper from the Bypass Tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.

Xerox® VersaLink® C605 Multifunction Printer8-10
User Guide

Troubleshooting



4. Remove the jammed paper.

5. Insert Tray 1 into the printer, then push it all the way in.

Note
If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

6. Insert the Bypass Tray completely into the printer.

7. When paper trays are set to Fully Adjustable, you are prompted to verify or change
the paper settings.
a) To confirm the same paper size, type, or color, touch OK.
b) To select a new paper size, type, or color, touch the current setting, then select

a new setting. When finished, touch OK.

8. To return to the Home menu, press the Home button.
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Clearing Paper Jams from the Tray 1 Area

To resolve the error displayed on the control panel, you must clear all paper from the
paper path.
1. Remove any paper from the Bypass Tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.
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4. Remove any crumpled paper from the tray and any remaining paper jammed in the
printer.

5. Insert Tray 1 into the printer, then push it all the way in.

Note
If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

6. Insert the Bypass Tray completely into the printer.

7. When paper trays are set to Fully Adjustable, you are prompted to verify or change
the paper settings.
a) To confirm the same paper size, type, or color, touch OK.
b) To select a new paper size, type, or color, touch the current setting, then select

a new setting. When finished, touch OK.

8. To return to the Home menu, press the Home button.
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Clearing Paper Jams from the Trays 2–5 Areas

To resolve the error displayed on the control panel, you must clear all paper from the
paper path.
1. For the tray reported on the Touch Screen Display, pull out the tray until it stops.

2. To remove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any crumpled paper from the tray and any remaining paper jammed at the
front of the printer.
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4. For the same tray, at the back of the printer, locate the jam-access door. Open the
door, then remove any jammed paper.

5. Re-insert the paper tray into the printer, then push the tray in until it stops.

Note
If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

6. When paper trays are set to Fully Adjustable, you are prompted to verify or change
the paper settings.
a) To confirm the same paper size, type, or color, touch OK.
b) To select a new paper size, type, or color, touch the current setting, then select

a new setting. When finished, touch OK.
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Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel, clear all paper from the paper path.
1. Lift the rear door release and pull open the door.

2. To open the paper guide on the top of the fuser, lift the paper guide tab.

3. Remove any jammed paper from the back of the printer.
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4. Close the paper guide on the fuser.

5. Close the rear door.

Troubleshooting Paper Jams
Multiple Sheets Pulled Together

SolutionsProbable Causes

Remove some of the paper. Do not load paper
past the fill line.

The paper tray is too full.

Remove the paper, align the edges, and then
reload it.

The edges of the paper are not even.

Remove the paper from the tray, and replace
it with new dry paper.

The paper is moist from humidity.

Try a new ream of paper.Too much static electricity is present.

Use only Xerox®-approved paper. For details,
refer to Supported Paper.

Using unsupported paper.

Humidity is too high for coated paper.
• Feed paper one sheet at a time.
• Try loading paper in the Bypass tray.
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SolutionsProbable Causes

With a clean, lint-free cloth moistened with
water, wipe the feed rollers until they are clean.
For details, refer to Cleaning the Printer.

The feed rollers are dirty.

Load the tray with only one type and size of
paper.

Tray is loaded with mixed paper.

Paper Misfeeds

SolutionsProbable Causes

The paper is not correctly positioned in the tray.
• Remove the misfed paper and reposition it

properly in the tray.
• Adjust the paper guides in the tray tomatch

the size of the paper.

Remove some of the paper. Do not load paper
past the fill line.

The paper tray is too full.

Adjust the paper guides in the tray to match
the size of the paper.

The paper guides are not correctly adjusted to
the paper size.

Remove the paper, smooth it out, and reload
it. If it still misfeeds, do not use that paper.

The tray contains warped or wrinkled paper.

Remove the moist paper and replace it with
new, dry paper.

The paper is moist from humidity.

Use only Xerox approved paper. For details,
refer to Supported Paper.

Using paper of the wrong size, thickness, or
type.

With a clean, lint-free cloth moistened with
water, wipe the feed rollers until they are clean.
For details, refer to Cleaning the Printer.

The feed rollers are dirty.

Label and Envelope Misfeeds

SolutionsProbable Causes

The label sheet is facing the wrong way in the
tray. • Load label sheets according to the instruc-

tions from the manufacturer.
• Load labels in the tray, face up.
• For details, refer to Labels.

Do not use any sheet where labels are missing,
curled, or pulled away from the backing sheet.

Labels are missing, curled, or pulled away from
the backing sheet.
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SolutionsProbable Causes

You can print envelopes from the Bypass tray
or Tray 1.
For details, refer to Envelopes.

Envelopes are loaded incorrectly.

Envelopes are wrinkling.
• The heat and pressure of the laser printing

process can cause wrinkling.
• Use supported envelopes. For details, refer

to Guidelines for Printing Envelopes.

Note
When you load envelopes long-edge feed, en-
sure that you specify landscape orientation in
the print driver.

Paper Jam Message Stays On

SolutionsProbable Causes

Recheck the media path and make sure that
you have removed all of the jammed paper.

Some paper remains jammed in the printer.

Check the doors on the printer. Close any door
that is open.

One of the printer doors is open.

Note
Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

SolutionsProbable Causes

Use paper of the correct size, thickness, or type.
For details, refer to Supported Paper Types and
Weights for Automatic 2-Sided Printing.

Using paper of the wrong size, thickness, or
type.

Ensure that paper is loaded into the correct
tray. For details, refer to Supported Paper.

Paper is loaded in the wrong tray.

Load the tray with only one type and size of
paper.

Tray is loaded with mixed paper.

Print-Quality Problems
Your printer is designed to produce consistently high-quality prints. If you observe
print-quality problems, use the information in this section to troubleshoot the problem.
For more information, go to www.xerox.com/office/VLC605support.
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Caution
The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or specialty media. The Xerox
Total Satisfaction Guarantee is available in the United States and Canada. Coverage
could vary outside these areas. Contact your local Xerox representative for details.

Note

• To ensure consistent print quality, the toner, print, and drum cartridges for many
devices are designed to cease functioning at a predetermined point.

• Grayscale images printedwith the composite black setting increment the color pages
counter, because color consumables are used. Composite black is the default setting
on most printers.

Controlling Print-Quality

Various factors can affect the quality of the output of your printer. For consistent and
optimum print quality, use paper designed for your printer, and correctly set the
Print-Quality Mode and Color Adjustments. Follow the guidelines in this section to
maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal
print quality is 15–28ºC (59–82ºF) and 20–70% relative humidity. However, print quality
can be affected when operating near the limits for both temperature and humidity.

Paper and Media

Your printer is designed to use various paper and othermedia types. Follow the guidelines
in this section for the best print quality and to avoid jams:

• Use only Xerox approved paper. For details, refer to Supported Paper.
• Use only dry, undamaged paper.

Caution
Some paper and other media types can cause poor output quality, increased paper
jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes withwindows,metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media
- Transparencies
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• Ensure that the paper type selected in your print driver matches the paper type on
which you are printing.

• If you have the same size paper loaded inmore than one tray, ensure that the proper
tray is selected in the print driver.

• Store your paper and other media properly for optimum print quality. For details,
refer to Paper Storage Guidelines.

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and
refer to the corresponding solution to correct the problem. You can also print a
Demonstration Print page to more precisely determine the print-quality problem. For
details, refer to Information Pages.

If the print quality does not improve after performing the appropriate action, contact
your Xerox representative.

Note

• To maintain print quality, the toner, print, and drum cartridges for many models of
equipment are designed to stop functioning at a predetermined point.

• Grayscale images printedwith the composite black setting increment the color-pages
counter, because color consumables are used. Composite black is the default setting
on most printers.

SolutionsProbable CausesSymptom

Use the paper registration pro-
cedure to adjust the image po-
sition on the page. For details,
refer to Adjusting Paper Regis-
tration.

A paper registration adjust-
ment is needed.• PageMarginsAre Inconsist-

ent.
• The image is not centered

on the page or themargins
are not consistent.
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SolutionsProbable CausesSymptom

Verify that the toner cartridges
meet specifications. Replace
the cartridges if necessary.

The toner cartridges are not
Xerox® toner cartridges.

Faded printouts with multiple
colors faded.

Replace the paper with a re-
commended size and type,
then confirm that your control
panel and print driver settings
are correct. For details, refer to
Supported Paper.

The paper being used is out-
side the recommended specific-
ation range.

Ensure that the proper paper
is loaded in the paper tray.
Choose a heavier paper type
at the control panel and in the
print driver.
Use a lighter paper or paper
type.

The paper type is heavier or
thicker than the paper type se-
lection.

Verify that the paper types set
in the control panel and the
print driver match the paper
loaded in the tray.

The bias transfer voltage is not
properly adjusted for the paper
type.

Print the Demonstration Print
from the Information Pages
menu. For details, refer to In-
formation Pages. If the Demo
Print looks correct, the printer
is printing properly. Verify that
the application and the print
driver selections are correct for
your print job.

The settings in the application
or print driver are incorrect.

Replace the paper.The paper is damp.

For assistance, go to the Xerox®

Support website at www.xer-
ox.com/office/VLC605support.

The high-voltage supply is de-
fective.

Check the condition of the
toner cartridge, then replace it
if necessary.

Toner cartridge is empty or
damaged.

Only one color is faded.
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SolutionsProbable CausesSymptom

Adjust the color registration.
For details, see details, refer to
Color Registration.

The color registration is incor-
rect.

Color around the edge of
printing is incorrect.

Replace thepaperwitha recom-
mended size and type, then
confirm that your control panel
and print driver settings are
correct. For details, refer to
Supported Paper.

The paper is outside the recom-
mended specification range.

Stray black dots or white areas
(dropouts).

Wipe the feed rollers with a
clean damp cloth to remove
debris from the rollers.

Note
Donot touch the transfer roller
or the exposed end of the
transfer belt. Fingerprints can
cause print-quality issues.

There is debris on the rollers.

Ensure that the toner cart-
ridges meet specifications. Re-
place the cartridges if neces-
sary. For details, refer to Con-
sumables.

The toner cartridges are not
Xerox® toner cartridges.

Ensure that the toner cart-
ridges meet specifications. Re-
place the cartridges if neces-
sary. For details, refer to Con-
sumables.

The toner cartridges are not
Xerox® toner cartridges.Vertical black or color

streaks or multiple colored
streaks or lines.

•

• Streaks in only one color.

Remove any debris or paper
scraps from the paper path
under the rear cover.

Debris in the printer is dragging
against the toner before it is
fused.

Check the toner cartridge for
damage, then replace if neces-
sary. For assistance, go to the
Xerox® Support website at
www.xerox.com/of-
fice/VLC605support.

There is a problem with the
toner cartridge for that color.

At the printer control panel,
perform a transfer belt clean-
ing procedure. For details, refer
to Performing a Transfer Belt
Cleaning Mode Procedure.

There is debris on the transfer
belt.
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SolutionsProbable CausesSymptom

Replace the paper.The paper is damp.Partial blanks, creased paper,
or blotted printing.

Replace the paper with a re-
commended size and type. For
details, refer to Supported Pa-
per.

The paper is outside the recom-
mended specification range.

For assistance, go to the Xerox®

Support website at www.xer-
ox.com/office/VLC605support.

A printer part is worn or dam-
aged.

Verify that the toner cartridges
meet specifications and re-
place if necessary. For details,
refer to Consumables.

The toner cartridges are not
Xerox®toner cartridges.

The paper is impeded in the
paper path. • Removeany paper or debris

from the paper path.
• Ensure that the trays are

pushed in all the way.
• Ensure that the rear cover

is closed and locked.

Power on the printer and leave
it on for at least 1 hour to get
rid of the condensation. For
assistance, go to the Xerox®

Support website at www.xer-
ox.com/office/VLC605support.

Condensation inside theprinter
causes partial blanks or
creased paper.

Clean the laser lenses. For de-
tails, refer to Cleaning the LED
Lenses.

The laser lenses are blocked.Vertical blanks appear.

For assistance, go to the Xerox®

Support website at www.xer-
ox.com/office/VLC605support.

A printer part is worn or dam-
aged.

Ensure that the toner cart-
ridgesmeet specifications and
replace if necessary.

The toner cartridges are not
Xerox® toner cartridges.
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SolutionsProbable CausesSymptom

Clean the lens for the affected
color. For details, refer to
Cleaning the LED Lenses.

Something is blocking the lens
for the affected color.

White lines or streaks running
through only one color.

Paper or debris is dragging the
bottom of the transfer belt.

White line or lines running
through all colors. • Remove the paper or debris

from the printer.
• Replace the Transfer Belt,

which is included in the
Maintenance Kit.

• For assistance, go to the
Xerox® Support website at
www.xerox.com/of-
fice/VLC605support.

Reset the paper tray guides.
For details, refer to Loading
Paper.

The paper guides in the trays
are not set correctly.

Slanted printing.

Choose a different paper type
at the control panel, in the ap-
plication, and in the print
driver.

The paper is too light or too
thin.

Blotchy or mottled images.

Replace the paper.The paper is damp.

Reduce the humidity in the
room or move the printer to a
new location.

The humidity is too high.

8-25Xerox® VersaLink® C605 Multifunction Printer
User Guide

Troubleshooting

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC605&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC605&PgName=tech&Language=English


SolutionsProbable CausesSymptom

One or more of the compon-
ents in the paper path is mark-
ing the paper.

Spots or lines appear at regular
intervals on the prints.

1. Print the Repeating De-
fects pages.
At the control panel, touch
Device > Support > Sup-
port Pages > Repeating
Defects.

2. To determine the cause,
measure the distance
between the print defects.

• 27.8mm(1.1 in.): Drum
Cartridge

• 52.0mm(2.1 in.): Drum
Cartridge

• 94.2mm(3.7 in.): Drum
Cartridge

• 82.4 mm (3.24 in.):
Fuser

• 94.2mm (3.7 in.): Fuser
• 18.8 mm (0.74 in.):

Transfer Belt
• 63.5 mm (2.5 in.):

Transfer Belt
• 56.5 mm (2.2 in.):

Transfer Roller

3. If the repeating defects
match one of these dis-
tances, replace that item.

Copy and Scan Problems
If the copy or scan quality is poor, refer to the following table.

SolutionsSymptoms

There is debris on the CVT glass or the second-
side scanning lens assembly. When scanning,
the paper from the document feeder passes
over the debris on the glass surfaces, resulting
in lines and streaks. Clean all glass surfaces with
a lint-free cloth. For details, refer to Cleaning
the Scanner.

Lines or streaks only present in copies made
from the document feeder.
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SolutionsSymptoms

There is debris on the document glass. When
scanning, the debris creates a spot on the im-
age. Clean all glass surfaces with a lint-free
cloth.

Spots present in copies made from the docu-
ment glass.

Adjust the lighten/darken setting.Image is too light or too dark.

Adjust color settings and confirm that the cor-
rect Original Type is set.
Perform the Scan Color Consistency procedure.
For details, refer to Color Registration.

Colors are inaccurate.

If the problem persists, for online support information, go to
www.xerox.com/office/VLC605support.

Fax Problems
Note
If the printer cannot send and receive faxes, make sure that you are connected to an
approved analog telephone line. The fax cannot send or receive when connected to a
digital phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes

SolutionsCausesSymptoms

Use the document glass to
send the fax.

The document is too thick, too
thin, or too small.

The document is not scanned
using the document feeder.

Adjust the document feeder
guides to fit the width of the
document.

The document feeder guides
are not adjusted to the width
of the document.

The document is scannedat an
angle.
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SolutionsCausesSymptoms

Position the document cor-
rectly.

The document is positioned
incorrectly.

The fax received by the recipi-
ent is blurry.

Clean the document glass.The document glass is dirty.

Adjust the resolution.The text in the document is too
light.

Verify that the telephone line
is working, then send the fax
again.

There is a problem with the
telephone connection.

Make a copy to verify that your
printer is operating correctly.
If the copy was printed cor-
rectly, have the recipient verify
the condition of the receiving
fax machine.

There is a problemwith the fax
machine of the caller.

The document was loaded in-
correctly.

The fax received by the recipi-
ent is blank. • Document feeder: Place the

original document face up.
• Document glass: Place the

original document face
down.

Verify the fax number.The fax number is wrong.Fax was not transmitted.

Verify the telephone connec-
tion. If it is disconnected, con-
nect it.

The telephone line is connec-
ted incorrectly.

Contact the recipient.There is a problemwith the fax
machine of the recipient.

Verify that the fax is installed
and enabled.

The fax is not installed or is not
enabled.

If the problem persists, for online support information, go to
www.xerox.com/office/VLC605support.
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Problems Receiving Faxes

SolutionsCausesSymptoms

Verify that the printer can
make copies. If it can, have the
caller send the fax again.

There is a problem with the
telephone connection or with
the fax machine of the caller.

The received fax is blank.

Contact the sender.The sender loaded the pages
incorrectly.

If the job contains several
graphics, the printer could have
insufficient memory. The
printer does not answer when
memory is low. Delete stored
documents and jobs, thenwait
for the existing job to com-
plete. This increases available
memory.

Not enough memory.The printer answers the call,
but does not accept incoming
data.

Confirm the original size of the
documents. Documents could
be reduced based on the avail-
able paper supply in the print-
er.

The paper supply in the printer
does not match the document
size sent.

The received fax size is re-
duced.

Set the printer to automatic
reception.

The printer is set to receive
faxes manually.

Faxes cannot be received
automatically.

Load paper if the tray is empty,
then print the faxes stored in
the memory.

The memory is full.

Verify the telephone line con-
nection. If it is disconnected,
connect it.

The telephone line is incor-
rectly connected.

Make a copy to verify that your
printer is operating correctly.
If the copy prints correctly,
have the recipient verify that
the receiving fax machine is
operating correctly.

There is a problemwith the fax
machine of the sender.

If the problem persists, for online support information, go to
www.xerox.com/office/VLC605support.
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Getting Help
Your printer includes utilities and resources to help you troubleshoot printing problems.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message
appears on the control panel and the LED status light on the control panel flashes amber
or red. Warning alerts inform you about printer conditions, such as low supplies or open
doors, that require your attention. If more than one warning condition occurs, only one
warning message appears on the control panel at a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you
of the problem. Error messages warn you about printer conditions that prevent the
printer from printing or degrade printing performance. If more than one error occurs,
only one is displayed on the control panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the
Demonstration Print page and the Error History report that can assist you in
troubleshooting certain problems. The Demonstration Print page prints an image to
show print quality. You can use this page to troubleshoot print-quality issues with the
printer. The Error History report prints information on the most recent printer errors.

Printing Information Pages
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. To print an Information Page, touch the needed page.
4. To return to the Home screen, press the Home button.

Printing the Error History Report
1. At the printer control panel, press the Home button.
2. To print the Error History Report, touch Device > Support > Support Pages > Error

History Report.
3. To return to the Home screen, press the Home button.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and
troubleshooting help to solve your printer problems. You can find solutions for
print-quality problems, paper jams, software installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/VLC605support.

More Information

You can obtain more information about your printer from these sources:
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LocationResource

Packaged with the printer.Installation Guide

www.xerox.com/office/VLC605docsOther documentation for your printer

United States: www.xerox.com/rmlna
European Union: www.xerox.com/rmleu

Recommended Media List

www.xerox.com/office/VLC605supportTechnical support information for your printer,
including online technical support, Online Sup-
port Assistant, and print driver downloads.

Print from the control panel. For details, refer
to Information Pages.

Information Pages

www.xerox.com/office/VLC605suppliesOrder supplies for your printer

www.xerox.com/office/worldcontactsLocal sales and Technical Customer Support

www.xerox.com/office/registerPrinter registration

www.direct.xerox.com/Xerox® Direct online store
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A
Specifications

Printer Configurations and Options

Available Configurations
Standard ConfigurationswithModels C605X, C605XP, C605XF, C605XT,
C605XTP

C605XTPC6505XTFC605XFC605XPC605XOption

StandardStandardStandardStandardStandardFax

StandardStandardStandardStandardStandard2-SidedPrinting

OptionOptionOptionOptionOption500-Sheet
Feeder (Up to 4
Trays)

OptionStandardStandardOptionNot Applic-
able

Finisher

StandardOptionOptionStandardNot Applic-
able

4-Bin Mailbox

StandardStandardOptionOptionOption2000-Sheet
High-Capacity
Feeder with
Casters

NotApplicableNotApplicableOptionOptionOptionCabinet with
Casters

StandardStandardStandardStandardStandardProductivity Kit
with 250-GB
hard drive
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C605XTPC6505XTFC605XFC605XPC605XOption

OptionOptionOptionOptionOptionWireless Net-
work Adapter

OptionOptionOptionOptionOptionCAC Kit/Card
Reader

Standard Features

DescriptionFeatures

Standard and Enhanced modes up to 55 ppmPrint Speed

Up to 52 ppm2-Sided Print Speed

1200 x 2400 dpiPrint Resolution

Paper Capacity

• 150 sheets• Bypass Tray
• •Tray 1 550 sheets

•• 550 sheets, up to 4 traysOptional 550-Sheet Feeder
• •Optional High-Capacity Feeder 2000 sheets

•• 500 sheets. Exception, C605X: 400 sheetsOutput Tray
• •Optional Mailbox 400 sheets

•• 500 sheetsOptional Finisher

Legal (216 x 356 mm, 8.5 x 14 in.)Maximum Print Size

For 2-Sided Printing models, up to 176 g/m² from any
tray

2-Sided Printing

Copy Speed

• 50 Letter-size copies perminute for color, or 55 copies
for black and white

• 1-Sided Copy
• 2-Sided Copy

• 50 Letter-size copies per minute for color, or 52.5
copies for black and white

600 x 400 dpiCopy Resolution

Legal (216 x 356 mm, 8.5 x 14 in.)Maximum Copy Size

Duplex Automatic Document FeederDocument Feeder

100 sheetsDocument Feeder Capacity

600 x 400 dpiOptical Scan Resolution
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DescriptionFeatures

Maximum Scan Size

• 215.9 x 355.6 mm (8.5 x 14 in.)• Document Glass
• •Duplex Automatic Document

Feeder
215.9 x 355.6 mm (8.5 x 14 in.)

File Formats
• JPEG
• TIFF
• PDF
• PDF/A
• XPS

Supported Scanning
• Scan to Desktop (WSD)
• Scan to SMB
• Scan to FTP
• Scan to Email
• Scan to USB Flash drive

7-inch LCD touch screen and keypad navigationControl Panel

Connectivity
• 3 USB 2.0 (Type A) Ports
• USB 3.0 (Type B) Port
• USB Flash drive
• Ethernet 10/100/1000 Base-TX
• Optional wireless network connectivity with an IEEE

802.11 n/g/b-compliant Wireless Network Adapter
• Near Field Communication (NFC)
• AirPrint®

• MOPRIA™

• IC Card Reader support
• Foreign Device Interface (FDI)

Embedded Web ServerRemote Access

Options and Upgrades
• Wireless Network Adapter: IEEE 802.11 n/g/b-compliant, and supports 2.4-GHz and

5-GHz frequencies.
• 550-Sheet Feeder, depending on configuration, up to 3 feeders
• 2000-Sheet High-Capacity Feeder with Casters
• Finisher, available for all models; exception: C605X
• 4-Bin Mailbox, available for all models except the C605X
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• Cabinet with Casters
• Productivity Kit with 250-GB hard drive
• CAC Kit/Card Reader

Physical Specifications

Weights and Dimensions

Configurations without Options, except the
C605X

Dimension

470 mm (18.5 in.)Width

503 mm (19.8 in.)Depth

844 mm (33.2 in.)Height

38.8 kg (85.5 lb.)Weight

C605X Configuration without OptionsDimension

470 mm (18.5 in.)Width

503 mm (19.8 in.)Depth

644 mm (25.4 in.)Height

36.1 kg (79.6 lb.)Weight

Standard Configuration
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Standard Configuration for C605X

Optional 550-Sheet Feeder

Optional Cabinet with Casters
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Optional High-Capacity Feeder with Casters

Height Measurements for Configurations
Height Configurations for Optional Feeders with Finisher/Mailbox

1 Optional FeederNo Optional FeedersItem

Configuration View

966.9 mm (38.1 in.)843.9 mm (33.2 in.)Height

871.4 mm (34.3 in.)748.4 mm (29.4 in.)Document Glass Height

Height Configurations for Optional Feeders with Casters and
Finisher/Mailbox

4 Optional
Feeders

3 Optional
Feeders

2 Optional
Feeders

1 Optional
Feeder

No Optional
Feeders

Item

Configuration
View

1425.9 mm
(56.1 in.)

1302.9 mm
(51.3 in.)

1179.9 mm
(46.5 in.)

1056.9 mm
(41.6 in.)

933.9 mm
(36.8 in.)

Height

1330.4 mm
(52.4 in.)

1207.4 mm
(47.5 in.)

1084.4 mm
(42.7 in.)

961.4 mm
(37.9 in.)

838.4 mm
(33.0 in.)

Document
Glass Height

Xerox® VersaLink® C605 Multifunction PrinterA-6
User Guide

Specifications



Height Configurations for Optional Feeders with Cabinet, Casters, and
Finisher or Mailbox

2 Optional Feeders1 Optional FeederNo Optional FeedersItem

Configuration View

1425.9 (56.1 in.)1302.9 (51.3 in.)1179.9 mm (46.5 in.)Height

1330.4 mm (52.4 in.)1207.4 mm (47.5 in.)1084.4 mm (42.7 in.)Document Glass
Height

Height Configurations for the Optional High-Capacity Feeder (HCF)
with Casters and Finisher/Mailbox

1 Optional FeederNo Optional FeedersItem

Configuration View

1425.9 mm (56.1 in.)1302.9 mm (51.3 in.)Height

1330.4 mm (52.4 in.)1207.4 mm (47.5 in.)Document Glass Height

Height Measurements for C605X Configurations
Height Configurations for C605X with Optional Feeders

3 Optional Feed-
ers

2 Optional Feed-
ers

1 Optional Feed-
er

No Optional
Feeders

Item

Configuration
View

1012.9 mm
(39.9 in.)

889.9 mm
(35.0 in.)

766.9 mm
(30.2 in.)

643.9 mm
(25.4 in.)

Height

917.4 mm
(36.1 in.)

794.4 mm
(31.3 in.)

671.4 mm
(26.4 in.)

548.4 mm
(21.6 in.)

Document
Glass Height
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Height Configurations for C605X with Optional Feeders and Casters

4 Optional
Feeders

3 Optional
Feeders

2 Optional
Feeders

1 Optional
Feeder

No Optional
Feeders

Item

Configuration
View

1225.9 mm
(48.3 in.)

1102.9 mm
(43.4 in.)

979.9 mm
(38.6 in.)

856.9 mm
(33.7 in.)

733.9 mm
(28.9 in.)

Height

1130.4 mm
(44.5 in.)

1007.4 mm
(39.7 in.)

884.4 mm
(34.8 in.)

761.4 mm
(30.0 in.)

638.4 mm
(25.1 in.)

Document
Glass Height

Height Configurations for C605X with Optional Feeders and Cabinet
with Casters

2 Optional Feeders1 Optional FeederNo Optional FeedersItem

Configuration View

1225.9 mm (48.3 in.)1102.9 mm (43.4 in.)979.9 mm (38.6 in.)Height

1130.4 mm (44.5 in.)1007.4 mm (39.7 in.)884.4 mm (34.8 in.)Document Glass
Height

Height Configurations for C605X with Optional High-Capacity Feeder
(HCF) and Casters

1 Optional FeederNo Optional FeedersItem

Configuration View

1225.9 mm (48.3 in.)1102.9 mm (43.4 in.)Height

1130.4 mm (44.5 in.)1007.4 mm (39.7 in.)Document Glass Height
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Total Space Requirements

Configurations without OptionsDimension

87.0 cm (34.3 in.)Width

132.2 cm (52.0 in.)Depth

107.8 cm (42.4 in.)Height

Total Space Requirements for C605X

Configurations without OptionsDimension

87.0 cm (34.3 in.)Width

132.2 cm (52.0 in.)Depth

87.8 cm (34.6in.)Height

Clearance Requirements
Clearance Requirements for Standard Configuration
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Clearance Requirements for C605X

Environmental Specifications

Temperature
• Operating Temperature Range: 10–32°C (50–90°F)
• Optimal Temperature Range: 15–28°C (59–82°F)

Relative Humidity
• Operating Humidity Range: 10–85%
• Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F)

Note
Under extreme environmental conditions, such as 10°C and 85% relative humidity,
printing defects can occur due to condensation inside the printer.

Elevation

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).

Electrical Specifications

Power Supply Voltage and Frequency

Current RequiredFrequencyPower Supply Voltage

12 A60 Hz +/-3 Hz120 VAC +/-10%
(108–132 VAC)

8 A50 Hz +/-3 Hz220–240 VAC +/-10%
(198–264 VAC)
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Power Consumption
• Power Saver Mode (Sleep): 0.9 W
• Ready: 92 W
• Continuous printing: 820 W

Recycling Supplies

If you want to return used supplies for recycling, follow the instructions included with
the new supplies. If the instructions or shipping label are not available, go to
www.xerox.com/gwa for more information.

Performance Specifications

SpecificationsFeature

Power on: As fast as 65 seconds.
Recovery from sleep mode: As fast as 11
seconds.

Note
Warm-up time assumes an ambient temperat-
ure of 20ºC (68°F) at 60% relative humidity.

Printer warm-up time

Print Speed

Print speeds for continuous printing are up to 55 ppm. Print speeds are the same for
color or black and white printing.

Several factors affect print speed:

• Print mode: The fastest print modes are Standard and Enhanced.
• Paper size: Letter (8.5 x 11 in.) size prints slightly faster than A4 (210 x 297mm) size.

Larger sizes reduce print speeds.
• Paper type and weights: For faster printing, use paper weights of 105 g/m² or less.

Themaximumprint speed for 1-sided printing is 55 ppmon Letter-size paper, and 52 ppm
on A4-size paper.

Themaximumprint speed for 2-sided printing is 52 ppmon Letter-size paper and 50 ppm
on A4-size paper.

The maximum print speed for heavy paper weights is 32 ppm.
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B
Regulatory Information

Basic Regulations
Xerox has tested this printer to electromagnetic emission and immunity standards. These
standards are designed to mitigate interference caused or received by this printer in a
typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy. If it is not installed and used in accordance with these instructions,
itmay cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Changes ormodifications to this equipment not approved by Xerox can void the authority
of the user to operate this equipment.

Note
To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.
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Canada

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

European Union
The CE mark applied to this product symbolizes a declaration of conformity by Xerox
with the following applicable Directives of the European Union as of the dates indic-
ated:

• February 26, 2014: Low Voltage Directive 2014/35/EU
• February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive

1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for
the consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from
Xerox.

Eurasian Economic Community Certification
Russia, Belarus, and Kazakhstan are working to establish a common customs
union, the Eurasian Economic Community, or EurAsEC. The Eurasian Economic
Community members anticipate sharing a common regulatory scheme and
common EurAsEC certification mark, the EAC Mark.

European Union Lot 4 Imaging Equipment Agreement
Environmental Information
Environmental Information Providing Environmental Solutions and
Reducing Cost

The following information has been developed to assist users and has been issued in
relation to the European Union (EU) Energy Related Products Directive, specifically the
Lot 4 study on Imaging Equipment. This requiresmanufacturers to improve environmental
performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

• Standard monochrome format products with a maximum speed less than 66 A4
images per minute

• Standard color format products with a maximum speed less than 51 A4 images per
minute
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Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability.
This enables you to print on both sides of the paper automatically, and therefore helps
to reduce the use of valuable resources by reducing your paper consumption. The Lot 4
Imaging Equipment agreement requires that on models greater than or equal to 40
ppm color or greater than or equal to 45 ppm monochrome the duplex function has
been auto enabled, during the setup and driver installation. Some Xerox models below
these speed bands may also be enabled with 2-sided printing settings defaulted on at
the time of install. Continuing to use the duplex function will reduce the environmental
impact of your work. However, should you require simplex/1-sided printing, you may
change the print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an
environmental stewardship scheme, which complies with EN12281 or a similar quality
standard. Lighter weight paper (60 g/m²), which contains less raw material and thus
save resources per print, may be used in certain applications.We encourage you to check
if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STARprogram is a voluntary scheme to promote the development and
purchase of energy efficient models, which help to reduce environmental impact.
Details on the ENERGY STAR program and models qualified to ENERGY STAR can be
found at the following website: www.energystar.gov
The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.
The ENERGY STARImaging Equipment Program is a team effort between United
States, EuropeanUnion, and Japanese governments and the office equipment industry
to promote energy-efficient copiers, printers, fax, multifunction printers, personal
computers, andmonitors. Reducing product energy consumption helps combat smog,
acid rain, and long-term changes to the climate by decreasing the emissions that
result from generating electricity.

For additional information on energy or other related topics, go to
www.xerox.com/about-xerox/environment/enus.html or
www.xerox.co.uk/about-xerox/environment/engb.html.

Power Consumption and Activation Time

The amount of electricity that a product consumes depends on the way the device is
used. This product is designed and configured to enable you to reduce your electricity
usage.

After the last print, the device switches to Ready mode. In this mode, the device can
print again immediately. If the product is not used for a period of time, the device
switches to a Power Saver mode. In these modes, to enable reduced product power
consumption, only essential functions remain active. The product takes slightly longer
to produce the first print after it exits Power Saver mode than it takes in Ready mode.
This delay is the result of the system waking up from Power Saver mode and is typical
of most imaging products on the market.
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You can set a longer activation time or completely deactivate the Power Saver mode.
This device can take longer to switch to a lower energy level.

Note
Changing the default Power Saver activation times can result in an overall higher energy
consumption of the product.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html.

Default Power Saver Settings

This device is ENERGY STAR ®-qualified under the ENERGY STAR Program Requirements
for Imaging Equipment. The transition time from Ready mode to Low-Power mode can
be set up to 60 minutes. The default value is 5 minutes. The transition time from
Low-Power mode to Sleep mode can be set up to 60 minutes. The default value is set
at 1 minute. The total transition time from Ready mode to Sleep mode can take up to
60 minutes.

To change the Power Saver settings, contact your System Administrator, or refer to the
System Administrator Guide at www.xerox.com/office/VLC605docs.

Environmental Choice Certified to Office Machines CCD-035

This product is certified to Environmental Choice standard for office machines,
meeting all requirements for reduced environmental impact. As part of
achieving certification, Xerox Corporation has proven this product meets the
Environmental Choice criteria for energy efficiency. Certified copier, printer,
multifunctional device, and fax productsmust alsomeet criteria such as reduced
chemical emissions and demonstrate compatibility with recycled supplies. En-
vironmental Choice was established in 1988 to help consumers find products
and services with reduced environmental impacts. Environmental Choice is a
voluntary, multi-attribute, and lifecycle-based environmental certification. This
certification indicates that a product has undergone rigorous scientific testing,
exhaustive auditing, or both, to prove its compliancewith stringent, third-party,
environmental performance standards.

Germany
Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded this
device the Blue Angel Environmental Label. This label distinguishes it as a device
that satisfies Blue Angel criteria for environmental acceptability in terms of
device design, manufacture, and operation. For more information, go to:
www.blauer-engel.de.

Blendschutz

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am
Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen amBildschirmarbeitsplatz
zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.
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Lärmemission

Maschinenlärminformations-Verordnung3. GPSGV:Der höchste Schalldruckpegel beträgt
70 dB(A) oder weniger gemäß EN ISO 7779.

Importeur

Xerox GmbH

Hellersbergstraße 2-4

41460 Neuss

Deutschland

Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify “it is in compliance with the
EEEregulation.”

“EEE yönetmeliğine uygundur.”

Regulatory Information for 2.4-GHz and 5-GHz Wireless Network
Adapter

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that
complies with the requirements specified in FCC Part 15, Industry Canada RSS-210 and
European Council Directive 99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may
not cause harmful interference, and (2) this devicemust accept any interference received,
including interference that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox
Corporation may void the user's authority to operate this equipment.

Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under
certain circumstances. Penalties of fine or imprisonmentmay be imposed on those guilty
of making such reproductions.

1. Obligations or Securities of the United States Government, such as:

• Certificates of Indebtedness.
• National Bank Currency.
• Coupons from Bonds.
• Federal Reserve Bank Notes.
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• Silver Certificates.
• Gold Certificates.
• United States Bonds.
• Treasury Notes.
• Federal Reserve Notes.
• Fractional Notes.
• Certificates of Deposit.
• Paper Money.
• Bonds and Obligations of certain agencies of the government, such as FHA and

so on.
• Bonds. United States Savings Bonds may be photographed only for publicity

purposes in connection with the campaign for the sale of such bonds.
• Internal Revenue Stamps. If it is necessary to reproduce a legal document on

which there is a canceled revenue stamp, this may be done provided the
reproduction of the document is performed for lawful purposes.

• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps
may be photographed, provided the reproduction is in black and white and is
less than 75% or more than 150% of the linear dimensions of the original.

• Postal Money Orders.
• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the

United States.
• Stamps and other representatives of value, of whatever denomination, which

have been or may be issued under any Act of Congress.
• Adjusted Compensation Certificates for Veterans of the World Wars.

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
3. Copyrightedmaterials, unless permission of the copyright owner has been obtained

or the reproduction falls within the “fair use” or library reproduction rights provisions
of the copyright law. Further information of these provisions may be obtained from
the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for Circular
R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may
be photographed.

5. Passports. Foreign Passports may be photographed.
6. Immigration papers.
7. Draft Registration Cards.
8. Selective Service Induction papers that bear any of the following Registrant’s

information:

• Earnings or Income.
• Court Record.
• Physical or mental condition.
• Dependency Status.
• Previous military service.
• Exception: United States military discharge certificates may be photographed.
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9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by
members of the various Federal Departments, such as FBI, Treasure, and so on
(unless photograph is ordered by the head of such department or bureau).

Reproducing the following is also prohibited in certain states:

• Automobile Licenses.
• Drivers’ Licenses.
• Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or
accuracy. In case of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under
certain circumstances. Penalties of fine or imprisonmentmay be imposed on those guilty
of making such reproductions.

• Current bank notes or current paper money
• Obligations or securities of a government or bank
• Exchequer bill paper or revenue paper
• The public seal of Canada or of a province, or the seal of a public body or authority

in Canada, or of a court of law
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent

to falsely cause same to purport to have been printed by the Queens Printer for
Canada, or the equivalent printer for a province)

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government
of Canada or of a province, the government of a state other than Canada or a
department, board, Commission, or agency established by theGovernment of Canada
or of a province or of a government of a state other than Canada

• Impressed or adhesive stamps used for the purpose of revenue by the Government
of Canada or of a province or by the government of a state other than Canada

• Documents, registers, or records kept by public officials charged with the duty of
making or issuing certified copies thereof, where the copy falsely purports to be a
certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of
the copyright or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and
no liability is assumed for its completeness or accuracy. In case of doubt, consult your
solicitor.
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Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or
imprisonment may be imposed on those found guilty of making such reproductions.

• Currency notes
• Bank notes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy.
In case of doubt, contact your legal counsel.

Fax Regulations

United States
Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to
use a computer or other electronic device, including a faxmachine, to send anymessage
unless suchmessage clearly contains in amargin at the top or bottomof each transmitted
page or on the first page of the transmission, the date and time it is sent and an
identification of the business or other entity, or other individual sending the message
and the telephone number of the sending machine or such business, other entity, or
individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted
by the Administrative Council for Terminal Attachments (ACTA). On the cover of this
equipment is a label that contains, among other information, a product identifier in the
formatUS:AAAEQ##TXXXX. If requested, this numbermust be provided to the Telephone
Company.

A plug and jack used to connect this equipment to the premises wiring and telephone
network must comply with the applicable FCC Part 68 rules and requirements adopted
by theACTA. A compliant telephone cord andmodular plug is providedwith this product.
It connects to a compatible modular jack that is also compliant. Refer to the installation
instructions for details.

You can safely connect the printer to the following standardmodular jack: USOC RJ-11C
using the compliant telephone line cord (with modular plugs) provided with the
installation kit. Refer to the installation instructions for details.
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The Ringer Equivalence Number (REN) is used to determine the number of devices that
can be connected to a telephone line. Excessive RENs on a telephone line could result
in the devices not ringing in response to an incoming call. In most but not all areas, the
sum of RENs should not exceed five (5.0). To be certain of the number of devices that
can be connected to a line, as determined by the RENs, contact the local Telephone
Company. For products approved after July 23, 2001, the REN is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the
REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the
REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to
quote the codes in the following list:

• Facility Interface Code (FIC) = 02LS2
• Service Order Code (SOC) = 9.0Y

Caution
Ask your local Telephone Company for the modular jack type installed on your line.
Connecting this machine to an unauthorized jack can damage telephone company
equipment. You, not Xerox, assume all responsibility and/or liability for any damage
caused by the connection of this machine to an unauthorized jack.

If this Xerox®equipment causes harm to the telephone network, the Telephone Company
could temporarily discontinue service to the telephone line to which it is connected. If
advance notice is not practical, the Telephone Company notifies you of the disconnection
as soon as possible. If the Telephone Company interrupts your service, they can advise
you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures
which could affect the operation of the equipment. If the Telephone Company changes
something that affects the operation of the equipment, they should notify you in order
for you to make necessary modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate
service center for repair or warranty information. Contact information is contained in
the Machine Status menu on the printer and in the back of the Troubleshooting section
of the User Guide. If the equipment is causing harm to the telephone network, the
Telephone Company may request you to disconnect the equipment until the problem
is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are
authorized to make repairs to the printer. This applies at any time during or after the
service warranty period. If unauthorized repair is performed, the remainder of the
warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is
subject to state tariffs. Contact the state public utility commission, public service
commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line.
Make sure that the installation of this Xerox®equipment does not disable your alarm
equipment.
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If you have questions aboutwhat could disable alarmequipment, consult your Telephone
Company or a qualified installer.

Canada

This product meets the applicable Innovation, Science and Economic Development
Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified
equipment. Repairs or alterationsmade by the user to this device, or devicemalfunctions,
could cause the telecommunications company to request you to disconnect the
equipment.

For user protection,make sure that the printer is properly grounded. The electrical ground
connections of the power utility, telephone lines, and internalmetallic water pipe systems,
if present, must be connected together. This precaution could be vital in rural areas.

Warning
Do not attempt to make such connections yourself. Contact the appropriate electric
inspection authority, or electrician, to make the ground connection.

TheRinger EquivalenceNumber (REN) indicates themaximumnumber of devices allowed
to be connected to a telephone interface. The termination of an interface may consist
of any combination of devices subject only to the requirement that the sum of the RENs
of all the devices not exceed five. For the Canadian REN value, please refer to the label
on the equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS–03 issue 9.

European Union
Radio Equipment and Telecommunications Terminal Equipment
Directive

This Xerox device has been self-certified by Xerox for pan-European single terminal
connection to the analog public switched telephone network (PSTN) in accordance with
Directive 1999/5/EC.

This device has been designed to work with the national public switched telephone
networks and compatible PBX devices of the following countries:

Pan-European Analog PSTN and Compatible PBX Certifications

NetherlandsGreeceAustria

NorwayHungaryBelgium

PolandIcelandBulgaria

PortugalIrelandCyprus
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Pan-European Analog PSTN and Compatible PBX Certifications

RomaniaItalyCzech Republic

SlovakiaLatviaDenmark

SloveniaLiechtensteinEstonia

SpainLithuaniaFinland

SwedenLuxembourgFrance

United KingdomMaltaGermany

This product has been tested to and is compliant with TBR21 OR ES 103 021-1/2/3 or
ES 203 021-1/2/3 technical specifications for terminal equipment for use on
analog-switched telephone networks in the European Economic Area.

If you have problems with your product, contact your local Xerox representative. This
product can be configured to be compatible with other country networks. Before
reconnecting the device to a network in another country, contact your Xerox
representative for assistance.

Notes:

• Although this product can use either loop disconnect (pulse) or DTMF tone signaling,
Xerox recommends that you use DTMF signaling. DTMF signaling provides reliable
and faster call setup.

• Modification of this product, or connection to external control software or control
apparatus not authorized by Xerox, invalidates its certification.

New Zealand
1. The grant of a Telepermit for any item of terminal equipment indicates only that

Telecom has accepted that the item complies with minimum conditions for
connection to its network. It indicates no endorsement of the product by Telecom,
it does not provide any sort of warranty, and it does not imply that any Telepermitted
product is compatible with all Telecom network services. Above all, it provides no
assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds
designated. 33.6kbps and 56kbps connections are likely to be restricted to lower bit
rates when connected to some PSTN implementations. Telecom will accept no
responsibility for difficulties that arise in such circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then
arrange for its disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to
other Telecom customers.

B-11Xerox® VersaLink® C605 Multifunction Printer
User Guide

Regulatory Information



4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone
dialing. There is no guarantee that Telecom lines will always continue to support
pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other
equipment, may give rise to 'bell tinkle' or noise and cause a false answer condition.
If you encounter such problems, do not contact the Telecom Faults Service.

6. DTMF tones dialing is the preferredmethod because it is faster than pulse (decadic)
dialing and is readily available on almost all New Zealand telephone exchanges.

Warning
No '111' or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another
device connected to the same line.

8. Some parameters required for compliance with Telecom Telepermit requirements
are dependent on the equipment (computer) associated with this device. The
associated equipment shall be set to operate within the following limits for
compliance with Telecom Specifications:

For repeat calls to the same number:

• There shall be nomore than 10 call attempts to the same number within any 30
minute period for any single manual call initiation, and

• The equipment shall go on-hook for a period of not less than 30 seconds between
the end of one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are
spaced such that there is no less than five seconds between the end of one call
attempt and the beginning of another.

9. For correct operation, total of the RNs of all devices connected to a single line at
any time should not exceed five.

South Africa

This modem must be used in conjunction with an approved surge protection device.

Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to:

• North America: www.xerox.com/msds
• European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to
www.xerox.com/office/worldcontacts.
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C
Recycling and Disposal

All Countries
If you are managing the disposal of your Xerox product, please note that the printer
may contain lead, mercury, perchlorate, and other materials whose disposal may be
regulated due to environmental considerations. The presence of these materials is fully
consistent with global regulations applicable at the time that the product was placed
on the market. For recycling and disposal information, contact your local authorities.
Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply. For more information, go to
www.dtsc.ca.gov/hazardouswaste/perchlorate.

North America
Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox
representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the
program. For more information about Xerox environmental programs, visit
www.xerox.com/environment , or for recycling and disposal information, contact your
local authorities.

European Union
Some equipmentmay be used in both a domestic/household and a professional/business
application.

Domestic/Household Environment
Application of this symbol on your equipment is confirmation that you should not
dispose of the equipment in the normal household waste stream.
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In accordance with European legislation, end of life electrical and electronic equipment
subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic
equipment to designated collection facilities free of charge. Please contact your local
disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be
required to take back your old equipment free of charge. Please ask your retailer for
information.

Professional/Business Environment
Application of this symbol on your equipment is confirmation that you must dispose
of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment
subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life
take-back information.

Collection and Disposal of Equipment and Batteries
These symbols on the products and/or accompanying documents mean that used
electrical and electronic products and batteries should not be mixed with general
household waste.
For proper treatment, recovery, and recycling of old products and used batteries,
please take them to applicable collection points, in accordance with your national
legislation and the Directive 2002/96/EC and 2006/66/EC.
By disposing of these products and batteries correctly, you will help to save valuable
resources and prevent any potential negative effects on human health and the envir-
onment which could otherwise arise from inappropriate waste handling.
For more information about collection and recycling of old products and batteries,
please contact your local municipality, your waste disposal service or the point of
sale where you purchased the items.
Penalties may be applicable for incorrect disposal of this waste, in accordance with
national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or
supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items,
please contact your local authorities or dealer and ask for the correctmethod of disposal.
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Battery Symbol Note
This wheeled bin symbol may be used in combination with a chemical symbol. This
establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.

Other Countries
Please contact your local waste management authority to request disposal guidance.
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Card
Copy

Scan
To

FaxEmailCopyDescriptionFeature

XXXXUse Preset to select values that were
stored previously. Select the required
Preset from the menu.

Preset

XXXXUse Output Color to control the color
rendering of the output image or
print.

Output Color

XFor a color original document, you
can adjust the balance of the printing
colors among cyan,magenta, yellow,
and black before printing your copy.

Color Balance

XFor a color original document, you
can adjust the color of the copy using
preset color effects. For example, you
can adjust colors to be brighter or
cooler.

Color Effects

XXXSaturation allows you to adjust the
color strength and the amount of
gray in the color.

Saturation

XXXXYou can use the 2-Sided options to
set the device to scan one or both
sides of an original document. For
Copy jobs, you can specify 1-Sided or
2-Sided output.

2-Sided and 2-Sided
Scanning
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XXUse Paper Supply to specify the size,
type and color of the paper required,
or the Paper Tray to use. If Auto is
selected, the printer chooses the pa-
per tray based on the original docu-
ment size and the selected settings.

Paper Supply

XYou can collate multiple-page copy
jobs automatically. For example,
whenmaking three 1-Sided copies of
a six-page document, the copies are
printed in this order:
1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3,
4, 5, 6.

Collated

XXYou can reduce the image to as little
as 25% of its original size or enlarge
it as much as 400%.

Reduce/Enlarge

XXXXXThe printer optimizes the image
quality of the copies based on the
type of images in the original docu-
ment and how the original was cre-
ated.

Original Type

XXXXXUse the Lighten/Darken slider to
make the output image or print
lighter or darker.

Lighten/Darken

XXXXUse this option to sharpen the output
image or print. For best results,
sharpen text images and soften pho-
tos.

Sharpness

XXUse the Image Enhancement options
to select Background Suppression
when you scan original documents
on a colored sheet, or to adjust the
image contrast.

ImageEnhancement

XXXYou can use the Original Orientation
option to specify the layout of the
original images that you scan. The
printer uses the information to de-
termine if images require rotation to
produce the desired output.

Original Orientation
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XImage Shift allows you tomodify the
location of the image on the page.
You can shift the printed image along
the X and Y axes of each sheet of
paper.

Image Shift

XXUse the Auto Background Suppres-
sion setting to reduce the sensitivity
of the printer to variations in light
background colors.

Auto Background
Suppression

XXXYou can erase content from the edges
of your images using the Edge Erase
feature. You can specify the amount
to erase on the right, left, top, and
bottom edges.

Edge Erase

XXXXTo ensure that you are scanning the
correct area of the documents, spe-
cify the original document size.

Original Size

XYou can use the Book Copying fea-
ture to copy books, magazines, or
other bound documents.

Book Copying

XYou can print the first page of your
copy job on different paper, such as
colored or heavyweight paper. The
printer selects the special paper from
a different tray. The cover can be
blank or printed.

Note
This function is only available on
printers with an optional Productivity
Kit installed.

Front Cover

XYou can add Annotations, such as
page numbers and the date, to your
copies.

Note
This function is only available on
printers with an optional Productivity
Kit installed.

Annotations

D-3Xerox® VersaLink® C605 Multifunction Printer
User Guide

Apps Features



ID
Card
Copy

Scan
To

FaxEmailCopyDescriptionFeature

XThe Booklet Creation feature prints
two pages on each side of the paper.
The pages are reordered so that they
are in numerical order when folded.

Note
This function is only available on
printers with an optional Productivity
Kit installed.

Booklet Creation

XYou can print the selected number of
pages on one side of a sheet of paper.
Selecting multiple pages per sheet
saves paper and provides a way to
review the layout of a document.

Page Layout

XSample Copy allows you to print a
test copy of a job to inspect before
printing multiple copies. This feature
is useful for complex or high-volume
jobs. After you print and inspect the
test copy, you can choose to print or
cancel the remaining copies.

Sample Copy

XUse this option to enter the number
of required ID card copies.

Quantity

XXXUse this option to view a sample im-
age.

Preview

XXXResolution determines how fine or
grainy graphic images appear. Image
resolution is measured in dots per
inch (dpi).

Resolution

XXYou can use the Contrast feature to
adjust the variation between light
and dark areas of the image.

Contrast

XXXRemove Blank Pages configures the
printer to ignore blank pages.

Remove Blank Pages
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XXYou can use the Book Scanning fea-
ture to scan books, magazines, or
other bound documents.

Book Scanning

XUse the Subject option to add a title
or heading to an email.

Subject

XXUse the From option to specify the
originator of the email.

From

XXUse the Reply To option to include an
email address you want the recipient
to reply to. This option is useful if you
want the recipient to reply to your
email address rather than to the
device.

Note
The system administrator can preset
this option.

Reply To

XXUseMessage to enter information to
accompany the email.

Message

XUse the File Format option to specify
the format of the saved image or to
define a searchable image. You can
add a password to protect the image
or choose to combinemultiple images
into a single file.

File Format

XUse the File Already Exists option to
define what action the device takes
when the file name is used already.

File Already Exists

XXUse the File Name option to specify
a name for the file containing the
scanned images.

File Name
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XYou can use the Book Faxing feature
to scan images from books,
magazines, or other bound docu-
ments for faxing.

Book Faxing

XSelect the highest starting rate to
transmit the fax, unless the destina-
tion for the fax you are sending has
special requirements.

Starting Rate

XYou can use the Cover Sheet option
to add an introduction page to the
beginning of your fax. You can add
a short comment to the cover sheet,
and To and From details.

Cover Sheet

XIt is unlawful to send amessage from
a fax machine without the proper
Transmission Header Text. Ensure
that thenameand telephonenumber
of the sender, and the date and time
of the transmission are included on
all faxes.

TransmissionHeader
Text

XYou can set a time in the future for
the printer to send your fax job. You
can delay the sending of your fax job
for up to 24 hours.

Delay Send

XUse Priority Send to identify urgent
faxes. Priority faxes are sent first.

Priority Send

XYou can use theManual Send feature
to enable the fax modem speaker
temporarily. This feature is helpful to
dial international numbers, or to use
phone systems that require you to
wait for a specific audio tone.

Manual Send

XPolling allows you to retrieve faxes
stored on other fax machines.

Polling
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